# CONTENTS

## Preface
- ix

## Overview
- ix

## Organization
- ix

## Obtaining Documentation, Obtaining Support, and Security Guidelines
- x

### CHAPTER 1

#### Overview
1-1

- How to Use this Manual 1-1
- Introducing the Cisco Video Surveillance System 1-2
  - Stream Manager Application 1-3
  - Video Cameras 1-3
  - Closed Circuit Monitors and Camera Keyboards 1-3
  - Matrix Switches 1-4
  - IP Gateway Encoders 1-4
  - IP Gateway Decoders 1-4
  - IP Gateway Hybrid Decoders 1-4
  - Convergence Chassis 1-4
  - Services Platform 1-5
  - Integrated Services Platform 1-5
  - Video Mass Storage 1-5
  - External Power Supply Chassis 1-5
  - External Fan Tray 1-6
  - Additional Hardware 1-6

### CHAPTER 2

#### Installing Stream Manager Software and Upgrading Firmware
2-1

- Installing Stream Manager Software Modules 2-1
- Uninstalling Stream Manager Software 2-6
- Upgrading Firmware 2-6

### CHAPTER 3

#### Deploying the Cisco Video Surveillance System
3-1

- Deployment Types 3-1
  - Standalone Gateways Deployment 3-2
  - Integrated Services Platform Deployment 3-3
  - Convergence Chassis with USB Outputs Deployment 3-4
Contents

Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply Deployment 3-6
Convergence Chassis with Fast Ethernet Outputs—External Power Supply Deployment 3-8
Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply Deployment 3-11
Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply Deployment 3-13

Hardware Installation Guidelines 3-15
Operating Conditions 3-16
Encoder 3-16
   Dual Streaming Encoder 3-16
   High-Density Encoder 3-18
Decoder 3-19
Convergence Chassis 3-20
   Convergence Chassis Types 3-21
   Connecting a Convergence Chassis to an External Power Supply 3-22
Services Platform 3-23
Integrated Services Platform 3-25
External Power Supply Chassis 3-27
Resetting an Encoder or Decoder 3-28

CHAPTER 4

Using the Stream Manager Configuration Module 4-1
Understanding and Navigating the Configuration Module 4-1
Starting the Configuration Module 4-2
Exiting the Configuration Module 4-3
Changing the Configuration Module Password 4-3
Configuring the SQL Connection 4-3
Displaying Information about the Configuration Module 4-4
Accessing System or Device Configuration Options 4-4
Pinning the Loaded Modules Display 4-6
Configuring Alarms 4-6
Configuring Sequences 4-10
   Adding a Sequence 4-11
   Updating a Sequence 4-12
   Removing a Sequence 4-15
Configuring Tours 4-15
   Adding a Tour 4-16
   Updating a Tour 4-17
   Removing a Tour 4-18
Configuring User Rights and Privileges 4-18
   Configuring User Information 4-19
   Adding a User 4-20
Using the Stream Manager Administration and Monitoring Module  

Starting and Exiting the Administration and Monitoring Module 5-1
Displaying Information about the Administration and Monitoring Module 5-2
Configuring the Administration and Monitoring Module 5-3
  Specifying Configuration File Location 5-3
  Configuring General Options 5-4
  Configuring Network Options 5-4
  Configuring Audio Alert Options 5-5
  Configuring Failover 5-6
  Configuring Still Image Location 5-7
Managing the Device Tree 5-7
  Designating the Display Order of Devices 5-8
  Locating a Recorder that is Recording Video from a Known Camera 5-8
  Displaying Detailed Status for a Device 5-8
  Clearing the Device List Display 5-8
  Rebooting a Device 5-9
Understanding Device Details 5-9
  Interpreting Device Details 5-10
  Viewing Retention Information 5-11
Understanding Device Alerts 5-12
Managing the Log File 5-13
Managing Device Problems 5-14

Using the Stream Manager Client Viewing Module 6-1
Quick Start 6-1
Starting and Exiting the Client Viewing Module 6-2
Displaying Information about the Client Viewing Module 6-4
Contents

Configuring the Client Viewing Module 6-4
  Specifying Configuration File Location 6-4
  Configuring Export Options 6-5
  Configuring General Options 6-5
  Configuring Network Refresh Rate 6-6
  Configuring Map Data Location 6-7
  Configuring Database Location 6-7

Managing Cameras 6-7
  Designating the Display Order of Cameras in the Camera Bank 6-9
  Designating the Camera Type in the Camera Bank 6-9
  Refreshing the Display in the Camera Bank 6-9
  Browsing Camera Activity 6-10
  Searching for Specific Activity 6-12

Managing Monitors 6-13
  Designating the Display Order of Monitors in the Monitor Bank 6-14
  Refreshing the Display in the Monitor Bank 6-15
  Displaying Live Video from a Camera on a Monitor 6-15

Managing Video 6-15
  Designating a Layout for Panes in the Media Wall 6-15
  Viewing Video in Full Screen Mode 6-16
  Managing Custom Screen Layouts 6-16
    Creating a Custom Layout 6-16
    Loading a Custom Layout 6-17
  Viewing Live Video 6-17
  Viewing Recorded Video 6-19
  Understanding the Video Status Bar 6-20
  Capturing a Video Image 6-21
  Designating 1:1 Resolution Mode 6-22

Managing Events 6-22
  Using the Live Tab 6-23
    Filtering Events in the Live Tab 6-23
    Reviewing Events in the Live Tab 6-23
  Using the Search Tab 6-24
    Designating a Time Period for a Search 6-24
    Filtering Events in the Search Tab 6-24
    Reviewing Events in the Search Tab 6-25
  Using the Log Tab 6-25

Exporting Video 6-25

Managing Preset Camera Actions 6-27
Programming a Preset Camera Action  6-27
Manually Executing a Preset Camera Action  6-27

CHAPTER 7  Using the Stream Manager On Screen Menus  7-29
Accessing the Stream Manager On Screen Menu  7-29
Managing a Tour or Sequence  7-31
Understanding the Status Display for a Tour or Sequence  7-33
## Preface

### Overview

*Cisco Video Surveillance System Getting Started Guide* provides information about installing and configuring the Cisco Video Surveillance system.

### Organization

This manual is organized as follows:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>“Overview”</td>
<td>Describes how to use this manual to understand, install, and configure the Cisco Video Surveillance System and provides an overview of the Video Surveillance System hardware and software components.</td>
</tr>
<tr>
<td>2</td>
<td>“Installing Stream Manager Software and Upgrading Firmware”</td>
<td>Provides instructions for installing and uninstalling the Cisco Video Surveillance Stream Manager software and describes how to upgrade the firmware on Cisco Video Surveillance devices.</td>
</tr>
<tr>
<td>3</td>
<td>“Deploying the Cisco Video Surveillance System”</td>
<td>Provides an overview of how to deploy the Cisco Video Surveillance system, describes several deployment types, and provides guidelines for installing hardware devices.</td>
</tr>
<tr>
<td>4</td>
<td>“Using the Stream Manager Configuration Module”</td>
<td>Explains how to use the Cisco Video Surveillance Stream Manager Configuration module and describes the configuration options that this module provides.</td>
</tr>
<tr>
<td>5</td>
<td>“Using the Stream Manager Administration and Monitoring Module”</td>
<td>Explains how to use the Cisco Video Surveillance Stream Manager Administration and Monitoring module to monitor the operation of devices in a video surveillance network.</td>
</tr>
</tbody>
</table>
Chapter 6, “Using the Stream Manager Client Viewing Module”

Explains how to use the Cisco Video Surveillance Stream Manager Client Viewing module to review video, control cameras, and perform other operations.

Chapter 7, “Using the Stream Manager On Screen Menus”

Explains how to access and use the Cisco Video Surveillance Stream Manager on screen menus from a video keyboard.

Obtaining Documentation, Obtaining Support, and Security Guidelines

For information about obtaining documentation, obtaining support, providing documentation feedback, security guidelines, and recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:

Overview

This chapter describes how to use this manual to understand, install, and configure the Cisco Video Surveillance System. It also provides an overview of the Video Surveillance System hardware and software component.

This chapter includes these topics:

- How to Use this Manual, page 1-1
- Introducing the Cisco Video Surveillance System, page 1-2

How to Use this Manual

This manual is designed to introduce you to the Cisco Video Surveillance environment and to guide you through the installation and configuration of the Video Surveillance System.

The following table describes the activities that you perform when you first deploy the system. After you deploy the system, refer to the appropriate sections in this manual when you need to install or configure new components, reconfigure existing components, or review the purpose of an existing component.

<table>
<thead>
<tr>
<th>Step</th>
<th>Activity</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Review the explanations of the components of the</td>
<td>See the “Introducing the Cisco Video Surveillance System” section on page 1-2</td>
</tr>
<tr>
<td></td>
<td>Video Surveillance System</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Install the Stream Manager software</td>
<td>See Chapter 2, “Installing Stream Manager Software and Upgrading Firmware”</td>
</tr>
<tr>
<td>3</td>
<td>Install the video surveillance hardware</td>
<td>See Chapter 3, “Deploying the Cisco Video Surveillance System”</td>
</tr>
<tr>
<td>4</td>
<td>Configure the video surveillance hardware</td>
<td>See Chapter 4, “Using the Stream Manager Configuration Module”</td>
</tr>
<tr>
<td>5</td>
<td>Review the explanations for monitoring the system</td>
<td>See Chapter 5, “Using the Stream Manager Administration and Monitoring Module”</td>
</tr>
<tr>
<td>6</td>
<td>Review the explanations for managing and</td>
<td>See Chapter 6, “Using the Stream Manager Client Viewing Module”</td>
</tr>
<tr>
<td></td>
<td>operating the system</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Review the instructions for using on screen menus</td>
<td>See Chapter 7, “Using the Stream Manager On Screen Menus”</td>
</tr>
<tr>
<td></td>
<td>from a video keyboard</td>
<td></td>
</tr>
</tbody>
</table>
Introducing the Cisco Video Surveillance System

A video surveillance deployment consists of a variety of hardware components. Table 1-1 lists the components that may be included in a deployment and provides a brief description of each one. This table also includes references to sections that provide additional overview information about each component.

Table 1-1  Cisco Video Surveillance System Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Provided By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stream Manager Application, page 1-3</td>
<td>Provides for the configuration, management, and operation of video surveillance solutions</td>
<td>Cisco</td>
</tr>
<tr>
<td>Video Cameras, page 1-3</td>
<td>Captures video and, optionally, audio surveillance that you can view and record</td>
<td>Third parties</td>
</tr>
<tr>
<td>Closed Circuit Monitors and Camera Keyboards, page 1-3</td>
<td>Monitors allow viewing of media streams from cameras; keyboards control the cameras</td>
<td>Third parties</td>
</tr>
<tr>
<td>Matrix Switches, page 1-4</td>
<td>Route video inputs to various displays</td>
<td>Third parties</td>
</tr>
<tr>
<td>IP Gateway Encoders, page 1-4</td>
<td>Processes incoming analog video signals to convert them to IP video signals</td>
<td>Cisco</td>
</tr>
<tr>
<td>IP Gateway Decoders, page 1-4</td>
<td>Decodes encoded video streams for display on monitors and enables video keyboards to select and control video cameras</td>
<td>Cisco</td>
</tr>
<tr>
<td>IP Gateway Hybrid Decoders, page 1-4</td>
<td>Decoder that plays back recorded video in a hybrid deployment</td>
<td>Cisco</td>
</tr>
<tr>
<td>Services Platform, page 1-5</td>
<td>Records, aggregates, and plays back IP CCTV video streams</td>
<td>Cisco</td>
</tr>
<tr>
<td>Integrated Services Platform, page 1-5</td>
<td>Records, aggregates, and plays back IP CCTV video streams; includes built-in analog video encoder cards</td>
<td>Cisco</td>
</tr>
<tr>
<td>Convergence Chassis, page 1-4</td>
<td>Houses encoder and decoder cards</td>
<td>Cisco</td>
</tr>
<tr>
<td>Video Mass Storage, page 1-5</td>
<td>Appliance that connect to Services Platforms and provide large video storage capacity</td>
<td>Cisco</td>
</tr>
<tr>
<td>External Power Supply Chassis, page 1-5</td>
<td>Houses power modules for providing power to a Convergence Chassis</td>
<td>Cisco</td>
</tr>
</tbody>
</table>
Chapter 1      Overview

Introducing the Cisco Video Surveillance System

Stream Manager Application

The Cisco Video Surveillance Stream Manager application is a collection of independent software modules that provide for the configuration, management, and operation of Cisco video surveillance solutions. Stream Manager software modules include:

- Configuration module—Used to configure alarms, sequences, tours, user rights and privileges, and video surveillance hardware components
- Administration and Monitoring module—Allows monitoring network and server use and dynamic system health, and provides status reporting
- Administration and Monitoring with Failover module—Provides all of the features of the Administration and Monitoring module, with the addition of failover management
- Client Viewing module—Provides access to all system operations, including live video viewing, stored video review, camera control, and alarm notifications
- Upgrade module—Upgrades firmware in video surveillance hardware

Video Cameras

Available from third-party manufacturers, video cameras provide video images and, depending on the camera, audio. The Video Surveillance System supports a variety of fixed and movable pan, tilt, zoom (PTZ) cameras.

For details about the features, functions, placement, and cabling of a camera, see the documentation provided by the camera manufacturer.

Closed Circuit Monitors and Camera Keyboards

A wide variety of analog closed circuit television (CCTV) monitors and camera keyboards are available from third-party manufacturers. Monitors allow view live or stored video streams from the video cameras in your network. Keyboards let operators control the cameras, including camera PTZ functions.

Cisco provides keyboard adaptors for keyboards from several manufacturers, which allows the connection of those keyboards to Cisco Video Surveillance components.

Table 1-1   Cisco Video Surveillance System Components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
<th>Provided By</th>
</tr>
</thead>
<tbody>
<tr>
<td>External Fan Tray, page 1-6</td>
<td>Provides cooling for the Convergence Chassis with USB outputs</td>
<td>Third parties</td>
</tr>
<tr>
<td>Additional Hardware, page 1-6</td>
<td>Miscellaneous components used in a typical installation</td>
<td>Cisco and third parties</td>
</tr>
</tbody>
</table>

External Fan Tray, page 1-6 Provides cooling for the Convergence Chassis with USB outputs

Third parties

Additional Hardware, page 1-6 Miscellaneous components used in a typical installation

Cisco and third parties
Matrix Switches

Third-party matrix switches are optional components that route video input from one or more sources to various Cisco Video Surveillance devices. These switches typically offer flexible configuration options and are designed to ensure the quality of video images.

IP Gateway Encoders

Cisco IP Gateway encoders provide real-time processing of video signals. This processing includes converting analog video streams into IP packets, compressing the packets, and forwarding them to the network.

These types of IP Gateway encoders are available:

- Single-port, dual-streaming encoder—Includes two full-duplex serial ports for PTZ cameras, and support for up to three contact sensor inputs and one dry contact output. Can be rack mounted or installed in a housing for use as a remote standalone device.
- 4-port, high-density encoder—Can be combined to provide support for up to 64 cameras in a 16-slot Convergence Chassis. Designed for camera-intensive environments (such as casinos or retail facilities). Does not support contact sensors or deployment as standalone devices.

IP Gateway Decoders

Cisco IP Gateway decoders provide real-time decoding of an encoded video signal. Typically, a decoder processes video streams for a CCTV monitor. In this case, each monitor requires its own decoder.

Decoders are available with two full-duplex serial ports for camera keyboard support, enabling video keyboards to select and control video cameras. They also support inputs from up to three contact sensors and one dry contact input, and are available with digital playback capability.

These devices can be rack mounted or installed in an enclosure and mounted remotely as a standalone device.

IP Gateway Hybrid Decoders

A Cisco IP Gateway hybrid decoders is a specialized version of the IP Gateway Decoder for use in hybrid deployments (deployments that include a third-party matrix switch). When playing back recorded video, the hybrid decoder displays the video on the selected monitor.

Convergence Chassis

The Cisco Convergence Chassis models house encoders and decoders. They can support up to 16 single-wide modules.

The Convergence Chassis is available in these models:

- Convergence Chassis with USB outputs
- Convergence Chassis with Fast Ethernet outputs
- Convergence Chassis with Gigabit Ethernet outputs
Each Convergence Chassis can be powered by an External Power Supply Chassis. In addition, Convergence Chassis with Ethernet outputs can be powered by an internal power supply.

**Services Platform**

Available in several models with various storage options, the Cisco Video Surveillance Services Platform records and aggregates IP CCTV video streams and allows playback of the recordings over an IP network. You can view recorded video streams any time from any device.

The Services Platform replaces traditional analog or digital video recorders. It provides high-quality MPEG-4 encoding and support for up to 16 virtual ports, which allows the Ethernet connection of any combination of up to 16 additional analog cameras using external encoders or IP cameras.

Models are available with these storage options:
- 800 GB of storage in a 1 rack unit case with 4 hard disks
- 2 TB of storage in a 2 rack unit case with 6 x 400 GB hard disks
- 6 TB of storage in a 2 rack unit case with 12 x 500 GB hard disks

**Integrated Services Platform**

The Cisco Video Surveillance Integrated Services Platform provides network digital video recording and playback. It includes built-in analog video encoder cards, which allow direct connectivity to analog closed-circuit television (CCTV) cameras. The device accepts IP video directed from the network and allows playback of the recordings over an IP network.

This device provides high-quality MPEG-4 encoding and support for up to 16 cameras through a combination of integrated video encoder card and virtual ports.

Models are available with these storage options:
- 8 video encoder ports, 2 TB of storage in a 2 rack unit case with 6 x 400 GB hard disks
- 8 video + 8 audio encoder ports, 2 TB of storage in a 2 rack unit case with 6 x 400 GB hard disks
- 8 video encoder ports, 6 TB of storage in a 2 rack unit case with 12 x 500 GB hard disks
- 12 video encoder ports, 6 TB of storage in a 2 rack unit case with 12 x 500 GB hard disks

**Video Mass Storage**

The Cisco Video Mass Storage device attaches to the Services Platform and stores the compressed digital MPEG-4 streams from video cameras. Stored video streams can be retrieved and replayed as needed.

**External Power Supply Chassis**

The External Power Supply Chassis houses up to four 350W power modules for providing power to a Convergence Chassis. The device ships with one power module.
External Fan Tray

The external fan tray is a rack-mounted device that provides cooling for the Convergence Chassis with USB outputs. One external fan tray is required for each convergence chassis.

Additional Hardware

Additional hardware in a typical video surveillance deployment includes the junction boxes or data converters, audio devices, spacers, power supplies, and other miscellaneous equipment.

For detailed information about other components that your deployment may require, consult your Cisco sales representative or your Cisco partner.
Installing Stream Manager Software and Upgrading Firmware

This chapter provides instructions for installing or uninstalling the Cisco Video Surveillance Stream Manager software on your PC. The Stream Manager software includes the following modules, which let you configure, manage, and operate the Cisco Video Surveillance system:

- **Configuration module**—Used to identify and program IP gateway encoders, decoders, and storage devices.
- **Administration and Monitoring module**—Allows monitoring network and server use and dynamic system health, and provides status reporting. Available with the Failover feature, which adds failover management capabilities.
- **Client Viewing module**—Provides access to all system operations, including camera control, stored video review, and alarm notifications.
- **Upgrade module**—Upgrades firmware in video surveillance hardware devices.

This chapter also describes how to upgrade the firmware on Cisco Video Surveillance encoders, decoders, and Services Platforms.

This chapter includes these topics:

- Installing Stream Manager Software Modules, page 2-1
- Uninstalling Stream Manager Software, page 2-6
- Upgrading Firmware, page 2-6

### Installing Stream Manager Software Modules

This section provides step-by-step instructions for installing Stream Manager software modules. You install the modules one at a time, performing the procedure in this section for each module that you want to install.

You can install software that you obtain on a Stream Manager installation disk or that you download from the following URL:


Before you install, make sure that the computer on which you are installing meets the minimum hardware requirements.
If you want to install the same or a newer version of a Stream Manager module that already is installed on the computer, you must first uninstall the existing module. To do so, see the “Uninstalling Stream Manager Software” section on page 2-6.

To install a Stream Manager software module, follow these steps:

**Service**

**Step 1** Close all programs that are running on the PC.

**Step 2** If you have downloaded a Stream Manager installation program, continue to **Step 3**.

If you have a Stream Manager installation disk, take the following actions:

1. Put the disk in the disk drive
2. Choose **Start > My Computer**.
3. Double-click the CD drive in which you put the installation disk
4. Double-click the StreamManager folder.

**Step 3** Double-click the installation program for the module that you want to install.

Installation modules are named as follows, where *version* is the software version number:

- StreamManagerConfig*version*.msi—Installs the Configuration module
- StreamManagerMonitor*version*.msi—Installs the Administration and Monitoring module
- StreamManagerClient*version*.msi—Installs the Client Viewing module
- StreamManagerUpgrade*version*.msi—Installs the Upgrade module

The Welcome to the Installation window appears for the module that you are installing. **Figure 2-1** shows this window for the Configuration Tool module.

![Welcome to the Installation Window](image)
Step 4  
Click Next. 
The User Information window appears, as shown in Figure 2-2.

**Figure 2-2  User Information Window**

![User Information Window](image)

Step 5  
In the User Information window:

a. In the Full Name field, enter a name for this installation.

b. In the Organization field, enter the name of your company or organization.

c. Click Next.

The Destination Folder window appears, as shown in Figure 2-3.
Step 6 In the Destination Folder window:

   a. (Optional) If you want to change the default folder in which the software module is installed, click **Browse**, navigate to the desired folder, then click **OK**.

   b. Click **Next**.

The Ready to Install the Application window appears, as shown in Figure 2-4.
Step 7  Click Next.

The installation begins. The Updating System window shows the progress of the operation. When the operation completes, the Setup window displays a message indicating that the installation is successful, as shown in Figure 2-5.
Step 8  Click Finish.

The installation is complete. To install another Stream Manager software module, repeat this procedure.

Uninstalling Stream Manager Software

You must uninstall a Stream Manager software module before you re-install it or upgrade to a new version. To uninstall a module, follow these steps:

Procedure

Step 1  From the Windows taskbar, choose Start > Control Panel > Add or Remove Programs.

Step 2  In the list of currently installed programs, click the name of the Stream Manager module that you want to remove and then click Remove.

Step 3  Follow the on-screen prompts to remove the module.

Upgrading Firmware

This section describes how to upgrade firmware on a Cisco Video Surveillance encoder, decoder, recorder, and xVCR decoder. Follow these instructions when you obtain a new firmware version for any of these devices. You can upgrade the firmware for several devices of the same type simultaneously.
When you upgrade firmware, follow these guidelines:

- If you are upgrading firmware for an encoder or decoder, you must upgrade both the device firmware and the DSP firmware. Upgrade the DSP firmware first.
- If you will enable the user rights and privileges feature, you must upgrade one Services Platform or one Integrated Services Platform with the Services Platform database firmware.

Before you upgrade firmware:

- Install the Cisco Video Surveillance Stream Manager Upgrade module. For instructions, see the “Installing Stream Manager Software Modules” section on page 2-1.
- Copy the firmware file to a folder your PC or to a folder that you can access through the network. Make a note of this folder. Do not rename the firmware upgrade file.
- Disable the Microsoft Windows firewall.

To upgrade the firmware, follow these steps.

**Procedure**

**Step 1**

Take either of these actions to launch the upgrade module:

- Double-click the Stream Manager Upgrade icon on your desktop
- Choose Start > Programs > Cisco Video Surveillance Stream Manager > Stream Manager Upgrade

The Cisco Stream Manager Upgrade window appears, as shown in Figure 2-6.

*Figure 2-6 Cisco Stream Manager Upgrade Window*
Step 2  Click **Browse**, in the Open window locate and choose the firmware file for the device that you are upgrading.

Firmware upgrade files are named as follows, where *version* is the firmware version number:

- `SPN Firmware_CSEN_version.tar`—Encoder device firmware
- `SPN Firmware_CSEN_DSP_version.tar`—Encoder DSP firmware
- `SPN Firmware_CSDE_version.tar`—Decoder device firmware
- `SPN Firmware_CSDE_DSP_version.tar`—Decoder DSP firmware
- `SPN Firmware_XDEC_version.tar`—Hybrid decoder firmware
- `SPN Firmware_XVCR_version.tar`—Services Platform firmware
- `SPN Firmware_XVCR_DB_version.tar`—Services Platform database firmware

When you choose the firmware file, the Cisco Stream Manager Upgrade module polls the network for devices that correspond to the upgrade file type that you chose and displays a list of discovered devices in the Cisco Stream Manager Upgrade window. This window also displays the IP address, MAC address, current firmware version, and type of each device.

To poll the network again and refresh the display, click **Refresh**.

Figure 2-7 shows an example of the Cisco Stream Manager Upgrade window when you are upgrading firmware for decoders.

**Figure 2-7  Cisco Stream Manager Upgrade Window with Decoders**
Step 3  Take these actions:

a. Select the device or devices to upgrade by checking the check box next to each device.
   To select all devices that the window displays, click Select All.
   To sort the list of devices by any column, click the column heading. Each time that you subsequently
   click a column heading, the list toggles between ascending and descending order.

b. Click Upgrade.

The upgrade begins. The Cisco Stream Manager Upgrade window shows the progress of the upgrade.
The Firmware version column for each device that is upgrading is color coded as follows:

- Yellow—Upgrade for the device is in progress
- Green—Upgrade for the device was successful
- Red—Upgrade for the device failed

After a device upgrades, it reboots automatically.

When the upgrade completes for all devices that you selected, you can exit the Cisco Stream Manager
Upgrade window.
Deploying the Cisco Video Surveillance System

This chapter provides an overview of how to deploy the Cisco Video Surveillance system. It describes several deployment types and provides guidelines for installing various Cisco Video Surveillance system hardware devices.

A Video Surveillance System deployment includes some or all of these interconnected components:

- Video cameras connected to standalone or rack-mounted encoders
- Encoders connected to a network device, such as a switch
- Standalone or rack-mounted decoders connected to closed-circuit television (CCTV) monitors and camera keyboards and to a network device, such as a switch
- A service platform connected to a network device, such as a switch
- Power supply
- A PC hosting the Cisco Stream Manager software and connected to a network device, such as a switch
- Network infrastructure

This chapter includes these topics:

- Deployment Types, page 3-1
- Hardware Installation Guidelines, page 3-15

Deployment Types

The following sections describe representative Video Surveillance system deployments. Each section provides an overview of the deployment and guidelines for installing the components that are used in the deployment.

- Standalone Gateways Deployment, page 3-2
- Integrated Services Platform Deployment, page 3-3
- Convergence Chassis with USB Outputs Deployment, page 3-4
- Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply Deployment, page 3-6
- Convergence Chassis with Fast Ethernet Outputs—External Power Supply Deployment, page 3-8
- Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply Deployment, page 3-11
Standalone Gateways Deployment

The Standalone Gateways deployment provides encoding and decoding applications for field deployments and for systems that do not use rack mounted equipment.

This deployment includes these components:

- Stand-alone decoder (CIVS-SG1ADCOD-FE)—Provides DSP-based MPEG 4 decoding. Includes two bi-directional audio ports, two serial data ports, and four contact closure ports.
- Stand-alone Encoder (CIVS-SG1AECOD-FE)—Provides DSP-based MPEG 4 encoding. Includes two bi-directional audio ports, two serial data ports and four contact closure ports.

Figure 3-1 illustrates the Standalone Gateways deployment.

Table 3-1 provides an overview of installing the Standalone Gateways deployment.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> Place the standalone encoders and decoders where desired.</td>
<td>For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td><strong>Step 2</strong> Connect each encoder and decoder to an electrical outlet.</td>
<td>Use the 12V DC power cable that is provided with the device.</td>
</tr>
</tbody>
</table>
Integrated Services Platform Deployment

The Integrated Services Platform deployment provides a cost-effective, rack-mountable solution for capturing and encoding up to 12 video channels. This deployment provides up to 6 TB of RAID5 storage in a 2 rack unit (RU) space.

This deployment includes these components:

- Integrated Services Platform (CIVS-SP8ECISP-2000)—Provides 8-port video encoding, network connectivity, and RAID5 6 x 400 GB disk storage. Runs the Cisco Video Surveillance Stream Manager software.
- Integrated Services Platform (CIVS-SP8ECISP-6000)—Provides 8-port video encoding, network connectivity, and RAID5 12 x 500 GB disk storage. Runs the Cisco Video Surveillance Stream Manager software.
- Integrated Services Platform (CIVS-SP12-ISP-6000)—Provides 12-port video encoding, network connectivity, and RAID5 12 x 500 GB disk storage. Runs the Cisco Video Surveillance Stream Manager software.

Figure 3-2 illustrates the Integrated Services Platform deployment.
Figure 3-2  Integrated Services Platform Deployment

Table 3-2 provides an overview of installing the Integrated Services Platform deployment.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> Rack-mount the Integrated Services Platform and power it on.</td>
<td>For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td><strong>Step 2</strong> Connect analog cameras to the BNC ports on the rear of the Integrated Services Platform.</td>
<td>For related information, see the “Integrated Services Platform” section on page 3-25.</td>
</tr>
<tr>
<td><strong>Step 3</strong> Connect the Integrated Services Platform to the network.</td>
<td>Use a category 5 cable or higher for the network connection.</td>
</tr>
<tr>
<td><strong>Step 4</strong> Connect the host PC to the network, connect its power cable, and power it on.</td>
<td>If you have not done so already, install the Cisco Video Surveillance Stream Manager software on this PC as described in Chapter 2, “Installing Stream Manager Software and Upgrading Firmware.”</td>
</tr>
</tbody>
</table>

Convergence Chassis with USB Outputs Deployment

The Convergence Chassis with USB Outputs deployment provides a cost-effective, rack-mountable solution for high-density encoding. This deployment provides up to 64 channel encoding in a 3 RU space.
This deployment includes these components:

- **Power module (CIVS-EXTPS-350=)**—350W power module for installation in the External Power Supply Chassis.
- **Power Supply Chassis (CIVS-EXTPWR-CHS)**—Houses up to four 350W power modules.
- **Convergence Chassis with USB outputs (CIVS-CVG16-USB-0)**—3 RU chassis for housing USB 4-port encoder cards. Powered by the Power Supply Chassis. Connects to the Services Platform via four USB 2.0 cables.
- **USB 4-port encoder line card (CIVS-4BECMD-C16U=)**—4-Port encoder card for installation in the Convergence Chassis. Provides MPEG4 compression for up to four analog video feeds and provides USB 2.0 output.
- **Services Platform (CIVS-SP1R-2FBCH)**—1 RU server designed to interface with the USB chassis. Provides network connectivity and a fiber channel interface for RAID storage arrays. Runs the Cisco Video Surveillance Stream Manager software.
- **Third-party fan tray.**

Figure 3-3 illustrates the Convergence Chassis with USB outputs deployment.

### Table 3-3 Deploying the Convergence Chassis with USB Outputs

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Rack-mount the Convergence Chassis with USB outputs. For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Install up to 16 4-port encoder cards in the Convergence Chassis. For related information, see the “Convergence Chassis” section on page 3-20.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Rack-mount the External Power Supply Chassis. —</td>
</tr>
<tr>
<td>Step 4</td>
<td>Install 350W power modules in the Power Supply Chassis. For related information, see the “External Power Supply Chassis” section on page 3-27.</td>
</tr>
</tbody>
</table>
Chapter 3      Deploying the Cisco Video Surveillance System

Deployment Types

Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply Deployment

The Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply deployment provides a rack-mountable solution for MPEG4 encoding and decoding in a 3 RU space.

This deployment includes these components:

- Decoder (CIVS-SG1ADCMD-C16=)—Provides DSP-based MPEG 4 decoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.
- Encoder (CIVS-SG1AECMD-C16=)—Provides DSP-based MPEG 4 encoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.
- Convergence Chassis with Fast Ethernet outputs (CIVS-CVG16-FE-115)—Houses encoder and decoder line cards and powered by an internal power supply. Provides an individual 10/100 BASET network connection to each of the 14 slots in the chassis.

Note  The internal power supply supports up to 10 encoder and decoder line cards.

Table 3-3  Deploying the Convergence Chassis with USB Outputs (continued)

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 5</td>
<td>Rack-mount a 1 RU fan tray directly above the Convergence Chassis and power it on. You can use one fan tray for up to two chassis.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Rack-mount the Services Platform and connect it to the local network. Use a category 5 cable or higher for the network connection.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Connect the Convergence Chassis to the external power supply. Use the gray DC power cable that is provided with the external power supply. For more detailed instructions, see the “Connecting a Convergence Chassis to an External Power Supply” section on page 3-22.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Connect the AC power cord from the External Power Supply Chassis to an electrical outlet. Provides power to the Convergence Chassis.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Connect up to 64 analog cameras to the Convergence Chassis. When a camera connects to an encoder, an LED on the front of encoder turns green.</td>
</tr>
<tr>
<td>Step 10</td>
<td>Connect an AC power cable from the Services Platform to an electrical outlet. —</td>
</tr>
<tr>
<td>Step 11</td>
<td>Connect the host PC to the network, connect its power cable, and power it on. If you have not done so already, install the Cisco Video Surveillance Stream Manager software on this PC as described in Chapter 2, “Installing Stream Manager Software and Upgrading Firmware.”</td>
</tr>
</tbody>
</table>

Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply Deployment

Figure 3-4 illustrates the Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply deployment.
Table 3-4 provides an overview of installing the Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply deployment.

**Table 3-4 Deploying the Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply**

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> Rack-mount the Convergence Chassis with Fast Ethernet outputs, connect the AC power cord, and power it on.</td>
<td>For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td><strong>Step 2</strong> Connect the host PC to the network, connect its power cable, and power it on.</td>
<td>If you have not done so already, install the Cisco Video Surveillance Stream Manager software on this PC as described in Chapter 2, “Installing Stream Manager Software and Upgrading Firmware.”</td>
</tr>
</tbody>
</table>
Chapter 3      Deploying the Cisco Video Surveillance System

Deployment Types

Table 3-4  Deploying the Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply (continued)

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Install the first device, then use the Stream Manager Configuration Module to configure the device. Repeat this process for each device. Do not install more than one encoder or decoder at a time. Each device is shipped with the same IP address and installing more than one at a time creates conflicts on the network and can make it difficult to locate a device for configuration. For information about configuring encoders and decoders, see Chapter 4, “Using the Stream Manager Configuration Module.” If you install more than 10 devices, the over-current circuit on the chassis internal supply trips and the over current LED on the ISP front panel flashes. In this case, correct the over current condition then press the OVER CURRENT RESET button on the front panel of the power supply.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Connect the video feed to the BNC port and connect the PTZ controls to a serial port. For related information, see the “Encoder” section on page 3-16</td>
</tr>
<tr>
<td>Step 5</td>
<td>Connect the video output from each decoder to a monitor. For related information, see the “Decoder” section on page 3-19.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Connect each encoder and decoder to a network switch. For related information, see the “Encoder” section on page 3-16 and the “Decoder” section on page 3-19.</td>
</tr>
</tbody>
</table>

Convergence Chassis with Fast Ethernet Outputs—External Power Supply Deployment

The Convergence Chassis with Fast Ethernet Outputs—External Power Supply deployment provides a rack-mountable solution for MPEG4 encoding. It includes an external power supply for efficient use of rack space and power resiliency.

This deployment includes these components:

- Decoder (CIVS-SG1ADCM-C16=)---Provides DSP-based MPEG 4 decoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.

- Encoder (CIVS-SG1AECDM-C16=)---Provides DSP-based MPEG 4 encoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with outputs Fast Ethernet or with Gigabit Ethernet outputs.
- Convergence Chassis with Fast Ethernet outputs (CIVS-CVG16-FE-0)—Houses the encoder and decoder line cards and powered by an external power supply. Provides an individual 10/100 BASET network connection to 14 of the 16 slots in the chassis.

**Note**

Up to 14 slots can be used because the right two slots do not provide network connectivity.

- Power module (CIVS-EXTPS-350=)—350W power module for installation in the Power Supply Chassis.
- Power Supply Chassis (CIVS-EXTPWR-CHS)—Houses up to four 350W power modules.

Figure 3-5 illustrates the Convergence Chassis with Fast Ethernet outputs—External Power Supply deployment.

*Figure 3-5  Convergence Chassis with Fast Ethernet Outputs—External Power Supply Deployment*

Table 3-5 provides an overview of installing the Convergence Chassis with Fast Ethernet Outputs—External Power Supply deployment.
### Deployment Types

**Table 3-5 Deploying the Convergence Chassis with Fast Ethernet Outputs—External Power Supply**

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rack-mount the Convergence Chassis with Fast Ethernet Outputs.</td>
<td>For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td>2</td>
<td>Connect the host PC to the network, connect its power cable, and power it on.</td>
<td>If you have not done so already, install the Cisco Video Surveillance Stream Manager software on this PC as described in Chapter 2, “Installing Stream Manager Software and Upgrading Firmware.”</td>
</tr>
<tr>
<td>3</td>
<td>Install any combination of up to 10 encoders and decoders in the Convergence Chassis.</td>
<td>Do not install devices in the last 2 slots on the right of the Convergence Chassis because these ports do not include network connections. Install the first device, then use the Stream Manager Configuration Module to configure the device. Repeat this process for each device. Do not install more than one encoder or decoder at a time. Each device is shipped with the same IP address and installing more than one at a time creates conflicts on the network and can make it difficult to locate a device for configuration. For information about configuring encoders and decoders, see Chapter 4, “Using the Stream Manager Configuration Module.”</td>
</tr>
<tr>
<td>4</td>
<td>Connect an analog camera to the BNC port on an encoder.</td>
<td>For related information, see the “Encoder” section on page 3-16.</td>
</tr>
<tr>
<td>5</td>
<td>Rack-mount the External Power Supply Chassis.</td>
<td>—</td>
</tr>
<tr>
<td>6</td>
<td>Install the 350W power module in the External Power Supply Chassis.</td>
<td>For related information, see the “External Power Supply Chassis” section on page 3-27.</td>
</tr>
<tr>
<td>7</td>
<td>Connect the Convergence Chassis to the external power supply.</td>
<td>Use the gray DC power cable that is provided with the external power supply. For more detailed instructions, see the “Connecting a Convergence Chassis to an External Power Supply” section on page 3-22.</td>
</tr>
<tr>
<td>8</td>
<td>Connect the AC power cord from the External Power Supply Chassis to an electrical outlet.</td>
<td>Provides power to the encoders and decoders that are mounted in the Convergence Chassis</td>
</tr>
<tr>
<td>9</td>
<td>Connect analog cameras to encoders.</td>
<td>Connect the video feed to the BNC port and connect the PTZ controls to a serial port.</td>
</tr>
<tr>
<td>10</td>
<td>Connect the video output from each decoder to a monitor.</td>
<td>For related information, see the “Decoder” section on page 3-19.</td>
</tr>
<tr>
<td>11</td>
<td>Connect each encoder and decoder to the network.</td>
<td>Use a category 5 cable or higher for the network connection.</td>
</tr>
</tbody>
</table>
Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply Deployment

The Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply deployment provides a rack-mountable solution for MPEG4 encoding and decoding. It includes an integrated level-2 managed switch in a 3 RU space.

This deployment includes these components:

- Decoder (CIVS-SG1ADCMD-C16=)—Provides DSP-based MPEG 4 decoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.

- Encoder (CIVS-SG1AECMD-C16=)—Provides DSP-based MPEG 4 encoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.

- Convergence Chassis with Gigabit Ethernet Outputs (CIVS-CVG16-GE-115)—Houses the encoder and decoder line cards and powered by the internal power supply. Provides an internal switch that manages connectivity to installed line cards and also provides two Gigabit Ethernet uplinks to the local network.

Note: The internal power supply supports up to eight encoder and decoder line cards.

Figure 3-6 illustrates the Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply deployment.

Figure 3-6 Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply Deployment
Table 3-6 provides an overview of installing the Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply deployment.

### Table 3-6 Deploying the Convergence Chassis with Gigabit Ethernet—Internal Power Supply

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> Rack-mount the Convergence Chassis with Gigabit Ethernet Outputs, connect the AC power cord, and power it on.</td>
<td>For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td><strong>Step 2</strong> Connect the host PC to the network, connect its power cable, and power it on.</td>
<td>If you have not done so already, install the Cisco Video Surveillance Stream Manager software on this PC as described in Chapter 2, “Installing Stream Manager Software and Upgrading Firmware.”</td>
</tr>
<tr>
<td><strong>Step 3</strong> Install any combination of up to 8 encoders and decoders in the Convergence Chassis.</td>
<td>Install the first device, then use the Stream Manager Configuration Module to configure the device. Repeat this process for each device. Do not install more than one encoder or decoder at a time. Each device is shipped with the same IP address and installing more than one at a time creates conflicts on the network and can make it difficult to locate a device for configuration. For information about configuring encoders and decoders, see Chapter 4, “Using the Stream Manager Configuration Module.” If you install more than 8 devices, the over-current circuit on the internal power supply trips and the over current LED on the front panel flashes. In this case, correct the over current condition, then press the OVER CURRENT RESET button on the front panel of the power supply. The LED on the front of a GE switch card illuminates when communication to the network is established.</td>
</tr>
<tr>
<td><strong>Step 4</strong> Connect analog cameras to encoders.</td>
<td>Connect the video feed to the BNC port and connect the PTZ controls to a serial port. For related information, see the “Encoder” section on page 3-16.</td>
</tr>
<tr>
<td><strong>Step 5</strong> Connect the video output from each decoder to a monitor.</td>
<td>For related information, see the “Decoder” section on page 3-19.</td>
</tr>
<tr>
<td><strong>Step 6</strong> Connect either one of the SFP connections on the rear of the Convergence Chassis to the local network.</td>
<td>The connection type depends on the hardware that you ordered.</td>
</tr>
</tbody>
</table>
Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply Deployment

The Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply deployment provides a rack-mountable solution for MPEG4 encoding and decoding in a 3 RU space. It includes an integrated level-2 managed switch and an external power supply for efficient use of rack space and power resiliency.

This deployment includes these components:

- **Decoder (CIVS-SG1ADCMD-C16=)**—Provides DSP-based MPEG 4 decoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.
- **Encoder (CIVS-SG1AECMD-C16=)** Provides DSP-based MPEG 4 encoding and two bi-directional audio ports, two serial data ports, and four contact closure ports. Can be installed in a Convergence Chassis with Fast Ethernet outputs or with Gigabit Ethernet outputs.
- **Convergence Chassis with Gigabit Ethernet Outputs (CIVS-CVG16-GE-0)**—Houses the encoder and decoder line cards and powered by an external power supply. Provides an internal switch that manages connectivity to installed line cards and provides two Gigabit Ethernet uplinks to the local network.
- **Power module (CIVS-EXTPS-350=)**—350W power module for installation in the Power Supply Chassis.
- **Power Supply Chassis (CIVS-EXTPWR-CHS)**—Houses up to four 350W power modules.

*Figure 3-7* illustrates the Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply deployment.
Table 3-7 provides an overview of installing the Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply deployment.

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rack-mount the Convergence Chassis with Gigabit Ethernet Outputs</td>
<td>For related information, see the “Operating Conditions” section on page 3-16.</td>
</tr>
<tr>
<td>2</td>
<td>Connect the host PC to the network, connect its power cable, and power it on.</td>
<td>If you have not done so already, install the Cisco Video Surveillance Stream Manager software on this PC as described in Chapter 2, “Installing Stream Manager Software and Upgrading Firmware.”</td>
</tr>
</tbody>
</table>
Table 3-7  Deploying the Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply (continued)

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 3</td>
<td>Install any combination of up to 14 encoders and decoders in the Convergence Chassis.</td>
<td>Install the first device, then use the Stream Manager Configuration Module to configure the device. Repeat this process for each device. Do not install more than one encoder or decoder at a time. Each device is shipped with the same IP address and installing more than one at a time creates conflicts on the network and can make it difficult to locate a device for configuration. For information about configuring encoders and decoders, see Chapter 4, “Using the Stream Manager Configuration Module.”</td>
</tr>
<tr>
<td>Step 4</td>
<td>Connect analog cameras to encoders.</td>
<td>Connect the video feed to the BNC port and connect the PTZ controls to a serial port.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Rack-mount the External Power Supply Chassis.</td>
<td>—</td>
</tr>
<tr>
<td>Step 6</td>
<td>Connect the AC power cord from the External Power Supply Chassis to an electrical outlet.</td>
<td>—</td>
</tr>
<tr>
<td>Step 7</td>
<td>Connect the Convergence Chassis to the external power supply.</td>
<td>Use the gray DC power cable that is provided with the external power supply. For more detailed instructions, see the “Connecting a Convergence Chassis to an External Power Supply” section on page 3-22.</td>
</tr>
<tr>
<td>Step 8</td>
<td>Connect the video output from each decoder to a monitor</td>
<td>For related information, see the “Decoder” section on page 3-19.</td>
</tr>
<tr>
<td>Step 9</td>
<td>Connect either one of the SFP connections on the rear of the Convergence Chassis to the local network.</td>
<td>The connection type depends on the hardware that you ordered.</td>
</tr>
</tbody>
</table>

Hardware Installation Guidelines

Review the guidelines in the following sections when you deploy the Cisco Video Surveillance system:

- Operating Conditions, page 3-16
- Encoder, page 3-16
- Decoder, page 3-19
- Convergence Chassis, page 3-20
- Services Platform, page 3-23
- Integrated Services Platform, page 3-25
- External Power Supply Chassis, page 3-27
- Resetting an Encoder or Decoder, page 3-28
Operating Conditions

As with any electronic device, to assure normal operation and avoid any unnecessary maintenance, avoid placing Cisco Video Surveillance hardware components where they will be subjected to extreme temperatures, humidity, or electromagnetic interference. When deploying and operating hardware components, follow these guidelines:

- The ambient operating temperature must be between 41°F and 104°F (5°C and 40°C).
- The relative humidity must be between 0% and 90%, non-condensing.
- Make sure that the hardware components are kept away from heating sources.
- Do not place any objects on top of the hardware components.
- Make sure that no water or moisture enters the hardware components. If necessary, use a dehumidifier to reduce humidity near the hardware components.
- Make sure that the hardware components are not exposed to excessive amounts of dust or other debris.
- Make sure that each mounting location is adequate to reduce interference of electromagnetic interference (EMI) or radio frequency interference (RFI) of nearby electrical equipment. These types of interference can be caused items such as relays, motor starters, large power transformers.
- If a chassis is mounted within an enclosure, make sure that the enclosure conforms with all local electrical codes.
- Make sure that the equipment receives adequate ventilation. Never block any ventilation area on the equipment.
- Some equipment includes a battery to preserve the time and date settings when the equipment is disconnected from its power supply. Replace the battery only with the same or equivalent type. Dispose of used batteries according to the instructions provided by the battery manufacturer.

Encoder

Cisco IP Gateway encoders provide real-time processing of an encoded video signal. Typically, each encoder supports the video stream from an analog camera and each camera requires its own encoder port. Encoders are available with two full-duplex serial ports for PTZ camera support and with the capability to support inputs from up to three contact sensors and one dry contract output. Four-port, high-density modules also are available. These high-density modules do not support contact sensors. Cisco IP Gateway encoders can be rack mounted or inserted in an enclosure and mounted externally.

For more detailed information, see these sections:
- Dual Streaming Encoder, page 3-16
- High-Density Encoder, page 3-18

Dual Streaming Encoder

The dual-streaming encoder is a single BNC port module that supports one camera. For PTZ cameras, the serial connection that controls camera motion and zoom is supplied by terminal blocks. This encoder supports two video streams that allow each video stream to be directed to its own destination. It can be rack mounted or installed in a housing for remote installation.

Figure 3-8 shows a standalone encoder and Figure 3-9 shows a chassis-mounted encoder.
Chapter 3      Deploying the Cisco Video Surveillance System

Hardware Installation Guidelines

Figure 3-8      Standalone Dual-Streaming Encoder

Figure 3-9      Chassis-Mounted Decoder
The encoders include some or all of the following items, depending on the model:

- Factory reset button, which returns the firmware version to the factory default or resets the password of the device
- SERIAL 1, which illuminates when serial data activity on port 1 is detected
- SERIAL 2, which illuminates when serial data activity on port 2 is detected
- SYSCOM, which illuminates during Cisco media gateway communication
- VID DET illuminated when video is detected at the BNC connector
- Power LED, which lights green when the card is powered

The back of the dual-streaming chassis-mounted encoder includes the following items:

- One BNC port for video camera attachment
- One 9-position spring-cage terminal block for serial connection to a PTZ camera
- One 12-position spring-cage terminal block for serial connection to a PTZ camera

High-Density Encoder

The four-port high-density encoder supports up to 64 cameras in a 16-slot USB Convergence Chassis. Support for PTZ cameras is provided by serial connections from the recorder to which the encoder is attached.

*Figure 3-10* shows a four-port high-density encoder.
The faceplate of the four-port high-density encoder includes these items:

- Port LEDs, which show the status of each port (numbered 1 through 4). When a port is connected to a camera and processing a video stream normally, the LED lights steady green.
- Power LED, which lights green when the card is powered.

The back of the encoder includes four BNC ports for connecting video cameras.

__Note__

There is no factory reset button on the four-port high-density encoder. Because there is no on-board memory, the card resets with every power cycle. To reset the card, unseat and reseat it.

## Decoder

The decoder provides real-time decoding of an encoded video signal. Typically, a decoder process video streams for a monitor and each monitor has its own decoder.

Figure 3-11 shows a standalone decoder and Figure 3-12 shows a chassis-mounted decoder.
Hardware Installation Guidelines

Chapter 3 Deploying the Cisco Video Surveillance System

Chapter 3
Deploying the Cisco Video Surveillance System

Figure 3-12 Chassis-Mounted Decoder

The faceplate of the chassis-mounted decoder includes some or all of the following items, depending on the model:

- Factory reset button, which returns the firmware version to the factory default or resets the password of the device
- SERIAL 1, which illuminates when serial data activity on port 1 is detected
- SERIAL 2, which illuminates when serial data activity on port 2 is detected
- SYSCOM, which illuminates during Cisco media gateway communication
- VID DET illuminated when video is detected at the BNC connector
- Power LED, which lights green when the card is powered

The back the chassis-mounted decoder includes the following items:

- One BNC port for video camera attachment
- One 9-position spring-cage terminal block for serial connection to a PTZ camera
- One 12-position spring-cage terminal block for serial connection to a PTZ camera

Convergence Chassis

The Cisco Video Surveillance Convergence Chassis is a 3 RU card cage that supports up to 16 single-wide modules. It can be configured for Gigabit Ethernet or Fast Ethernet for Layer 2 network connectivity or for USB connections to Cisco video surveillance recording platforms. Convergence Chassis can be daisy-chained to support larger installations.

**Note**

A screwdriver may be required to firmly secure a line card in a Convergence Chassis.
The following sections provide related information:

- Convergence Chassis Types, page 3-21
- Connecting a Convergence Chassis to an External Power Supply, page 3-22

**Convergence Chassis Types**

The following figures illustrate the Convergence Chassis types:

- Figure 3-13—Convergence Chassis with USB
- Figure 3-14—Convergence Chassis with Fast Ethernet
- Figure 3-15—Convergence Chassis with Gigabit Ethernet

**Figure 3-13  Convergence Chassis with USB**

![Convergence Chassis with USB]

**Figure 3-14  Convergence Chassis with Fast Ethernet**

![Convergence Chassis with Fast Ethernet]
Connecting a Convergence Chassis to an External Power Supply

Figure 3-16 illustrates how to connect a Convergence Chassis to an external power supply. You use an external power supply in these cases:

- You are installing more than 10 line cards in a Convergence Chassis with Fast Ethernet
- You are installing more than eight line cards in a Convergence Chassis with Gigabit Ethernet
- You are using a Convergence Chassis with USB
Figure 3-16  Connecting a Convergence Chassis to an External Power Supply

The Services Platform records and aggregates IP CCTV video streams, and allows playback of the recordings over an IP network. It is available in several models with various storage options.

Depending on the model, the 2 RU Services Platform includes 6 or 12 hard disk drives that are configured as a RAID 5 array. The devices support only Cisco-provided drives. The number, type, and size of drives is not configurable. If a drive needs to be replaced because of a failure, it must be replaced with the same model. If a failed drive is replaced, allow the RAID array time to rebuild itself. The rebuilding time varies depending on the amount of data in the array.

Figure 3-17 shows the front of the Integrated Services Platform. Figure 3-18 and Figure 3-19 provide rear views of two Services Platform models.

Services Platform

The Services Platform records and aggregates IP CCTV video streams, and allows playback of the recordings over an IP network. It is available in several models with various storage options.

Depending on the model, the 2 RU Services Platform includes 6 or 12 hard disk drives that are configured as a RAID 5 array. The devices support only Cisco-provided drives. The number, type, and size of drives is not configurable. If a drive needs to be replaced because of a failure, it must be replaced with the same model. If a failed drive is replaced, allow the RAID array time to rebuild itself. The rebuilding time varies depending on the amount of data in the array.

Figure 3-17 shows the front of the Integrated Services Platform. Figure 3-18 and Figure 3-19 provide rear views of two Services Platform models.
### Figure 3-17 2 RU Services Platform Front View

1. RAID 5 hard disk drive bay. Each hard disk drive is removable.
2. Drive release latch. Push the latch in the direction of the arrow to release a pull handle that allows easy removal of the drive.
3. Drive pull handle. Released when you push the drive release latch.
4. Drive bay power status indicator. Lights blue when power is applied to a drive.
5. Drive bay status indicator. Flashes blue when there is drive activity.

### Figure 3-18 2 RU Services Platform Rear View

1. Power input.
2. Power switch.
4. Switch connector (black). RJ-45 connector to connect to a matrix switch.
5. Mouse and keyboard connector. Connects an optional mouse and computer keyboard.
6. USB ports. Used for additional camera inputs through a USB interface module.
7. Monitor connector. Provides a signal to an optional SVGA monitor for debugging.
   - Serial connector. 9-pin serial connector for a serial (RS-232, RS-442, or RS-485) I/O device, such as a camera or keyboard.
   - Parallel connector. D-25 connector for a parallel device, such as a printer.
8. Network I/O. RJ-45 connector that provides video output.
Integrated Services Platform

The Cisco Video Surveillance Integrated Services Platform provides network digital video recording and playback. It includes built-in analog video encoder cards, which allow direct connectivity to a CCTV.

Depending on the model, the 2 RU Services Platform includes 6 or 12 hard disk drives that are configured as a RAID 5 array. The devices support only Cisco-provided drives. The number, type, and size of drives is not configurable. If a drive needs to be replaced because of a failure, it must be replaced with the same model. If a failed drive is replaced, allow the RAID array time to rebuild itself. The rebuilding time varies depending on the amount of data in the array.

Figure 3-20 shows the front of the Integrated Services Platform and Figure 3-21 shows the rear of the Integrated Services Platform.
Figure 3-20  2 RU Integrated Services Platform Front View

1  RAID 5 hard disk drive bay. Each hard disk drive is removable.
2  Drive release latch. Push the latch in the direction of the arrow to release a pull handle that allows easy removal of the drive.
3  Drive pull handle. Released when you push the drive release latch.
4  Drive bay power status indicator. Lights blue when power is applied to a drive.
5  Drive bay status indicator. Flashes blue when there is drive activity.

Figure 3-21  2 RU Integrated Services Platform Rear View

1  Power input.
2  Power switch.
3  Keyboard connector. RJ-45 connector used for a CCTV keyboard.
4  Switch connector. RJ-45 connector used for a matrix switch.
5  Mouse and keyboard connectors. PS/2 connectors for optional mouse and computer keyboard.
6  USB ports. Used for additional camera inputs through a USB interface module.
7  Serial connector. RJ-45 connector used for a CCTV keyboard.
8  Parallel connector. D-25 connector for a parallel device, such as a printer.
9  Monitor connector. Provides a signal to an optional SVGA monitor for debugging.
External Power Supply Chassis

An External Power Supply Chassis houses up to four 350W power modules for providing power to a Convergence Chassis.

Figure 3-22 illustrates the ways in which an External Power Supply Chassis can be configured.

**Figure 3-22  External Power Supply Chassis Options**

- **90 – 250VAC In**
- **350W – No Redundancy**

- **90 – 290VAC In**
- **700W or 350W Redundant for 1 DC Module failure**

- **90 – 360VAC In**
- **700W or 350W Redundant for 1 DC module or 1 AC mains Failure**

- **90 – 260VAC In**
- **1400W or 1050W Redundant for 1 DC Module Failure**

- **90 – 260VAC In**
- **1400W or 1050W Redundant for DC module or 1 AC Mains failure**
Resetting an Encoder or Decoder

Some encoder and decoder models include a factory reset button, which you can use to return the firmware version to the factory default value or reset the password of the device.

To reset the firmware version on a device to the factory default value, follow these steps:

**Procedure**

**Step 1** Disconnect power from the device.

**Step 2** Press the factory reset button and apply power while continuing to press the reset button.

**Step 3** Continue press the factory reset button until all the LEDs on the front of the device illuminate. This process takes approximately 20 seconds.

**Step 4** Release the factory reset button and allow approximately 1 minute for the device to boot.

To reset the password on a device to the factory default value, follow these steps:

**Procedure**

**Step 1** With the device on but not in the boot state, press and hold the factory reset button until the SERIAL1 LED illuminates.

**Step 2** Release the factory reset button for 2 seconds, then press and hold it again until all the LEDs on the font panel illuminate.

**Step 3** Release the factory reset button.
Using the Stream Manager Configuration Module

The Cisco Video Surveillance Stream Manager Configuration module lets you identify and configure a variety of Video Surveillance system and device settings and options.

This chapter includes these topics:

- Understanding and Navigating the Configuration Module, page 4-1
- Configuring Alarms, page 4-6
- Configuring Sequences, page 4-10
- Configuring Tours, page 4-15
- Configuring User Rights and Privileges, page 4-18
- Configuring Decoders, page 4-26
- Configuring Encoders, page 4-35
- Configuring Recorders, page 4-44
- Configuring Hybrid Decoders, page 4-63

Understanding and Navigating the Configuration Module

The Configuration module provides an intuitive user interface through which you configure system and device settings. This section describes how to perform these tasks:

- Starting the Configuration Module, page 4-2
- Exiting the Configuration Module, page 4-3
- Changing the Configuration Module Password, page 4-3
- Configuring the SQL Connection, page 4-3
- Displaying Information about the Configuration Module, page 4-4
- Accessing System or Device Configuration Options, page 4-4
- Pinning the Loaded Modules Display, page 4-6
Starting the Configuration Module

To start the Stream Manager Configuration module, follow these steps:

**Procedure**

**Step 1** Take either of these actions:
- Double-click the Stream Manager Configuration icon on your desktop
- Choose "Start > Programs > Cisco Video Surveillance Stream Manager > Stream Manager Configuration"

**Step 2** Enter the Stream Manager Configuration module password and click **Login**.

The default password is 12345. For information about changing this password, see the "Changing the Configuration Module Password" section on page 4-3.

The Configuration Manager window appears, as shown Figure 4-1.

*Figure 4-1  Configuration Module Window*

The Loaded Modules area appears at the left of the Configuration Module window. From this area, you choose the system information or device type to configure. The right area of the window varies depending on the activity that you are performing. It may display a list of devices of the type that you choose, or it may display system or device configuration options.
Exiting the Configuration Module

To exit the Configuration module, choose File > Exit, then click Yes in the confirmation dialog box.

Changing the Configuration Module Password

To use the Configuration module, you must enter a login password when you start the program. The default password is 12345. After you log in to the Configuration module, you can change the password at any time.

To change the login password, follow these steps:

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose Tools &gt; Change Password.</td>
</tr>
<tr>
<td>2</td>
<td>In the Old Password field, enter the existing login password.</td>
</tr>
<tr>
<td>3</td>
<td>In the New Password field and the Verify New Password field, enter the new password.</td>
</tr>
<tr>
<td></td>
<td>The password can contain any combination of from 4 to 10 letters, numerals, and these characters: ! @ # $ % ^ * ().</td>
</tr>
<tr>
<td>4</td>
<td>Click OK.</td>
</tr>
</tbody>
</table>

Configuring the SQL Connection

Configuring the SQL connection lets you specify the Services Platform or Integrated Services Platform on which Configuration module databases are located. These databases contain information for user rights and privileges, and for sequences and tours. You must configure this information if you will configure user rights and privileges or use sequences or tours.

To configure the SQL connection follow these steps:

Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Choose Tools &gt; SQL Connection.</td>
</tr>
<tr>
<td>2</td>
<td>In the Connection String Settings window, enter information in the following fields:</td>
</tr>
<tr>
<td></td>
<td>• Server—Enter the IP address of the recorder (Services Platform or Integrated Services Platform) on which the user rights and privileges database resides</td>
</tr>
<tr>
<td></td>
<td>• MySql Connection—Check this check box to enable the connection to the database on the recorder</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The Enable Pooling check box is reserved for future use.</td>
</tr>
</tbody>
</table>
Displaying Information about the Configuration Module

To determine the version of the Configuration module and its components, choose Help > About. In the About window, you can take these actions:

- Click OK to exit the window.
- Click Copy Info to copy the list of installed modules to a text file that you specify. You can provide this text file to the Cisco Technical Assistance Center if you need assistance with troubleshooting the Configuration module.
- Click System Info to display the Windows System Information window.

Accessing System or Device Configuration Options

When the Stream Manager Configuration module starts, the window displays the Loaded Modules area. This area appears at the left of the window and includes the following links:

- System Configuration links:
  - Alarms—Displays a list of the devices for which you can configure alarms
  - Sequences and Tours—Displays options for configuring sequences and tours
  - User Rights and Privileges—Displays options for configuring users of the Video Surveillance system
- Device Configuration links:
  - Decoders—Displays a list of the Cisco IP Gateway decoders that you can configure
  - Encoders—Displays a list of the Cisco IP Gateway encoders that you can configure
  - Video Recorders—Displays a list of the Services Platforms and Integrated Services Platforms that you can configure
  - Hybrid Decoder—Displays a list of the hybrid decoders that you can configure

To expand or collapse a set of links, click the Up Arrow or the Down Arrow button next to System Configuration or Device Configuration.

To access configuration options, follow these steps:

**Procedure**

**Step 1**

In the Loaded Modules are, click the link for the system information or device type that you want to configure.

If you click Sequences and Tours or User Rights and Privileges, relevant configuration options appear. For detailed information about configuring these items, see the appropriate section in this chapter.

If you click Alarms, Decoders, Encoders, Video Recorders, or Hybrid Decoders, the system displays a list of the devices that you can configure.

**Figure 4-2** shows an example of how the Configuration module appears appear after you choose Decoders from the Loaded Modules area.
Step 2  If the system displays a list of the devices that you can configure, take any of these actions:

- To specify how the list of devices appears, click the Down Arrow button next to Views and choose the view that you prefer, or click the Views button to toggle between view formats. Views are:
  - Details—Displays each device on its own row, and displays the IP address, firmware version, operating system version, and MAC address of each device. The alarms window also displays the device type.
  - Tile—Displays each device as an icon, and displays the IP address and firmware version. The alarms window also displays the device type.
- To display configuration options for a device by choosing it from a list, double-click the device name in either view.
- To display configuration options for a device if you know its name, type the device name in the Search field and then click Edit.
- To make sure that the device list is current, click Refresh.

For detailed information about configuring these devices, see the appropriate section in this chapter.
Pinning the Loaded Modules Display

You can pin the Loaded Modules area so that it always displays in the Stream Manager Configuration window. If you do not pin the Loaded Modules area, it displays only when needed.

To turn pinning on and off, click the Pin icon at the top of the Loaded Modules area. Pinning or unpinning has these effects:

- **Pinned**—The Loaded Modules area always appears when the Stream Manager Configuration window is open.
- **Unpinned**—The Loaded Modules area collapses a few seconds after you move the mouse pointer out of the Loaded Modules area. To redisplay the Loaded Modules area, move the mouse pointer to the Toolbox icon near the top left of the Stream Manager Configuration window.

Configuring Alarms

An alarm is an event that is detected by a device and that triggers one or more actions that the Cisco Video Surveillance system takes. You can specify the events that cause an alarm and configure the actions that the system performs when an alarm occurs.

An alarm can be caused by these events:

- **Activity detection**—Activity detected within a predefined region of a video view. Applies only to recorders.
- **Contact closure**—Changed contact state is detected on an encoder or decoder, caused by an electrical current sent by a sensor. These alarms can provide notification of events such as an open door or window. Applies to encoders and decoders.
- **Recording failure**—Recording failure on the designated port on a recorder. Applies only to recorders.
- **Video loss**—Video loss on the designated port of the device. Applies to encoders and recorders.
- **RAID Failure**—A RAID unit failure on a Services Platform or Integrated Services Platform.

To configure an alarm for a device, follow these steps:

**Procedure**

**Step 1** Click **Alarms** in the Loaded Modules area and then choose the device for which you want to configure alarms.

For more detailed instructions, see the “Accessing System or Device Configuration Options” section on page 4-4.

When you select a device, the system displays each alarm type that can be configured for the device. A red X ✗ indicates that the alarm is not configured. A green check ✓ indicates that the alarm is configured.

**Step 2** Double click the type alarm that you want to configure.

The Alarm area appears. This area includes configuration options for the alarm type that you chose.

**Step 3** Check the **Enable Alarm Type** check box.
Step 4 In the Alarm Settings area, enter the information that is shown in Table 4-1.

Table 4-1 Alarm Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Description of the alarm. This description appears in the Stream Manager Client Module Events list if the alarm is triggered.</td>
</tr>
<tr>
<td>Delay</td>
<td>Time, in seconds, that an event is active before an alarm is triggered.</td>
</tr>
<tr>
<td>Interval</td>
<td>When an alarm event persists, the amount of time, in seconds, before the alarm action is repeated.</td>
</tr>
<tr>
<td>Configure Activity Regions</td>
<td>Applies to activity detection alarm types only. Lets you specify up to three regions in a video field. An alarm is triggered after the specified delay period if activity is detected and persists in any of these regions. When configuring activity regions, you can take these actions:</td>
</tr>
<tr>
<td></td>
<td>• To specify a region, hold down the left mouse button at one corner of the desired region, drag the mouse pointer to the opposite corner of the region, then release the mouse button. The border turns yellow when the region is large enough to be used.</td>
</tr>
<tr>
<td></td>
<td>• To move a region, click the region and drag it to where you want.</td>
</tr>
<tr>
<td></td>
<td>• To resize a region, click the region and drag the desired handle.</td>
</tr>
<tr>
<td></td>
<td>• To remove a region, click the region then click the Delete Selected Region button.</td>
</tr>
<tr>
<td></td>
<td>• To specify the amount of activity in a region that causes an alarm, drag the Sensitivity slider to the desired value. A lower value means that more activity is required to trigger the alarm. A higher value means that less activity is required. To change this value for an individual region, click the region, then drag the slider.</td>
</tr>
<tr>
<td></td>
<td>• To test the activity setting that you made, click the Start Preview button, then perform activity in the area that the camera is recording. If activity is detected, the region turns red and the graph near the bottom of the window indicates activity. To stop the test, click the Stop Preview button.</td>
</tr>
<tr>
<td></td>
<td>• To exit the Regions Configuration area, click the Return to Alarm Settings button.</td>
</tr>
</tbody>
</table>
Configuring Alarms

Table 4-1   Alarm Settings (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm When</td>
<td>Applies to contact closure alarm types only. Lets you choose the contact event that triggers an alarm:</td>
</tr>
<tr>
<td></td>
<td>• Open—Alarm triggers when a contact changes from closed to open and remains open for the specified delay period</td>
</tr>
<tr>
<td></td>
<td>• Closed—Alarm triggers when a contact changes from open to closed and remains closed for the specified delay period</td>
</tr>
<tr>
<td></td>
<td>• TransOpen—Alarm triggers immediately when a contact opens, regardless of the configured delay period</td>
</tr>
<tr>
<td></td>
<td>• TransClosed—Alarm triggers immediately when a contact closes, regardless of the configured delay period</td>
</tr>
</tbody>
</table>

Step 5 In the Alarm Actions area, click the icon that corresponds to an action that you want to add for this alarm:

- Decode Action—Displays video from the designated camera on the designated monitor
- Message Action—Displays the designated message on the designated monitor for the time specified
- Preset Action—Causes the designated camera to perform the designated preset action
- Record Action—Causes a recording to be marked when an alarm triggers so that the recording can be easily located later
- Relay Action—Causes the designated Cisco Video Surveillance device to open or close a relay
- Encoding Change—Causes the streaming video parameters to change on an encoder

You can add as many actions as needed.

If you want to remove an action, highlight the action and click the red X icon next to the list of actions.

Step 6 In the Alarm Actions area, click the alarm action that you want to configure, and enter the applicable information as described in Table 4-2.

Table 4-2   Alarm Action Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings for Decode Alarm Action</td>
<td></td>
</tr>
<tr>
<td>Camera ID</td>
<td>ID of the camera from which video is displayed. This video appears on the monitor that you designate in the next field or on the configured alarm monitor.</td>
</tr>
<tr>
<td>Monitor ID</td>
<td>ID of the monitor on which to display video when an alarm occurs. This field is not available if you check the Use Alarm Monitor check box.</td>
</tr>
<tr>
<td>Use Alarm Monitor</td>
<td>Check this check box to display video on each monitor that is configured as an alarm monitor.</td>
</tr>
</tbody>
</table>
|                          | You configure an alarm monitor by checking the Show Alarms on this Monitor check box in the Device Settings area for a decoder. For more information, see the “Configuring Device Settings for a Decoder” section on page 4-26.
### Table 4-2 Alarm Action Settings (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Settings for Decode Alarm Action</strong></td>
<td></td>
</tr>
<tr>
<td>Monitor ID</td>
<td>ID of the monitor on which the message is displayed.</td>
</tr>
<tr>
<td>Message</td>
<td>Text of the message that displays on the monitor.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time, in seconds, that the message displays on the monitor.</td>
</tr>
<tr>
<td><strong>Settings for Preset Alarm Action</strong></td>
<td></td>
</tr>
<tr>
<td>Camera ID</td>
<td>ID of the camera that performs the preset action.</td>
</tr>
<tr>
<td>Preset ID</td>
<td>ID of the preset action that the camera performs.</td>
</tr>
<tr>
<td><strong>Settings for Record Alarm Action</strong></td>
<td></td>
</tr>
<tr>
<td>Camera ID</td>
<td>ID of the camera from which to record the video stream.</td>
</tr>
<tr>
<td>Duration</td>
<td>Time, in seconds, after the alarm triggers that the end mark is placed in the recording.</td>
</tr>
<tr>
<td>Pre Alarm</td>
<td>Time, in seconds, before an alarm triggers that the start mark is placed in the recording.</td>
</tr>
<tr>
<td><strong>Settings for Relay Alarm Action</strong></td>
<td></td>
</tr>
<tr>
<td>Device Name</td>
<td>Device to which to send the relay.</td>
</tr>
<tr>
<td>Port</td>
<td>Contact point that takes the close or open action on the device to which the relay is sent.</td>
</tr>
<tr>
<td>Duration</td>
<td>Time, in seconds, that the contact on the device to which the relay is sent remains closed or open.</td>
</tr>
<tr>
<td>Close Relay, Open Relay</td>
<td>Specifies the action that occurs on the device to which the relay is sent.</td>
</tr>
<tr>
<td><strong>Settings for Encoding Change Action</strong></td>
<td></td>
</tr>
<tr>
<td>Duration</td>
<td>Time, in seconds, that the encoding change persists.</td>
</tr>
<tr>
<td>Enter a number 1 through 9,999.</td>
<td></td>
</tr>
<tr>
<td>Camera ID</td>
<td>ID of the camera which the streaming parameter changes apply.</td>
</tr>
<tr>
<td>User Recorded Stream</td>
<td>Check this check box to apply the streaming parameter changes to the video stream that is being recorded.</td>
</tr>
<tr>
<td>Video Standard</td>
<td>Choose the video standard to apply to the video stream: NTSC or PAL.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Choose the resolution to apply to the video stream.</td>
</tr>
<tr>
<td>Framerate</td>
<td>Choose the frame rate to apply to the video stream.</td>
</tr>
</tbody>
</table>
Step 7  
Click **OK** to save the information that you entered in the Alarms area.
If you want to exit this area without saving your changes, click **Cancel**.

Step 8  
Click **Apply**.

## Configuring Sequences

A sequence consists of from 2 to 1,024 steps. Each step causes the video from a set of cameras to display on a set of monitors for a designated time. You can cause each PTZ camera to execute a preset action before its video displays. A sequence repeats indefinitely.

When you use sequences, be aware of the following guidelines:

- If two or more sequences execute simultaneously and the sequences are configured to cause different actions on the same device, the last action prevails.
- If you update a sequence that is executing, the updates take effect when the sequence next executes.
- If you remove a sequence that is executing, the current execution completes.
- You can run a sequence from a video keyboard. For instructions, see Chapter 7, “Using the Stream Manager On Screen Menus.”

The following sections describe how to configure sequences:

- **Adding a Sequence**, page 4-11
- **Updating a Sequence**, page 4-12
- **Removing a Sequence**, page 4-15
Chapter 4 Using the Stream Manager Configuration Module

Configuring Sequences

You perform these procedures in the Sequences Configuration area, as shown in Figure 4-3.

![Figure 4-3 Sequences Configuration Area](image)

**Note**

When you add, update, or remove a sequence, all decoders reboot. Perform these procedures when rebooting decoders will not disrupt your operations.

**Adding a Sequence**

You can add an unlimited number of sequences. To add a sequence, follow these steps:

**Procedure**

1. **Step 1** Click **Sequences and Tours** in the Loaded Modules area.
2. **Step 2** Click **Sequences** near the bottom of the Stream Manager Configuration window. The Sequences Configuration area appears, as shown in Figure 4-3.
3. **Step 3** Click **Add**.
4. **Step 4** In the Details area, take these actions:
   a. In the Name field, enter a name for the sequence.
   b. In the Sequence ID field, enter a unique ID for the sequence.
   c. Click **Apply**.
5. **Step 5** In the list of sequences, click the name of the sequence and then click **Edit**, or double-click the name of the sequence.
Step 6  Click Manage Group Steps.
This action will let you specify the dwell time for all cameras that display in this step.

Step 7  Click Add.

Step 8  In the Group Step Details area, take these actions:
   a. In the Dwell Time field, enter the time, in seconds, that the video from the cameras display.
   b. Click Apply.

Step 9  In the list of steps, click the name of the step and then click Edit, or double-click the name of the step.

Step 10  Click Manage Group Actions.
This action will let you designate which camera displays on which monitor when the sequence executes.

Step 11  Click Add.

Step 12  In the Action Details area, take these actions:
   a. In the Camera ID field, enter the ID of the camera that displays on the monitor that you specify in the next field.
   b. In the Monitor ID field, enter the ID of the monitor on which video from the camera displays.
   c. (Optional) In the Preset ID field, enter the identifier of a preset activity that a PTZ camera executes before its video displays.
   d. Click Apply.
   e. (Optional) Click Add and repeat this step as needed to define additional cameras and monitors.

Step 13  Click Return to current sequence group.

Step 14  Click Apply.

Step 15  Repeat Step 7 through Step 14 as needed to define additional steps in the sequence.

Step 16  Click Return to current sequence details.

Step 17  Click Apply.

Step 18  Click Update.

Step 19  In the window that warns you that current tours will be overwritten and decoders will reboot, click Yes.

---

Updating a Sequence

Updating a sequence lets you change the name or ID of the sequence, or add, modify, or remove steps or actions that the sequence performs. The updates take effect the next time that the sequence executes.

To update a sequence, follow these steps:

**Procedure**

Step 1  Click Sequences and Tours in the Loaded Modules area.

Step 2  Click Sequences near the bottom of the Stream Manager Configuration window.
The Sequences Configuration area appears, as shown in Figure 4-3 on page 4-11.

Step 3  In the list of sequences, click the name of the sequence then click Edit, or double-click the name of the sequence.
Step 4  Take one of these actions:

- To change the name or ID of a sequence:
  a. In the Name field, enter a new name for the sequence.
  b. In the Sequence ID field, enter a new unique ID for the sequence.
  c. Click Apply.

- To add a step:
  a. Click Manage Group Steps.
  b. Click Add.
  c. In the Dwell Time field, enter the time, in seconds, that the video from the cameras display.
  d. Click Apply.
  e. In the list of steps, click the name of the step and then click Edit, or double-click the name of the step.
  f. Click Manage Group Actions.
  g. Click Add.
  h. In the Camera ID field, enter the ID of the camera that displays on the monitor that you specify in the next field.
  i. In the Monitor ID field, enter the ID of the monitor on which video from the camera displays.
  j. (Optional) In the Preset ID field, enter the identifier of a preset activity that a PTZ camera executes before its video displays.
  k. Click Apply.
  l. Repeat substep g through substep k as needed to define additional actions.
  m. Click Return to current sequence group.
  n. Click Apply.
  o. Repeat substep a through substep n as needed to define additional steps.
  p. Click Return to current sequence details.
  q. Click Apply.

- To modify an existing step:
  a. Click Manage Group Steps.
  b. (Optional) If you want to remove a step, click the name of the step then click Remove.
  c. In the list of steps, click the name of the step and then click Edit, or double-click the name of the step.
  d. In the Dwell Time field, enter the time, in seconds, that the video from the cameras display.
  e. Click Apply.
  f. In the list of steps, click the name of the step and then click Edit, or double-click the name of the step.
  g. Click Manage Group Actions.
  h. (Optional) If you want to remove an action, click the name of the action then click Remove.
  i. In the list of steps, click the name of the step and then click Edit, or double-click the name of the step.
j. In the Camera ID field, enter the ID of the camera that displays on the monitor that you specify in the next field.

k. In the Monitor ID field, enter the ID of the monitor on which video from the camera displays.

l. (Optional) In the Preset ID field, enter the identifier of a preset activity that a PTZ camera executes before its video displays.

m. Click Apply.

n. Repeat substep g through substep k as needed to define additional actions.

o. Click Return to current sequence group.

p. Click Apply.

q. Repeat substep g through substep n as needed to define additional steps.

r. Click Return to current sequence details.

s. Click Apply.

Step 5 In the list of sequences, click the name of the sequence and then click Edit, or double-click the name of the sequence.

Step 6 Click Manage Group Steps.

This action will let you specify the dwell time for all cameras that display in this step.

Step 7 Click Add.

Step 8 In the Group Step Details area, take these actions:

a. In the Dwell Time field, enter the time, in seconds, that the video from the cameras display.

b. Click Apply.

Step 9 In the list of sequences, click the name of the sequence and then click Edit, or double-click the name of the sequence.

Step 10 Click Manage Group Actions.

This action will let you designate which camera displays on which monitor when the sequence executes.

Step 11 Click Add.

Step 12 In the Action Details area, take these actions:

a. In the Camera ID field, enter the ID of the camera that displays on the monitor that you specify in the next field.

b. In the Monitor ID field, enter the ID of the monitor on which video from the camera displays.

c. (Optional) In the Preset ID field, enter the identifier of a preset activity that a PTZ camera executes before its video displays.

d. Click Apply.

e. (Optional) Click Add and repeat this step as needed to define additional cameras and monitors.

Step 13 Click Return to current sequence group.

Step 14 Click Apply.

Step 15 Repeat Step 7 through Step 14 as needed to define additional steps in the sequence.

Step 16 Click Return to current sequence details.

Step 17 Click Apply.
Step 18  Click Update.
Step 19  In the window that warns you that current sequences will be overwritten and decoders will reboot, click Yes.

Removing a Sequence

You can remove any sequence from the system. If you remove a sequence that is executing, its execution stops.

To remove a sequence, follow these steps:

Procedure

Step 1  Click Sequences and Tours in the Loaded Modules area.
Step 2  Click Sequences near the bottom of the Stream Manager Configuration window.
The Sequences Configuration area appears, as shown in Figure 4-3 on page 4-11.
Step 3  Click the name of the sequence in the System Sequences list.
Step 4  Click Remove.
Step 5  Click Update.
Step 6  In the window that warns you that current sequences will be overwritten and decoders will reboot, click Yes.

Configuring Tours

A tour consists of from 1 to 1,024 steps. Each step causes the video from a designated camera to display for a designated time. You can cause each camera to execute a preset action before its video displays.

When you use tours, be aware of the following guidelines:

- If two or more tours execute simultaneously and the tours are configured to cause different actions on the same device, the last action prevails.
- If you update a tour that is executing, the updates take effect when the tour next executes.
- If you remove a tour that is executing, its execution completes.
- You can run a tour from a video keyboard. For instructions, see Chapter 7, “Using the Stream Manager On Screen Menus.”

The following sections describe how to configure tours:

- Adding a Tour, page 4-16
- Updating a Tour, page 4-17
- Removing a Tour, page 4-18

You perform these procedures in the Tours Configuration area, as shown in Figure 4-4.
Chapter 4 Using the Stream Manager Configuration Module

Configuring Tours

Note When you add, update, or remove a tour, all decoders reboot. Perform these procedures when rebooting decoders will not disrupt your operations.

Figure 4-4 Tours Configuration Area

Adding a Tour

You can add an unlimited number of tours. To add a tour, follow these steps:

Procedure

Step 1 Click Sequences and Tours in the Loaded Modules area.
Step 2 Click Tours near the bottom of the Stream Manager Configuration window.
   The Tours Configuration area appears, as shown in Figure 4-4.
Step 3 Click Add.
Step 4 In the Details area, take these actions:
   a. In the Name field, enter a name for the tour.
   b. In the Tour ID field, enter a unique ID for the tour.
   c. Click Apply.
Step 5 In the list of tours, click the name of the tour and then click Edit, or double-click the name of the tour.
Step 6 Click Manage Tour Steps.
Step 7 Click Add.
Step 8  In the Step Details area, take these actions to define the step:
   a. In the Camera ID field, enter the ID of the camera from which video displays.
   b. In the Preset ID field, enter the identifier of a preset activity that a PTZ camera executes before its video displays.
   c. In the Dwell Time field, enter the time, in seconds, that the video from the camera displays.
   d. Click Apply.
   e. (Optional) Click Add and repeat this step as needed to define additional steps.

Step 9  Click Return to current tour details.

Step 10 Click Apply.

Step 11 Click Update.

Step 12  In the window that warns you that current tours will be overwritten and decoders will reboot, click Yes.

## Updating a Tour

Updating a tour lets you add, modify, or remove steps that the tour performs. The updates take effect the next time that the tour executes.

To update a tour, follow these steps:

**Procedure**

**Step 1**  Click Sequences and Tours in the Loaded Modules area.

**Step 2**  Click Tours near the bottom of the Stream Manager Configuration window.

The Tours Configuration area appears, as shown in Figure 4-4 on page 4-16.

**Step 3**  In the list of tours, click the name of the tour and then click Edit, or double-click the name of the tour.

**Step 4**  Click Manage Tour Steps.

**Step 5**  Take one of these actions:

- To add a step:
  a. Click Add.
  b. In the Camera ID field in the Step Details area, enter the ID of the camera from which video displays.
  c. In the Preset ID field in the Step Details area, enter the identifier of a preset activity that a PTZ camera executes before its video displays.
  d. In the Dwell Time field in the Step Details area, enter the time, in seconds, that the video from the camera displays.
  e. Click Apply in the Step Details area.
  f. (Optional) Click Add and repeat this step as needed to define additional steps.

- To modify an exiting step:
  a. In the list of steps, click the name of the step and then click Edit, or double-click the name of the step.
b. In the Camera ID field in the Step Details area, enter the ID of the camera from which video displays.

c. In the Preset ID field in the Step Details area, enter the identifier of a preset activity that a PTZ camera executes before its video displays.

d. In the Dwell Time field in the Step Details area, enter the time, in seconds, that the video from the camera displays.

e. Click **Apply** in the Step Details area.

- To remove a step, click the name of the step, then click **Remove**.

**Step 6** Click **Return to current tour details**.
**Step 7** Click **Apply**.
**Step 8** Click **Update**.
**Step 9** In the window that warns you that current tours will be overwritten and decoders will reboot, click **Yes**.

---

**Removing a Tour**

You can remove any tour from the system. If you remove a tour that is executing, its execution stops.

To remove a tour, follow these steps:

**Procedure**

**Step 1** Click **Sequences and Tours** in the Loaded Modules area.
**Step 2** Click **Tours** near the bottom of the Stream Manager Configuration window.

The Tours Configuration area appears, as shown in **Figure 4-4 on page 4-16**

**Step 3** Click the name of the tour in the System Tours list.
**Step 4** Click **Remove**.
**Step 5** Click **Update**.
**Step 6** In the window that warns you that current tours will be overwritten and decoders will reboot, click **Yes**.

---

**Configuring User Rights and Privileges**

The user rights and privileges feature lets you set up and configure users, configure how a user can control specific cameras and monitors, and configure which cameras can display on which monitors.

Before you can access this feature, you must install the Services Platform database firmware on one Services Platform or Integrated Services Platform and you must configure a SQL connection. For more information, see Chapter 2, “Installing Stream Manager Software and Upgrading Firmware” and see the “Configuring the SQL Connection” section on page 4-3.
You can perform these user rights and privileges activities:

- Configuring User Information, page 4-19
- Configuring Monitor Access Rights, page 4-21
- Configuring Camera Access Rights, page 4-23
- Configuring Monitor Access Security, page 4-24
- Configuring System Security, page 4-25

## Configuring User Information

A user is someone who is able to operate the Cisco Video Surveillance system. For each user, you configure the information that is shown in Table 4-3.

### Table 4-3  User Information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Windows user name of the user on the computer from which the user runs the Stream Manager Client Viewing module.</td>
</tr>
<tr>
<td>User ID</td>
<td>Unique 4-digit login ID for the user. The user enters this ID when logging in from a camera keyboard.</td>
</tr>
<tr>
<td>PIN</td>
<td>Unique 4-digit login PIN for the user. The user enters this PIN when logging in from a camera keyboard.</td>
</tr>
<tr>
<td>Priority Level</td>
<td>Priority of the user with respect to other users. If more than one user attempts to take the same action simultaneously, such as moving a camera, the user with the highest priority level prevails. If users with the same priority level attempt to take the same action simultaneously, the user who first started the action prevails.</td>
</tr>
<tr>
<td>Grant Sequence and Tours Rights</td>
<td>Designates whether the user can run sequences and tours.</td>
</tr>
</tbody>
</table>

You can perform these user management activities:

- Adding a User, page 4-20
- Updating Information for a User, page 4-21
- Removing a User, page 4-21

You perform these procedures in the Use Information area, as shown in Figure 4-5.
Adding a User

When you add a user to the Cisco Video Surveillance system, the user can operate the system after logging in from a camera keyboard or accessing the Stream Manager Client Viewing module.

To add a user, follow these steps:

**Procedure**

1. **Step 1** Click **User Rights and Privileges** in the Loaded Modules area.
2. **Step 2** If the User Information area does not appear, click **User Information** near the bottom of the Stream Manager Configuration window.
3. **Step 3** Click **Add**.
4. **Step 4** Enter a user name, ID, PIN, and priority level for the user, and designate whether the user can operate sequences and tours.
   For an explanation of these items, see Table 4-3 on page 4-19.
5. **Step 5** Click **Apply** to add the user.
   If you do not want to add the user, click **Cancel**.
Chapter 4      Using the Stream Manager Configuration Module

Configuring User Rights and Privileges

Updating Information for a User

You can update user information for any user.

To update information for a user, follow these steps:

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Click <strong>User Rights and Privileges</strong> in the Loaded Modules area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>If the User Information area does not appear, click <strong>User Information</strong> near the bottom of the Stream Manager Configuration window.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the System Users list, click the name of the user whose information you want to update and then click <strong>Edit</strong>, or double-click the name of the user.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Update information for the user as needed. For an explanation of these items, see Table 4-3 on page 4-19.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click <strong>Apply</strong> to save the changes. If you do not want to change the information, click <strong>Cancel</strong>.</td>
</tr>
</tbody>
</table>

Removing a User

You can remove any user from the Cisco Video Surveillance System. This action takes effect within approximately 10 seconds after you execute it. If you remove a user who is operating the system, that user will no longer be able to operate the system after the action takes effect.

To remove a user, follow these steps:

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Click <strong>User Rights and Privileges</strong> in the Loaded Modules area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>If the User Information area does not appear, click <strong>User Information</strong> near the bottom of the Stream Manager Configuration window.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the System Users list, click the name of the user that you want to remove.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click <strong>Remove</strong>.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click <strong>OK</strong> in the confirmation dialog box to remove the user. If you do not want to remove the user, click <strong>Cancel</strong>.</td>
</tr>
</tbody>
</table>

Configuring Monitor Access Rights

When you configure monitor access rights, you designate whether a user can select a monitor to display video.
To configure monitor access rights, follow these steps:

**Procedure**

**Step 1** Click **User Rights and Privileges** in the Loaded Modules area.

**Step 2** Click **Monitor Access Rights** near the bottom of the Stream Manager Configuration window.

The Monitor Rights and Privileges Area appears, as shown in **Figure 4-6**.

**Figure 4-6  Monitor Rights and Privileges Area**

**Step 3** In the list of System Users, click the name of the user for whom you want to configure monitor access rights.

**Step 4** In the list of monitors, click a monitor that you want to configure for this user, then click in the adjacent columns to configure these items:

- **Select**—Allows this user to select the monitor to display video
- **Lock**—Prevents users with lower access levels from changing which camera video displays on a monitor

A green check ✓ indicates that an item is enabled. A red X ✗ indicates that an item is not enabled. A red dash — indicates a Lock item that cannot be enabled until its associated Select item is enabled.

Repeat this step as needed to configure other monitors for the user.

**Step 5** Click **Apply**.
Configuring Camera Access Rights

When you configure camera access rights, you designate the cameras that a user can select and the activities that the user can perform with that camera.

To configure camera access rights, follow these steps:

**Procedure**

**Step 1**
Click **User Rights and Privileges** in the Loaded Modules area.

**Step 2**
Click **Camera Access Rights** near the bottom of the Stream Manager Configuration window. The Camera Rights and Privileges Area appears, as shown in Figure 4-7.

**Step 3**
In the list of System Users, click the name of the user for whom you want to configure camera access rights.

**Step 4**
In the Camera Rights and Privileges area, select a camera that you want to configure for this user, then click in the adjacent columns to configure one or more of these items:

- **Select**—Allows this user to view live video from the camera
- **PTZ**—Allows this user to control PTZ functions on the camera
- **Lock**—Prevent users with lower priority levels from controlling the camera
- **Playback**—Allows this user to playback video that was recorded from the camera
- **Export**—Allows this user to export video that was recorded from the camera
Configuring User Rights and Privileges

A green check ✓ indicates that an item is enabled. A red X ❌ indicates that an item is not enabled. A red dash — indicates an item that cannot be enabled until an associated item is enabled.

Repeat this step as needed to configure other cameras for this user.

**Step 5**  
Click **Apply**.

---

**Configuring Monitor Access Security**

When you configure monitor access security, you designate which cameras can display video on the monitor.

To configure monitor access security, follow these steps:

**Procedure**

**Step 1**  
Click **User Rights and Privileges** in the Loaded Modules area.

**Step 2**  
Click **Monitor Access Security** near the bottom of the Stream Manager Configuration window.

The Monitor Access Security area appears as shown in **Figure 4-8**.

**Figure 4-8  Monitor Access Security Area**

---

**Step 3**  
In the System Monitor Assets list on the left, click the monitor for which you want to designate the cameras that can display video.

The names of the cameras that are designated as able to display video on the monitor appears in the Accessible list in the middle of the window.
Tip

To make sure that the Monitor Access Security area shows the most current information, click the Refresh button.

Step 4

Take these actions as needed:

- To add a camera to the Accessible list, click the camera name in the System Monitor Assets list on the right, then click the left arrow button.
- To remove a camera from the Accessible list, click the camera name in the Accessible list, then click the right arrow button.

### Configuring System Security

You can specify whether a device is secure. A secure device is a device for which applicable user rights and privileges can be enforced.

To configure system security, follow these steps:

#### Procedure

**Step 1**

Click User Rights and Privileges in the Loaded Modules area.

**Step 2**

Click System Security near the bottom of the Stream Manager Configuration window.

The System Security area appears. This window displays list of devices in the Cisco Video Surveillance network. Each device includes an icon that designates its security status, as shown in Table 4-4.

#### Table 4-4 Device Security Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Green Checkmark]</td>
<td>Security is enabled for the device</td>
</tr>
<tr>
<td>![Red X]</td>
<td>Security is not enabled for the device</td>
</tr>
<tr>
<td>![Shield]</td>
<td>The firmware on the device does not support security</td>
</tr>
<tr>
<td>![Question Mark]</td>
<td>An unsuccessful attempt has been made to compromise the security of the device</td>
</tr>
</tbody>
</table>

Tip

To make sure that the System Security area shows the most current information, click the Refresh button.

**Step 3**

To specify security for one or more devices, take any of these actions:

- To enable security for a device, click the device, then click the Enable button.
- To disable security for a device, click the device, then click the Disable button.
Configuring Decoders

You can configure the following settings for decoders in your Cisco Video Surveillance network:

- **Device settings**—Include the decoder name and time zone, the ID of the monitor that is attached to the decoder, video playback overlay settings, and whether the decoder plays back video from a secondary stream
- **Network settings**—Include the decoder IP address, DNS server, and MAC address information, Quality of Service (QoS) settings, and Simple Network Management Protocol (SNMP) settings
- **Media settings**—Designate the video standard and buffering for video output from the decoder
- **Overlay settings**—Designate whether the camera information and date and time appear on the monitor that is attached to the decoder, and when and where this information appears
- **Peripheral settings**—Include information about the video keyboard that is attached to the decoder

To configure a decoder, follow these steps:

**Procedure**

1. **Step 1**
   - Click **Decoders** in the Loaded Modules area, then display the options for the decoder that you want to configure.
   - For more detailed instructions, see the “Accessing System or Device Configuration Options” section on page 4-4.

2. **Step 2**
   - Perform the following activities as needed:
     - **Configuring Device Settings for a Decoder**, page 4-26
     - **Configuring Network Settings for a Decoder**, page 4-28
     - **Configuring Media Settings for a Decoder**, page 4-31
     - **Configuring Overlay Settings for a Decoder**, page 4-32
     - **Configuring Peripheral Settings for a Decoder**, page 4-33

3. **Step 3**
   - To update the decoder with the configuration that you specified, click **Apply**.
   - If you want to discard the configuration changes without updating the decoder, click **Cancel**.

**Configuring Device Settings for a Decoder**

Device settings for a decoder include options that identify the device and its time zone, the ID of the monitor that is attached to it, overlay settings for video played back by the attached monitor, and whether the decoder plays back video from a secondary stream.
To configure device settings, display the configuration area for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click **Device Settings**.

Figure 4-9 shows an example of the Device Settings area for a decoder.

![Figure 4-9  Device Settings Area for a Decoder](image)

Table 4-5 describes the device settings for a decoder.

**Table 4-5  Device Settings for a Decoder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Descriptive name for the decoder. This name must begin with an alphabetic character and can contain any combination of up to 32 alphabetic, numeric, and underscore characters.</td>
</tr>
<tr>
<td>Overlay</td>
<td>Choose one of these options to specify how overlay information appears on the monitor that is attached to this decoder when you play back video on the monitor:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Box</strong>—Overlay information appears in a box at the lower-right of the monitor screen.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Bar</strong>—Overlay information appears in a bar at the bottom of the monitor screen.</td>
</tr>
<tr>
<td>Monitor ID</td>
<td>Assign an identification number (digits only) to the monitor that is attached to this decoder.</td>
</tr>
</tbody>
</table>
Configuring Network Settings for a Decoder

Network settings for a decoder let you configure IP address options, DNS server options, SNMP options, and QoS options.

You must configure IP address options when you install a decoder or you may not be able to connect it to the network. Make sure that each decoder has a unique IP address. Devices with the same IP address cause conflicts on a network.

To configure network settings for a decoder, display the configuration screen for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click **Network Settings**. Then click any of these options:

- **Network Settings**—Configures network settings for a decoder. For detailed information, see the “Configuring Network Settings” section on page 4-28.
- **SNMP Settings**—Configures SNMP settings for a decoder. For detailed information, see the “Configuring SNMP Settings” section on page 4-29.
- **QoS Settings**—Configures QoS settings for a decoder. For detailed information, see the “Configuring QoS Settings” section on page 4-30.

To redisplay the Device Settings area and the main list of configuration settings, click **Return to Main Menu**.

### Configuring Network Settings

Network settings for a decoder include IP address options, DNS server options, and MAC address information.

To configure network settings, display the configuration area for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click **Network Settings**.

Figure 4-10 shows an example of the Network Settings area for a decoder.
Table 4-6 describes the network settings for a decoder.

Table 4-6  Network Settings for a Decoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IP address automatically</td>
<td>If DHCP is enabled in your network, click this radio button if you want DHCP to assign an IP address to the decoder.</td>
</tr>
<tr>
<td>Use the following IP address</td>
<td>Click this radio button if you want to manually enter an IP address, subnet mask, and default gateway for the decoder.</td>
</tr>
<tr>
<td>IP address</td>
<td>IP address of the decoder.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>Subnet mask of the decoder.</td>
</tr>
<tr>
<td>Default gateway</td>
<td>Default gateway for the decoder.</td>
</tr>
<tr>
<td>Obtain DNS server address automatically</td>
<td>If DNS is enabled in your network, click this radio button if you want the decoder to obtain the address of the DNS server automatically.</td>
</tr>
<tr>
<td>Use the following DNS server address</td>
<td>Click this radio button if you want to manually enter the IP addresses of the primary and an alternate DNS server.</td>
</tr>
<tr>
<td>Preferred DNS server</td>
<td>IP address of the primary DNS server.</td>
</tr>
<tr>
<td>Alternate DNS server</td>
<td>IP address of an alternate DNS server.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Display only. MAC address of the decoder.</td>
</tr>
</tbody>
</table>

Configuring SNMP Settings

SNMP enables the exchange of management information between the decoder and an SNMP server. You can configure various SNMP options for a decoder.
Figure 4-11 shows an example of the SNMP Settings area for a decoder.

**Table 4-7** describes the SNMP settings for a decoder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP</td>
<td>Check this check box if you want to enable SNMP for this decoder.</td>
</tr>
<tr>
<td>Compatibility</td>
<td>Choose the SNMP standard: V1 or V2.</td>
</tr>
<tr>
<td>SNMP Server</td>
<td>Enter the IP address of the SNMP server.</td>
</tr>
<tr>
<td>Community</td>
<td>Enter the SNMP community for this decoder.</td>
</tr>
<tr>
<td>Contact</td>
<td>Enter the name of the SNMP system administrator.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Displays the SNMP object identifier (OID) of the Cisco MIB.</td>
</tr>
</tbody>
</table>

**Configuring QoS Settings**

QoS marks IP packets that are sourced by the decoder with differentiated services code point (DSCP) values. You can configure various QoS options for a decoder.

Figure 4-12 shows an example of the Quality of Service Settings area for a decoder.
Table 4-8 describes the QoS settings for a decoder.

### Table 4-8 QoS Settings for a Decoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Management</td>
<td>Choose the QoS level for general communication from the decoder, such as device discovery replies.</td>
</tr>
<tr>
<td>Disable device Management QoS Settings</td>
<td>Check this check box if you want to disable QoS marking for device management.</td>
</tr>
<tr>
<td>Command/Control</td>
<td>Choose the QoS level for communication with devices that control video surveillance peripherals.</td>
</tr>
<tr>
<td>Disable command and control QoS Settings</td>
<td>Check this check box if you want to disable QoS marking for device command and control.</td>
</tr>
<tr>
<td>Video</td>
<td>Choose the QoS level for video data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable video QoS settings</td>
<td>Check this check box if you want to disable QoS marking for video.</td>
</tr>
<tr>
<td>Audio</td>
<td>Choose the QoS level for audio data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable audio QoS settings</td>
<td>Check this check box if you want to disable QoS marking for audio.</td>
</tr>
</tbody>
</table>

**Configuring Media Settings for a Decoder**

Media settings let you configure the video standard and buffering for video output from a decoder to a monitor.
To configure media settings, display the configuration area for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click Media Settings. Figure 4-13 shows an example of the Media Settings area for a decoder.

Figure 4-13  Media Settings Area for a Decoder

Table 4-9 describes media settings for a decoder.

Table 4-9  Media Settings for a Decoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Standard</td>
<td>Choose the video output type that the decoder provides to the attached monitor: NTSC or PAL.</td>
</tr>
<tr>
<td>Video Buffering</td>
<td>Use the slider to specify video buffering latency. Low Latency (default) minimizes video delay. Smooth Video enhances the video display but increases latency.</td>
</tr>
</tbody>
</table>

Configuring Overlay Settings for a Decoder

Overlay settings let you designate reference information that appears on a monitor that is connected to the decoder that you are configuring. You can specify whether a camera name and the system date and time appear on a monitor, when this information appears, and the position of this information on the monitor. These settings apply only when the monitor displays live video.

To configure overlay settings, display the configuration area for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click Overlay Settings. Figure 4-14 shows an example of the Video Overlay Settings area for a decoder.
Table 4-10 describes the overlay settings for a decoder.

**Table 4-10  Overlay Settings for a Decoder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Camera Title</td>
<td>If you check this check box, the overlay display includes the name of the camera that is capturing the video.</td>
</tr>
<tr>
<td>Show Date and Time</td>
<td>If you check this check box, the overlay display includes system date and time.</td>
</tr>
<tr>
<td>Always show video overlay</td>
<td>Click this radio button to constantly display overlay information.</td>
</tr>
<tr>
<td>Only show video overlay when switching</td>
<td>Click this radio button to briefly display overlay information when switching between video from live cameras.</td>
</tr>
<tr>
<td>Video Overlay Position</td>
<td>Designate where overlay information appears on the monitor. The Cisco logo represents the monitor screen. If you choose to display overlay information, click a corner of the logo to indicate where the overlay information should appear on the monitor.</td>
</tr>
</tbody>
</table>

**Configuring Peripheral Settings for a Decoder**

Peripheral settings let you enter information about the video surveillance keyboard that is attached to the decoder.

To configure peripheral settings, display the configuration area for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click **Peripheral Settings**.

Figure 4-15 shows an example of the Serial Settings area for a decoder.
Table 4-11 describes the peripheral settings for a decoder.

### Table 4-11  Peripheral Settings for a Decoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RS-232 Port Settings</strong></td>
<td></td>
</tr>
<tr>
<td>RS232 Keyboard attached</td>
<td>Check this check box if the keyboard that is attached to this decoder uses a RS-232 serial port.</td>
</tr>
<tr>
<td>Model</td>
<td>Choose the keyboard model that is attached to this decoder.</td>
</tr>
<tr>
<td>Baud rate</td>
<td>Choose the baud rate of the keyboard that is attached to this decoder.</td>
</tr>
<tr>
<td><strong>RS-422/485 Port Settings</strong></td>
<td></td>
</tr>
<tr>
<td>RS422/485 Keyboard attached</td>
<td>Check this check box if the keyboard that is attached to this decoder uses a RS-422 or RS-485 serial port.</td>
</tr>
<tr>
<td>Port protocol</td>
<td>Check the radio button that corresponds to the protocol of the RS-422 or RS-485 serial port.</td>
</tr>
<tr>
<td>Model</td>
<td>Choose the keyboard model that is attached to this decoder.</td>
</tr>
<tr>
<td>Baud rate</td>
<td>Choose the baud rate of the keyboard that is attached to this decoder.</td>
</tr>
</tbody>
</table>
Configuring Encoders

You can configure the following settings for encoders in your Cisco Video Surveillance network:

- **Device settings**—Designate the name of the decoder
- **Network settings**—Include the encoder IP address, DNS server, and MAC address information, Quality of Service (QoS) settings, and Simple Network Management Protocol (SNMP) settings
- **Media settings**—Include information about the video streams that the encoder receives and outputs, and about the audio stream that the encoder outputs
- **Peripheral settings**—Include information about the camera that is attached to the serial port of the encoder

To configure an encoder, follow these steps:

**Procedure**

**Step 1**
Click **Encoders** in the Loaded Modules area, then display the options for the encoder that you want to configure.

For more detailed instructions, see the “Accessing System or Device Configuration Options” section on page 4-4.

**Step 2**
Perform the following activities as needed:

- Configuring Device Settings for an Encoder, page 4-35
- Configuring Network Settings for an Encoder, page 4-36
- Configuring Media Settings for an Encoder, page 4-40
- Configuring Peripheral Settings for an Encoder, page 4-42

**Step 3**
To update the encoder with the configuration that you specified, click **Update**.

If you want to discard the configuration changes without updating the encoder, click **Cancel**.

Configuring Device Settings for an Encoder

Device settings for an encoder let you configure a descriptive name for the device.

To configure device settings, display the configuration screen for the encoder as described in the “Configuring Encoders” procedure on page 4-35, then click **Device Settings** in the list of encoder properties.

Figure 4-16 shows an example of the Device Settings area for an encoder.
Configuring Network Settings for an Encoder

Network settings for an encoder let you configure IP address options, DNS server options, SNMP options, and QoS options.

You must configure IP address options when you install an encoder or you may not be able to connect the device to the network. Make sure that each encoder has a unique IP address. Devices with the same IP address cause conflicts on a network.

To configure network settings, display the configuration screen for the encoder as described in the “Configuring Encoders” procedure on page 4-35, then click Network Settings in the list of encoder properties. Then click any of these options:

- **Network Settings**—Configures network settings for an encoder. For detailed information, see the “Configuring Network Settings” section on page 4-37.
- **SNMP Settings**—Configures SNMP settings for an encoder. For detailed information, see the “Configuring SNMP Settings” section on page 4-38.
QoS Settings—Configures QoS settings for an encoder. For detailed information, see the “Configuring QoS Settings” section on page 4-39.

To redisplay the Device Settings area and the main list of configuration settings, click Return to Main Menu.

Configuring Network Settings

Network settings for an encoder include IP address options, DNS server options, and MAC address information.

To configure network settings, display the configuration area for the encoder as described in the “Configuring Encoders” section on page 4-35, then click Network Settings. Figure 4-17 shows an example of the Network Settings area for an encoder.

Figure 4-17 Network Settings Area for an Encoder

Table 4-13 describes the network settings for an encoder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IP address automatically</td>
<td>If DHCP is enabled in your network, click this radio button if you want DHCP to assign an IP address to the encoder.</td>
</tr>
<tr>
<td>Use the following IP address</td>
<td>Click this radio button if you want to manually enter an IP address, subnet mask, and default gateway for the encoder.</td>
</tr>
<tr>
<td>IP address</td>
<td>IP address of the encoder.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>Subnet mask of the encoder.</td>
</tr>
<tr>
<td>Default gateway</td>
<td>Default gateway for the encoder.</td>
</tr>
</tbody>
</table>
Configuring Encoder Settings

Configuring SNMP Settings

SNMP enables the exchange of management information between the encoder and an SNMP server. You can configure various SNMP and QoS options for an encoder.

Figure 4-18 shows an example of the SNMP Settings area for an encoder.

Table 4-14 describes the SNMP options for an encoder.

Table 4-14  SNMP Settings for an Encoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP</td>
<td>Check this check box if you want to enable SNMP for this encoder.</td>
</tr>
<tr>
<td>Compatibility</td>
<td>Choose the SNMP standard: V1 or V2.</td>
</tr>
</tbody>
</table>
Chapter 4      Using the Stream Manager Configuration Module

Configuring Encoders

Configuring QoS Settings

QoS marks IP packets that are sourced by the decoder with differentiated services code point (DSCP) values. You can configure various QoS options for an encoder.

Figure 4-19 shows an example of the Quality of Service Settings area for an encoder.

Table 4-15 describes QoS options for an encoder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Management</td>
<td>Choose the QoS level for general communication from the encoder, such as device discovery replies.</td>
</tr>
<tr>
<td>Disable device management QoS settings</td>
<td>Check this check box if you want to disable QoS marking for device management.</td>
</tr>
<tr>
<td>Command/Control</td>
<td>Choose the QoS level for communication with devices that control video surveillance peripherals.</td>
</tr>
</tbody>
</table>
Configuring Encoders

Configuring Media Settings for an Encoder

Media settings include information about the primary and optional secondary video streams that the encoder receives and outputs, and about the audio stream that the encoder outputs.

The primary video stream is always sent to a recorder unless you specify to record the secondary stream.

To configure media settings, display the configuration screen for the decoder as described in the “Configuring Decoders” procedure on page 4-26, then click Media Settings in the list of encoder properties. Then, click the name of the video port that you want to configure on the encoder.

Figure 4-20 shows an example of the Media Settings area for an encoder.

Table 4-15 QoS Settings for an Encoder (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable command and control QoS settings</td>
<td>Check this check box if you want to disable QoS marking for command and control.</td>
</tr>
<tr>
<td>Video</td>
<td>Choose the QoS level for video data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable video QoS settings</td>
<td>Check this check box if you want to disable QoS marking for video.</td>
</tr>
<tr>
<td>Audio</td>
<td>Choose the QoS level for audio data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable audio QoS settings</td>
<td>Check this check box if you want to disable QoS marking for audio.</td>
</tr>
</tbody>
</table>

Table 4-16 describes the media settings for an encoder.
### Table 4-16 Media Settings for an Encoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Stream Settings</strong></td>
<td></td>
</tr>
<tr>
<td>Stream Description</td>
<td>Assign a name for the primary stream that is provided by the camera to this encoder.</td>
</tr>
<tr>
<td>Camera ID</td>
<td>Assign an ID number to the primary stream from the camera that is attached to this encoder.</td>
</tr>
<tr>
<td>Video Standard</td>
<td>Choose the analog video type that the camera provides to the encoder: NTSC or PAL.</td>
</tr>
<tr>
<td>Codec</td>
<td>Choose the codec that the encoder should use to encode the video that it receives.</td>
</tr>
<tr>
<td>Video Resolution</td>
<td>Choose the resolution for the primary IP video stream that the encoder outputs.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Choose the frame rate for the primary IP video stream that the encoder outputs.</td>
</tr>
<tr>
<td><strong>Bit Rate Model options</strong></td>
<td></td>
</tr>
<tr>
<td>Constant</td>
<td>Specifies that the encoder outputs the primary IP video stream at or close to a constant bit rate. Constant lets you limit bandwidth use, but can cause loss of video quality.</td>
</tr>
<tr>
<td>Bit Rate (appears if you choose <strong>Constant</strong>)</td>
<td>Specify the bit rate per second (bps) for the constant output.</td>
</tr>
<tr>
<td>Variable</td>
<td>Specifies that the encoder outputs the primary video stream at a variable rate. The rate varies according on the activity in the scene that the camera provides.</td>
</tr>
<tr>
<td>Quality (appears if you choose <strong>Variable</strong>)</td>
<td>Specifies the quality of the video. A higher value provides better video quality but consumes more bandwidth.</td>
</tr>
<tr>
<td><strong>Secondary Stream Settings</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Secondary Stream</td>
<td>Check this check box if you want the encoder to output video in two streams. This configuration is useful if you want to send the video to a monitor and a recorder.</td>
</tr>
<tr>
<td>Stream Description</td>
<td>Assign a name for the secondary stream that is provided by the camera to this encoder.</td>
</tr>
<tr>
<td>Camera ID</td>
<td>Assign an ID number to the secondary stream from the camera that is attached to this encoder.</td>
</tr>
<tr>
<td>If you check the <strong>Record Secondary Stream</strong> check box, the system automatically enters a value, which is the camera ID that you specified in the Primary Stream area + 10000.</td>
<td></td>
</tr>
<tr>
<td>Video Resolution</td>
<td>Choose the resolution for the secondary IP video stream that the encoder outputs.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Choose the frame rate for the secondary IP video stream that the encoder outputs.</td>
</tr>
</tbody>
</table>
Configuring Peripheral Settings for an Encoder

Peripheral settings let you enter information about the video surveillance camera that is attached to the encoder.

To configure peripheral settings, display the configuration screen for the encoder as described in the “Configuring Encoders” procedure on page 4-35, then click Peripheral Settings.

Figure 4-21 shows an example of the Peripheral Settings area for an encoder.

---

**Table 4-16 Media Settings for an Encoder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Bit Rate Model options  | • Constant—Specifies that the encoder outputs the secondary IP video stream at or close to a constant bit rate. This setting lets you limit bandwidth use, but can cause loss of video quality.  
                          • Bit Rate (appears if you choose Constant)—Specify the bit rate per second (bps) for the constant output.  
                          • Variable—Specifies that the encoder outputs the secondary video stream at a variable rate. The rate varies according on the activity in the scene that the camera provides.  
                          • Quality (appears if you choose Variable)—Specifies the quality of the video. A higher value provides better video quality but consumes more bandwidth. |
| Record Secondary Stream | For a dual-stream encoder, check this check box to use stream 2 as the recorded signal. If you do not check this check box, stream 1 is used as the recorded signal. |
| Audio Settings          |                                                                                                                                              |
| Enable Audio            | Check this check box if you want to listen to or record audio from the microphone of a camera that is attached to the encoder.                  |
| Primary                 | Audio is transmitted on the primary stream.                                                                                            |
| Secondary               | Audio is transmitted on the secondary stream.                                                                                     |
| Sample Rate             | Choose a sample rate for the audio, in KHz per second. A higher value provides better audio quality but consumes more bandwidth.          |
| Channel(s) options      | Choose the channel for live or recorded audio:                                                                                           |
|                          | • Both—Both channels.                                                                                                                   |
|                          | • Left—Left channel.                                                                                                                    |
|                          | • Right—Left channel.                                                                                                                    |
Table 4-17 describes the peripheral settings for an encoder.

**Table 4-17 Peripheral Settings for an Encoder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RS-232 Port Settings</strong></td>
<td></td>
</tr>
<tr>
<td>RS-232 Camera Attached</td>
<td>Check this check box if the camera that is attached to the encoder uses RS-232 for PTZ control.</td>
</tr>
<tr>
<td>Model</td>
<td>Choose the camera model that is attached to the encoder.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Enter the baud rate of the camera.</td>
</tr>
<tr>
<td>Dome Address</td>
<td>Enter the address of the dome that houses the PTZ camera that is controlled by this encoder. The address can include up to 4 characters.</td>
</tr>
<tr>
<td>Home Position Timeout</td>
<td>Specifies how often, in seconds, the camera executes its preset 1 commands. For example, if you enter 7200, the camera executes its preset 1 commands every 2 hours. You can enter a number up to 9999.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If an operator is using the camera when the preset commands execute according to this schedule, the preset commands override the operator commands.</td>
</tr>
<tr>
<td><strong>RS-422 and RS-485 Port Settings</strong></td>
<td></td>
</tr>
<tr>
<td>RS422/485 Camera attached</td>
<td>Check this check box if the camera that is attached to the encoder uses RS-422 or RS-485 for PTZ control.</td>
</tr>
<tr>
<td>Port Protocol</td>
<td>Choose the protocol of the camera.</td>
</tr>
</tbody>
</table>
Configuring Recorders

Recorders include Cisco Video Surveillance Services Platforms and Integrated Services platforms. You can configure the following settings for recorders in your Cisco Video Surveillance network:

- Device settings—Include the name of the recorder, the pool to which it belongs, its recording mode, and various time master settings, if the recorder is configured to provide the master clock
- Storage monitor settings—Include options for monitoring the status of the RAID set in the recorder
- Analog video port settings—Include options for configuring audio and video for encoders in or connected to a recorder
- Network settings—Include the recorder IP address, DNS server, and MAC address information, QoS settings, and SNMP
- Video matrix settings—Include options for configuring a third-party switch in a hybrid video surveillance deployment
- Virtual video port settings—Include options for configuring cameras that are connected to the recorder through an Ethernet interface

To configure a recorder, follow these steps:

**Procedure**

**Step 1** Click *Video Recorders* in the Loaded Modules area, then display the options for the recorder that you want to configure.

For more detailed instructions, see the “Accessing System or Device Configuration Options” section on page 4-4.

**Step 2** Perform the following activities as needed:

- Configuring Device Settings for a Recorder, page 4-45
- Configuring Network Settings for a Recorder, page 4-46
- Configuring Storage Monitor Settings for a Recorder, page 4-50
Configuring Device Settings for a Recorder

Device settings for a recorder let you configure the name of the recorder, the pool to which it belongs, and its recording mode. If you designate that the recorder provides the master clock for the Video Surveillance system, you can also configure time master options.

To configure device settings, display the configuration screen for the recorder as described in the “Configuring Recorders” section on page 4-44, then click Device Settings.

Figure 4-22 shows an example of the Device Settings area for a recorder.

Table 4-18 describes the device settings for a recorder.
Configuring Recorders

Table 4-18  Device Settings for a Recorder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Descriptive name for the recorder. This name must begin with an alphabetic character and can contain any combination of up to 32 alphabetic, numeric, and underscore characters.</td>
</tr>
<tr>
<td>Pool</td>
<td>Enter the name of a pool in which this video recorder is grouped with hybrid recorders for video playback. This name can contain any combination of up to 32 characters.</td>
</tr>
</tbody>
</table>
| Video Recorder Mode     | Choose one of these options:  
  - Failover—Recorder serves as a failover device for a recorder that is deployed in a hybrid system.  
  - Normal—Recorder operates as a video recorder.  
  - Time Master—Recorder provides the master clock for the Video Surveillance system. |
| Time Master Settings    |                                                                                                                                               |
| Time Zone               | Time zone in which the recorder is located.                                                                                                  |
| Sync Interval           | Interval, in seconds, between each broadcast of time information from the recorder to other Cisco Video Surveillance devices.                 |
| Custom                  | Recorder obtains time information from a matrix switch via an RS-232 serial connection.                                                      |
| Daytime                 | Recorder obtains time information from a network server.                                                                                     |
| Internal                | Recorder obtains time information from its internal CMOS.                                                                                   |
| NTP                     | Recorder obtains time information from an NTP server.                                                                                        |
| Port                    | Serial port on the recorder that receives information from the matrix switch.                                                                     |
| Baud Rate               | Baud rate for the serial port that is connected to the matrix switch.                                                                         |
| Parity                  | Parity for the serial port that is connected to the matrix switch.                                                                           |
| Data Bits               | Data bits for the serial port that is connected to the matrix switch.                                                                          |
| Stop Bits               | Stop bits for the serial port that is connected to the matrix switch.                                                                           |
| Primary Server          | IP address of the primary server from which the recorder obtains daytime or NTP time information.                                               |
| Secondary Server        | IP address of a secondary server from which the recorder obtains daytime or NTP time information.                                               |

Configuring Network Settings for a Recorder

Network settings let you configure IP address, DNS server, QoS, and SNMP options for encoders that are hosted in a recorder or attached to the recorder through a USB connection.
To configure network settings for a recorder, display the configuration screen for the recorder as described in the “Configuring Recorders” section on page 4-44, then click Network Settings. Then click any of these options:

- **Network Settings**—Configures network settings for the recorder. For detailed information, see the “Configuring Network Settings” section on page 4-47.
- **SNMP Settings**—Configures SNMP settings for a recorder. For detailed information, see the “Configuring SNMP Settings for a Recorder” section on page 4-48.
- **QoS Settings**—Configures QoS settings for a recorder. For detailed information, see the “Configuring QoS Settings for a Recorder” section on page 4-49.

To redisplay the Device Settings area and the main list of configuration settings, click Return to Main Menu.

### Configuring Network Settings

Network settings for a recorder include IP address options, DNS server options, and MAC address information.

Figure 4-23 shows an example of the Network Settings area for a recorder.

**Figure 4-23  Network Settings Area for a Recorder**

Table 4-19 describes the network settings for a recorder.
Configuring Recorders

Table 4-19  Network Settings for a Recorder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IP address automatically</td>
<td>If DHCP is enabled in your network, click this radio button if you want DHCP to assign an IP address to the recorder.</td>
</tr>
<tr>
<td>Use the following IP address</td>
<td>Click this radio button if you want to manually enter an IP address, subnet mask, and default gateway for the recorder.</td>
</tr>
<tr>
<td>IP address</td>
<td>IP address of the recorder.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>Subnet mask of the recorder.</td>
</tr>
<tr>
<td>Default gateway</td>
<td>Default gateway for the recorder.</td>
</tr>
<tr>
<td>Obtain DNS server address</td>
<td>If DNS is enabled in your network, click this radio button if you want the recorder to obtain the address of the DNS server automatically.</td>
</tr>
<tr>
<td>automatically</td>
<td></td>
</tr>
<tr>
<td>Use the following DNS server</td>
<td>Click this radio button if you want to manually enter the IP addresses of the primary and an alternate DNS server.</td>
</tr>
<tr>
<td>address</td>
<td></td>
</tr>
<tr>
<td>Preferred DNS server</td>
<td>IP address of the primary DNS server.</td>
</tr>
<tr>
<td>Alternate DNS server</td>
<td>IP address of an alternate DNS server.</td>
</tr>
<tr>
<td>MAC Address</td>
<td><em>Display only.</em> MAC address of the recorder.</td>
</tr>
</tbody>
</table>

Configuring SNMP Settings for a Recorder

SNMP enables the exchange of management information between the recorder and an SNMP server. You can configure various SNMP options for a recorder.

Figure 4-24 shows an example of the SNMP Settings area for a recorder.
Table 4-20 describes the SNMP settings for a recorder.

**Table 4-20  SNMP Settings for a Recorder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP</td>
<td>Check this check box if you want to enable SNMP for this recorder.</td>
</tr>
<tr>
<td>Compatibility</td>
<td>Choose the SNMP standard: V1 or V2.</td>
</tr>
<tr>
<td>SNMP Server</td>
<td>Enter the IP address of the SNMP server.</td>
</tr>
<tr>
<td>Community</td>
<td>Enter the SNMP community for this recorder.</td>
</tr>
<tr>
<td>Contact</td>
<td>Enter the name of the SNMP system administrator.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Displays the SNMP object identifier (OID) of the Cisco MIB.</td>
</tr>
</tbody>
</table>

**Configuring QoS Settings for a Recorder**

QoS marks IP packets that are sourced by the decoder with differentiated services code point (DSCP) values. You can configure various QoS options for a recorder.

**Figure 4-25** shows an example of the Quality of Service Settings area for a recorder.
Configuring Recorders

Figure 4-25  Quality of Service Settings Area for a Recorder

Table 4-21 describes the QoS settings for a recorder.

Table 4-21  QoS Settings for a Recorder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Management</td>
<td>Choose the QoS level to be used for general communication from the recorder, such as device discovery replies.</td>
</tr>
<tr>
<td>Disable device management QoS settings</td>
<td>Check this check box if you want to disable QoS marking for device management.</td>
</tr>
<tr>
<td>Command/Control</td>
<td>Choose the QoS level for communication with devices that control video surveillance peripherals.</td>
</tr>
<tr>
<td>Disable command and control QoS settings</td>
<td>Check this check box if you want to disable QoS marking for command and control.</td>
</tr>
<tr>
<td>Video</td>
<td>Choose the QoS level for video data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable video QoS settings</td>
<td>Check this check box if you want to disable QoS marking for video.</td>
</tr>
<tr>
<td>Audio</td>
<td>Choose the QoS level for audio data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable audio QoS settings</td>
<td>Check this check box if you want to disable QoS marking for audio.</td>
</tr>
</tbody>
</table>

Configuring Storage Monitor Settings for a Recorder

You can configure storage monitoring, which maintains data so that the system can monitor the status of the RAID set in a recorder.
To configure storage monitor settings for a recorder, display the configuration screen for the recorder as described in the “Configuring Recorders” procedure on page 4-44, then click Storage Monitor Settings. Figure 4-26 shows an example of the Storage Monitor Settings area for a recorder.

**Figure 4-26  Storage Monitor Settings Area for a Recorder**

![Storage Monitor Settings Area for a Recorder](image)

Table 4-22 describes the storage monitor settings for a recorder.

**Table 4-22   Storage Monitor Settings for a Recorder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Storage Monitoring</td>
<td>Allows the Client View Module to retrieve RAID set status information from this recorder.</td>
</tr>
<tr>
<td>Storage Units</td>
<td>Type of RAID arrays in the recorder.</td>
</tr>
<tr>
<td>Monitoring Interval</td>
<td>How often, in seconds, the recorder updates its status information.</td>
</tr>
<tr>
<td>Unit 1 IP Address</td>
<td>IP address of an external storage device that is connected to the recorder.</td>
</tr>
<tr>
<td>Enable Unit 2</td>
<td>Indicates that a second storage device is connected to the recorder.</td>
</tr>
<tr>
<td>Unit 2 IP Address</td>
<td>IP address of a second external storage device that is connected to the recorder.</td>
</tr>
</tbody>
</table>

**Configuring Video Matrix Settings for a Recorder**

Video matrix settings for a recorder let you configure connections to a third-party switch in a hybrid video surveillance deployment.
To configure video matrix settings for a recorder, display the configuration screen for the recorder as described in the “Configuring Recorders” procedure on page 4-44, then click Video Matrix Settings. Figure 4-27 shows an example of the Video Matrix Settings area for a recorder.

**Figure 4-27   Video Matrix Settings Area for a Recorder**

Table 4-23 describes the video matrix settings for a recorder.

**Table 4-23   Video Matrix Settings for a Recorder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Matrix Keyboard</td>
<td>Check this check box if the recorder is connected to a matrix switch.</td>
</tr>
<tr>
<td>Video Matrix</td>
<td>Select the manufacturer or model of the matrix switch.</td>
</tr>
<tr>
<td>Playback Timeout</td>
<td>Time, in seconds, that video playback stops automatically. Enter 1 to 9999.</td>
</tr>
<tr>
<td>Instant Replay</td>
<td>Number of seconds before the current time that instant replay start.</td>
</tr>
<tr>
<td>Date Time Format</td>
<td>Format of the date and time display that appears on a monitor during video playback.</td>
</tr>
</tbody>
</table>

**Configuring Analog Video Ports Settings for a Recorder**

Analog video port settings let you configure various audio, video, and grooming options for encoders that are hosted in a recorder or attached to the recorder through a USB connection.
To configure analog video port settings for a recorder, display the configuration screen for the recorder as described in the “Configuring Recorders” procedure on page 4-44, then click **Analog Video Ports Settings**. Then click any of these options:

- **Port Audio Settings**—Configures options for recorded audio. For detailed information, see the “Configuring Port Audio Settings for a Recorder” section on page 4-53.
- **Port Grooming Settings**—Configures how long the system attempts to store recorded information. For detailed information, see the “Configuring Port Grooming Settings for a Recorder” section on page 4-54.
- **Port Video Settings**—Configures options for recorded video. For detailed information, see the “Configuring Port Video Settings for a Recorder” section on page 4-55.
- **Port Video Adjustment Settings**—Lets you control the appearance of played-back video. For detailed information, see the “Configuring Port Video Adjustment Settings for a Recorder” section on page 4-57.
- **Port PTZ Camera Control Settings**—Lets you let enable PTZ control of a camera for the designated port. For detailed information, see the “Configuring Port PTZ Camera Control Settings for a Recorder” section on page 4-58.

To redisplay the Device Settings area and the main list of configuration settings, click **Return to Main Menu**.

### Configuring Port Audio Settings for a Recorder

Port audio settings affect the audio of recordings from the designated port on the recorder. Figure 4-28 shows an example of the Port Audio Settings area for a recorder.

**Figure 4-28  Port Audio Settings Area for a Recorder**
The Port Audio Settings area displays this information:

- Port Settings—Lists the ports on the recorder. ID is the ID of the camera that is connected to the video port. Port Name is the name of the video port.
- Video feed from the camera.
- Configuration options.

To configure audio settings for a recorder port, click the port in the list of ports and configure the items that are shown in Table 4-24.

### Table 4-24 Port Audio Settings for a Recorder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Port</td>
<td>Check this check box if you want to disable recording on this port.</td>
</tr>
<tr>
<td>Enable Port Audio</td>
<td>Enables audio recording for the selected port.</td>
</tr>
<tr>
<td>Sample Rate</td>
<td>Choose a sample rate for the audio, in KHz per second. A higher value provides better audio quality but consumes more bandwidth.</td>
</tr>
<tr>
<td>Channel(s)</td>
<td>Choose the channel from which audio is recorder:</td>
</tr>
<tr>
<td></td>
<td>• Both—Both channels.</td>
</tr>
<tr>
<td></td>
<td>• Left—Left channel.</td>
</tr>
<tr>
<td></td>
<td>• Right—Left channel.</td>
</tr>
</tbody>
</table>

#### Configuring Port Grooming Settings for a Recorder

Port grooming settings specify how long the system attempts to retain recorded video from the designated port on the recorder before overwriting it.

**Note**

A recorder begins to overwrite video data when reaches its maximum storage capacity, which may be before the target retention time.

*Figure 4-29* shows an example of the Port Grooming area for a recorder.
Figure 4-29  Port Grooming Area for a Recorder

The Port Grooming area displays this information:

- **Port Settings**—Lists the ports on the recorder. ID is the ID of the camera that is connected to the video port. Port Name is the name of the video port.

- **Video feed from the camera.**

- **Configuration options.**

To configure port grooming settings for a recorder, click the port in the list of ports and configure the items that are shown in Table 4-25.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Port</td>
<td>Check this check box if you want to disable recording on this port.</td>
</tr>
<tr>
<td>Retention</td>
<td>Target length of time for retention of recorded video on this port.</td>
</tr>
<tr>
<td></td>
<td>If a recorder reaches its maximum storage capacity before this time, it begins to overwrite video data.</td>
</tr>
</tbody>
</table>

Configuring Port Video Settings for a Recorder

Port video settings affect the video recordings from the designated port on the recorder. Figure 4-30 shows an example of the Port Video Settings area for a recorder.
Figure 4-30  Port Video Settings Area for a Recorder

The Port Video Settings area displays this information:

- Port Settings—Lists the ports on the recorder. ID is the ID of the camera that is connected to the video port. Port Name is the name of the video port.
- Video feed from the camera.
- Configuration options.

To configure port video settings for a recorder, click the port in the list of ports and configure the items that are shown in Table 4-26.

Table 4-26  Port Video Settings for a Recorder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Port</td>
<td>Check this check box if you want to disable recording on this port.</td>
</tr>
<tr>
<td>Camera Title</td>
<td>Assign a name to the camera that provides a video stream to the port.</td>
</tr>
<tr>
<td>Camera ID</td>
<td>Assign an ID number to the stream from the camera that is attached to this video port.</td>
</tr>
<tr>
<td>Video Standard</td>
<td>Choose the analog video type that the camera provides to the video port: NTSC or PAL.</td>
</tr>
<tr>
<td>Codec</td>
<td>Choose the codec that the video port should use to encode the video that it receives.</td>
</tr>
<tr>
<td>Video Resolution</td>
<td>Choose the resolution for the recorded video stream.</td>
</tr>
</tbody>
</table>
Configuring Recorders

Configuring Port Video Adjustment Settings for a Recorder

Port video adjustment settings let you control the appearance of video that displays on a monitor from the designated port on the recorder.

Figure 4-31 shows an example of the Port Video Adjustments area for a recorder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame Rate</td>
<td>Choose the frame rate for the recorded video stream.</td>
</tr>
<tr>
<td>Bit Rate Model options</td>
<td>• Constant—Specifies that the video stream is recorded at or close to a constant bit rate. Constant lets you limit bandwidth use, but can cause loss of video quality.</td>
</tr>
<tr>
<td></td>
<td>• Bit Rate (appears if you choose Constant)—Specify the bit rate per second (bps) for the recorded video stream.</td>
</tr>
<tr>
<td></td>
<td>• Variable—Specifies that the video stream is recorded at a variable rate. The rate varies according on the activity in the scene that the camera provides.</td>
</tr>
<tr>
<td></td>
<td>• Quality (appears if you choose Variable)—Specifies the quality of the video. A higher value provides better video quality but consumes more bandwidth.</td>
</tr>
</tbody>
</table>

Table 4-26  Port Video Settings for a Recorder (continued)
The Port Video Adjustments area displays this information:

- Port Settings—Lists the ports on the recorder. ID is the ID of the camera that is connected to the video port. Port Name is the name of the video port.
- Video feed from the camera.
- Configuration options.

To configure port video adjustment settings for a recorder, click the port in the list of ports and configure the items that are shown in Table 4-27.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Port</td>
<td>Check this check box if you want to disable recording on this port.</td>
</tr>
<tr>
<td>Brightness</td>
<td>Use the slider to control the brightness of the video display.</td>
</tr>
<tr>
<td>Contrast</td>
<td>Use the slider to control the contrast of the video display.</td>
</tr>
<tr>
<td>Saturation</td>
<td>Use the slider to control the color saturation of the video display.</td>
</tr>
<tr>
<td>Hue</td>
<td>Use the slider to control the hue of the video display.</td>
</tr>
<tr>
<td>Reset</td>
<td>Reset brightness, contrast, saturation, and hue settings to their default values.</td>
</tr>
</tbody>
</table>

**Configuring Port PTZ Camera Control Settings for a Recorder**

Port PTZ camera control settings let you enable PTZ control of a camera for the designated port. Figure 4-32 shows an example of the Port PTZ Camera Control area for a recorder.
Before you can configure port PTZ camera control settings, you must configure PTZ control settings for the recorder as described in the “Configuring PTZ Camera Control Settings for a Recorder” section on page 4-61.

The Port PTZ Camera Control area displays this information:

- Video feed from the camera.
- Configuration options.

To configure port PTZ camera control settings for a recorder, click the port in the list of ports and configure the items that are shown in Table 4-28.

**Table 4-28 Port PTZ Camera Control settings for a Recorder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Port</td>
<td>Check this check box if you want to disable recording on this port.</td>
</tr>
<tr>
<td>Enable PTZ Control</td>
<td>Check this check box to enable PTZ control for this port.</td>
</tr>
<tr>
<td>Dome Address</td>
<td>Enter the dome address of the PTZ camera that this port controls.</td>
</tr>
<tr>
<td>Home Position Timeout</td>
<td>Specifies how often, in seconds, the camera executes its preset 1 commands. For example, if you enter 7200, the camera executes its preset 1 commands every 2 hours. You can enter a number up to 9999.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If an operator is using the camera when the preset commands execute according to this schedule, the preset commands override the operator commands.</td>
</tr>
</tbody>
</table>
Configuring Virtual Video Ports for a Recorder

Virtual video port settings let you configure options for a camera or encoder that is connected to the recorder through an Ethernet interface. These settings do not affect cameras that are attached to the recorder through an encoder through a BNC connection.

To configure virtual video ports for a recorder, display the configuration screen for the recorder as described in the “Configuring Recorders” procedure on page 4-44, click Virtual Video Ports, then take any of these actions:

- Add a new virtual port. See the “Adding a Virtual Video Port” section on page 4-60.
- Delete a virtual port. See the “Removing a Virtual Video Port” section on page 4-61
- Configure an existing virtual port. See the “Configuring a Virtual Video Port” section on page 4-61.

Figure 4-33 shows an example of the Virtual Video Ports area for a recorder.

Adding a Virtual Video Port

To add a virtual port, click Add, configure the information that is described in Table 4-29, then click OK.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Title</td>
<td>Name of the virtual port.</td>
</tr>
<tr>
<td>Model</td>
<td>Model of the camera or encoder that is attached to the virtual port.</td>
</tr>
</tbody>
</table>
Removing a Virtual Video Port

To remove a virtual port, click the port in the list of ports then click Remove.

Configuring a Virtual Video Port

To configure an existing virtual port, click the port in the list of ports, then configure the options that are described in Table 4-30.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera Title</td>
<td>Name of the camera or encoder that provides the video stream.</td>
</tr>
<tr>
<td>Model</td>
<td>Model of the camera or encoder that provides the video stream.</td>
</tr>
<tr>
<td>Camera ID</td>
<td>Unique ID of the camera or encoder that provides the video stream.</td>
</tr>
<tr>
<td>Use Recorded Stream</td>
<td>Check this check box to record from the secondary stream of an encoder. If you check this check box, the system automatically enters a value</td>
</tr>
<tr>
<td></td>
<td>that value in the Camera ID field by 10000.</td>
</tr>
<tr>
<td>IP Address</td>
<td>IP address of the camera that provides the video stream.</td>
</tr>
<tr>
<td>Retention</td>
<td>Target length of time for retention of recorded video from this port. If a recorder reaches its maximum storage capacity before this time,</td>
</tr>
<tr>
<td></td>
<td>begins to overwrite video data then.</td>
</tr>
</tbody>
</table>

Configuring PTZ Camera Control Settings for a Recorder

PTZ Camera Control settings for a recorder let you configure the control of PTZ cameras for this recorder.
To configure PTZ camera control settings, display the configuration screen for the recorder as described in the “Configuring Recorders” section on page 4-44, then click PTZ Camera Control Settings.

After you configure camera control settings for a recorder, enable PTZ control of a camera for designated ports as described in the “Configuring Port PTZ Camera Control Settings for a Recorder” section on page 4-58.

Figure 4-34 shows an example of the PTZ Camera Control Settings area for a recorder.

![Figure 4-34 PTZ Camera Control Area for a Recorder](image)

Table 4-18 describes the PTZ camera control settings for a recorder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable PTZ camera control</td>
<td>Check this check box to enable PTZ camera control through a serial port on this recorder.</td>
</tr>
<tr>
<td>PTZ Camera Control Port</td>
<td>Choose the port through which PTZ control information is sent from the recorder.</td>
</tr>
<tr>
<td>PTZ Camera Control Port Protocol</td>
<td>Choose the protocol that is used for PTZ control information.</td>
</tr>
<tr>
<td>PTZ Model</td>
<td>Choose the model of the PTZ camera to which this recorder sends control information.</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>Choose the baud rate at which this recorder sends control information.</td>
</tr>
</tbody>
</table>
Configuring Hybrid Decoders

A hybrid decoder plays back recorded video in a hybrid deployment. You can configure the following settings for hybrid decoders in your Cisco Video Surveillance network:

- **Device settings**—Include the name of the hybrid decoder, how it displays overlay information, and the pool to which it belongs.
- **Network settings**—Include the encoder IP address, DNS server, and MAC address information, Quality of Service (QoS) settings, and Simple Network Management Protocol (SNMP) settings.
- **Media settings**—Include options for configuring the time zone of the encoder, video port on the matrix switch that it is attached to, and video output that it provides.

To configure a hybrid decoder, follow these steps:

**Procedure**

**Step 1**
Click **Hybrid Decoder** in the Loaded Modules area, then display the options for the hybrid decoder that you want to configure.

For more detailed instructions, see the “Accessing System or Device Configuration Options” section on page 4-4.

**Step 2**
Perform the following activities as needed:

- Configuring Device Settings for a Hybrid Decoder, page 4-63
- Configuring Network Settings for a Hybrid Decoder, page 4-65
- Configuring Media Settings for a Hybrid Decoder, page 4-68

**Step 3**
To update the decoder with the configuration that you specified, click **Update**.

If you want to discard the configuration changes without updating the decoder, click **Cancel**.

Configuring Device Settings for a Hybrid Decoder

Device settings for a hybrid decoder let you configure the name of the device, how it displays overlay information, and the pool to which it belongs.

To configure device settings, display the configuration screen for the decoder as described in the “Configuring Hybrid Decoders” procedure on page 4-63, then click **Device Settings**.

Figure 4-35 shows an example of the Device Settings area for a hybrid decoder.
Table 4-32 describes the device settings for a hybrid decoder.

Table 4-32  Device Settings for a Hybrid Decoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Name</td>
<td>Descriptive name for the hybrid decoder. This name must begin with an alphabetic character and can contain any combination of up to 32 alphabetic, numeric, and underscore characters.</td>
</tr>
</tbody>
</table>
| Overlay   | Choose one of these options to specify how overlay information appears on the monitor that is attached to this hybrid decoder when you play back video on the monitor:  
  - Box—Overlay information appears in a box at the lower-right of the monitor screen.  
  - Bar—Overlay information appears in a bar at the bottom of the monitor screen. Overlay information includes the camera ID, and the date and time that the recording was made. |
| Pool      | Enter the name of a pool in which this hybrid recorder is grouped with a video recorder for video playback. This name can contain any combination of up to 32 characters. |
Configuring Network Settings for a Hybrid Decoder

Network settings for a hybrid decoder let you configure IP address options, DNS server options, SNMP options, and QoS options.

You must configure IP address options when you install a decoder or you may not be able to connect the device to the network. Make sure that each decoder has a unique IP address. Devices with the same IP address cause conflicts on a network.

To configure network settings, display the configuration screen for the decoder as described in the “Configuring Hybrid Decoders” procedure on page 4-63, then click Network Settings in the list of encoder properties. Then click any of these options:

- **Network Settings**—Configures network settings for a hybrid decoder. For detailed information, see the “Configuring Network Settings” section on page 4-65.
- **SNMP Settings**—Configures SNMP settings for a hybrid decoder. For detailed information, see the “Configuring SNMP Settings” section on page 4-67.
- **QoS Settings**—Configures Qos settings for a hybrid decoder. For detailed information, see the “Configuring QoS Settings” section on page 4-67.

To redisplay the Device Settings area and the main list of configuration settings, click Return to Main Menu.

Configuring Network Settings

Network settings for a hybrid decoder include IP address options, DNS server options, and MAC address information.

Figure 4-36 shows an example of the Network Settings area for a hybrid decoder.
Figure 4-36  Network Settings Area for a Hybrid Decoder

Table 4-33 describes the network settings for a hybrid decoder.

Table 4-33  Network Settings for a Hybrid Decoder

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Obtain IP address automatically</td>
<td>If DHCP is enabled in your network, click this radio button if you want DHCP to assign an IP address to the hybrid decoder.</td>
</tr>
<tr>
<td>Use the following IP address</td>
<td>Click this radio button if you want to manually enter an IP address, subnet mask, and default gateway for the hybrid decoder.</td>
</tr>
<tr>
<td>IP address</td>
<td>IP address of the hybrid decoder.</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>Subnet mask of the hybrid decoder.</td>
</tr>
<tr>
<td>Default gateway</td>
<td>Default gateway for the hybrid decoder.</td>
</tr>
<tr>
<td>Obtain DNS server address automatically</td>
<td>If DNS is enabled in your network, click this radio button if you want the hybrid decoder to obtain the address of the DNS server automatically.</td>
</tr>
<tr>
<td>Use the following DNS server address</td>
<td>Click this radio button if you want to manually enter the IP addresses of the primary and an alternate DNS server.</td>
</tr>
<tr>
<td>Preferred DNS server</td>
<td>IP address of the primary DNS server.</td>
</tr>
<tr>
<td>Alternate DNS server</td>
<td>IP address of an alternate DNS server.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>Display only. MAC address of the hybrid decoder.</td>
</tr>
</tbody>
</table>
Configuring SNMP Settings

SNMP enables the exchange of management information between the decoder and an SNMP server. You can configure various SNMP options for a hybrid decoder.

Figure 4-37 shows an example of the SNMP Settings area for a hybrid decoder.

![Figure 4-37 SNMP Settings Area for a Hybrid Decoder](image)

Table 4-34 describes the SNMP options for a hybrid decoder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable SNMP</td>
<td>Check this check box if you want to enable SNMP for this decoder.</td>
</tr>
<tr>
<td>Compatibility</td>
<td>Choose the SNMP standard: V1 or V2.</td>
</tr>
<tr>
<td>SNMP Server</td>
<td>Enter the IP address of the SNMP server.</td>
</tr>
<tr>
<td>Community</td>
<td>Enter the SNMP community for this decoder.</td>
</tr>
<tr>
<td>Contact</td>
<td>Enter the name of the SNMP system administrator.</td>
</tr>
<tr>
<td>Enterprise</td>
<td>Displays the SNMP object identifier (OID) of the Cisco MIB.</td>
</tr>
</tbody>
</table>

Configuring QoS Settings

QoS marks IP packets that are sourced by the decoder with differentiated services code point (DSCP) values. You can configure various options for a hybrid decoder.

Figure 4-38 shows an example of the Quality of Service Settings area for a hybrid decoder.
Configuring Hybrid Decoders

Table 4-35 describes the QoS options for a hybrid decoder.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Management</td>
<td>Choose the QoS level for general communication from the decoder, such as device discovery replies.</td>
</tr>
<tr>
<td>Disable device management QoS settings</td>
<td>Check this check box if you want to disable QoS marking for device management.</td>
</tr>
<tr>
<td>Command/Control</td>
<td>Choose the QoS level for communication with devices that control video surveillance peripherals.</td>
</tr>
<tr>
<td>Disable command and control QoS settings</td>
<td>Check this check box if you want to disable QoS marking for device command and control.</td>
</tr>
<tr>
<td>Video</td>
<td>Choose the QoS level for video data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable video QoS settings</td>
<td>Check this check box if you want to disable QoS marking for video.</td>
</tr>
<tr>
<td>Audio</td>
<td>Choose the QoS level for audio data that is sent across the IP network.</td>
</tr>
<tr>
<td>Disable audio QoS settings</td>
<td>Check this check box if you want to disable QoS marking for audio.</td>
</tr>
</tbody>
</table>

Configuring Media Settings for a Hybrid Decoder

Media settings let you configure the time zone of a hybrid decoder, video port on the matrix switch that it is attached to, and video output that it provides.
To configure media settings, display the configuration screen for the decoder as described in the “Configuring Hybrid Decoders” procedure on page 4-63, then click **Media Settings**. Figure 4-39 shows an example of the Media Settings area for a hybrid decoder.

**Figure 4-39  Media Settings Area for a Hybrid Decoder**

![Hybrid Decoders Configuration Screen](image)

Table 4-36 describes the media settings for a hybrid decoder.

**Table 4-36  Media Settings for a Hybrid Decoder**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Zone</td>
<td>Choose the time zone for the location in which the hybrid decoder is installed.</td>
</tr>
<tr>
<td>Matrix Input</td>
<td>Video input port number on the matrix switch to which the hybrid decoder is connected.</td>
</tr>
<tr>
<td>Video Standard</td>
<td>Choose the video output type that the hybrid decoder provides to the attached matrix switch: NTSC or PAL</td>
</tr>
</tbody>
</table>
CHAPTER 5

Using the Stream Manager Administration and Monitoring Module

The Cisco Video Surveillance Stream Manager Administration and Monitoring module monitors the operation of devices in a video surveillance network and provides valuable operating information and statistics. In addition, the Administration and Monitoring module takes the following actions if it detects a problem with a device:

- Provides detailed information in the Device Alerts area
- Adds detailed information to the log file
- Plays an alert tone (if this feature is configured)

This chapter includes these topics:

- Starting and Exiting the Administration and Monitoring Module, page 5-1
- Displaying Information about the Administration and Monitoring Module, page 5-2
- Configuring the Administration and Monitoring Module, page 5-3
- Managing the Device Tree, page 5-7
- Understanding Device Details, page 5-9
- Understanding Device Alerts, page 5-12
- Managing the Log File, page 5-13
- Managing Device Problems, page 5-14

Starting and Exiting the Administration and Monitoring Module

To start the Stream Manager Administration and Monitoring module, take either of these actions:

- Double-click the Stream Manager Administration and Monitoring module icon on your desktop.
- Choose Start > Programs > Cisco Video Surveillance Stream Manager > Stream Manager Monitor.

The Stream Manager Administration and Monitoring window appears, as shown Figure 5-1.
Displaying Information about the Administration and Monitoring Module

To determine the version of the Administration and Monitoring module and its components, Choose Help > About. In the About window, you can take these actions:

- Click OK to exit the window.
- Click System Info to display the Windows System Information window.
Configuring the Administration and Monitoring Module

Table 5-1 describes the options that you can configure in the Administration and Monitoring module.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration location</td>
<td>Location on a local or network drive where the system stores and accesses configuration files</td>
<td>See the “Specifying Configuration File Location” section on page 5-3</td>
</tr>
<tr>
<td>General options</td>
<td>Settings for time master and for device alerts</td>
<td>See the “Configuring General Options” section on page 5-4</td>
</tr>
<tr>
<td>Network options</td>
<td>IP address range of devices that the Administration and Monitoring module monitors, and refresh interval for the Administration and Monitoring window</td>
<td>See the “Configuring Network Options” section on page 5-4</td>
</tr>
<tr>
<td>Audio options</td>
<td>Location and name of sound files that the system plays to alert you of various situations</td>
<td>See the “Configuring Audio Alert Options” section on page 5-5</td>
</tr>
<tr>
<td>Failover</td>
<td>Events that cause a failover</td>
<td>See the “Configuring Failover” section on page 5-6</td>
</tr>
<tr>
<td>Still image location</td>
<td>Location where the system stores images that are captured using a video keyboard that is attached to a decoder</td>
<td>See the “Configuring Still Image Location” section on page 5-7</td>
</tr>
</tbody>
</table>

Specifying Configuration File Location

The configuration file location designates the folder in which the Administration and Monitoring module stores and accesses configuration files. This folder can be on the local PC or on a network computer. The default location is the following folder on the local PC, where Windows_user_name is the Windows user name that you are logged in as:

C:\Documents and Settings\Windows_user_name\Local Settings\Application Data\Cisco\StreamManagerMonitor

To specify a location for configuration files, follow these steps:

**Procedure**

1. **Step 1** From the Stream Manager Administration and Monitoring window, choose **Tools > Options**.
2. **Step 2** Choose the **Configuration** tab.
3. **Step 3** In the Configuration Location field, enter the folder in which the system stores and accesses configuration files.

   To browse to a folder, click the Browse button (which is labeled ...).
Configuring the Administration and Monitoring Module

Chapter 5 Using the Stream Manager Administration and Monitoring Module

Configuring General Options

General options include whether the PC on which you are running the Administration and Monitoring module obtains its time from a time master, how often the system clears device alerts, and how the system displays RAID alerts.

To configure general options, follow these steps:

Procedure

Step 1
From the Stream Manager Administration and Monitoring window, choose Tools > Options.

Step 2
Choose the General tab.

Step 3
Configure the options that are described in Table 5-2.

Table 5-2 General Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize clock with system</td>
<td>Check this check box to cause the PC on which you are running the Administration and Monitoring module to use the time from a recorder that is designated as a time master.</td>
</tr>
<tr>
<td>Delete Alerts that have been idle for n minutes</td>
<td>Enter the number of minutes that the system retains each alert in the device area. Alerts that are older than this time are deleted from the device area.</td>
</tr>
<tr>
<td>Silence “Raid Verification” alerts</td>
<td>Check this check box if you do not want RAID alerts to be shown as active alerts. In this case, RAID alerts are displayed in the Silenced tab in the Device Alerts area. This option is useful for separating RAID alerts from other alert types.</td>
</tr>
</tbody>
</table>

Step 4
Click OK.

Configuring Network Options

Network options include the IP address range for devices that the Administration and Monitoring module monitors and the refresh interval, which specifies how often the Administration and Monitoring module polls and updates information in the Administration and Monitoring Main window.

A lower refresh rate causes the display to update more often, but uses more network bandwidth. To conserve bandwidth, do not choose a refresh rate that is lower than you need.
To configure network options, follow these steps:

**Procedure**

**Step 1**
From the Stream Manager Administration and Monitoring window, choose **Tools > Options**.

**Step 2**
Choose the **Network** tab.

**Step 3**
Configure the options that are described in **Table 5-3**.

**Table 5-3  Network Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring Range: From</td>
<td>All video surveillance network devices with IP addresses within the range that you enter are monitored. Devices with IP addresses outside of this range are not monitored.</td>
</tr>
<tr>
<td>Monitoring Range: To</td>
<td>The default range is 0.0.0.0 to 255.255.255.255, which causes all devices to be monitored.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>Enter how often, in seconds, the system polls devices and updates displayed information.</td>
</tr>
<tr>
<td></td>
<td>Enter a value from 1 to 3600. The default value is 60.</td>
</tr>
</tbody>
</table>

**Step 4**
Click **OK**.

---

**Configuring Audio Alert Options**

You can configure the system to play an alert sound in any of the following situations:

- Video loss—Loss of video on an encoder or recorder.
- Recording failure—Recording failure on a recorder.
- Bad video—Video source that does not meets specifications on an encoder or recorder.
- RAID event—Problem with a RAID device on a recorder.
- Missing device—Device that the Administration and Monitoring module previously discovered is no longer available. (The device may have shut down or been removed from the network.)

In any of these situations, the system plays the .wav file that you specify.

If you do not configure a sound for a situation, the system does not play an alert in that situation.

To configure audio options, follow these steps:

**Procedure**

**Step 1**
From the Stream Manager Administration and Monitoring window, choose **Tools > Options**.

**Step 2**
Choose the **Audio** tab.
Step 3 Configure the options that are described in Table 5-4.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Loss Sound File</td>
<td>In each field, enter the path and file name of a .wav file that the system plays if the corresponding situation occurs. Leave a field blank if you do not want the system to play a sound for that situation.</td>
</tr>
<tr>
<td>Recording Failure Sound File</td>
<td>To browse to a folder, click the Browse button (which is labeled ...).</td>
</tr>
<tr>
<td>Bad Video Sound File</td>
<td>To listen to a .wav file, click the &gt; button next to an audio file type.</td>
</tr>
<tr>
<td>Raid Event Sound File</td>
<td></td>
</tr>
<tr>
<td>Missing Device Sound File</td>
<td></td>
</tr>
</tbody>
</table>

Step 4 Click OK.

Configuring Failover

The Administration and Monitoring can redirect (fail over) video streams to a backup Integrated Services Platform if it detects a failure event. You can configure the types of events that cause a failover. To do so, follow these steps:

Procedure

Step 1 From the Stream Manager Administration and Monitoring window, choose Tools > Options.
Step 2 Choose the Failover tab.
Step 3 Configure the options that are described in Table 5-5.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Loss</td>
<td>Check this check box if a recorder should fail over if it detects the loss of a video signal</td>
</tr>
<tr>
<td>Channel Recording Failure</td>
<td>Check this check box if a recorder should fail over if it cannot record video on a channel</td>
</tr>
<tr>
<td>Missing Recorder</td>
<td>Check this check box if a recorder should failover if when it is not visible on the network</td>
</tr>
</tbody>
</table>

Step 4 Click OK.
Configuring Still Image Location

When you use a video keyboard that is attached to a decoder to capture an image from a video stream, the Administration and Monitoring module saves the image. By default, the image is saved in the following folder on the PC on which you most recently started the Administration and Monitoring module, where Windows_user_name is the Windows user name that you are logged in as:

C:\Documents and Settings\Windows_user_name\My Documents\My Pictures

You can change this default location to another folder on a local or network PC. To do so, follow these steps:

**Procedure**

**Step 1** From the Stream Manager Administration and Monitoring window, choose **Tools > Options**.

**Step 2** Choose the **Still Image** tab.

**Step 3** In the Still Image Location field, enter the folder in which the system stores and accesses configuration files.

To browse to a folder, click the Browse button (which is labeled ...).

**Step 4** Click **OK**.

Managing the Device Tree

The device tree appears at the left of the Stream Manager Monitor window. (See Figure 5-1 on page 5-2.) When you start the Stream Manager Administration and Monitoring module, the device tree displays a list of video surveillance devices that are installed in the network. This display includes the name of each device as it was configured in the Stream Manager Configuration module and the type of device. It also shows the following device-specific information:

- For recorders—Percentage of storage space used, aggregate recording rate for all channels, number of alerts for this device in the Device alerts areas, if any, and number of channels that are being recorded if failover has occurred
- For hybrid decoders—ID of the camera from which the decoder is obtaining the video stream that it is providing to a matrix switch

In addition, the device tree displays a color-coded status icon for each device:

- **Green icon** —Device is operating normally and has no alerts
- **Yellow icon** —Device is operating but the system has detected one or more alerts on the device
- **Red icon** —The Stream Manager Administration and Monitoring module cannot access the device

A clock icon indicates a device that is the time master.

You can change the width of the device tree by dragging the right edge of the device tree area.

You can perform the following device tree activities:

- Designating the Display Order of Devices, page 5-8
- Locating a Recorder that is Recording Video from a Known Camera, page 5-8
Designating the Display Order of Devices

By default, the devices in the device tree appear in order of status type (red status, then yellow status, then green status).

To change the display order of devices, follow these steps:

**Step 1** Choose **Devices > Sort By**.

**Step 2** Choose one of these options:
- Status—Displays devices in order of status type (red, yellow, green)
- Type—Displays devices in alphabetical order by type
- Name—Displays devices in alphabetical order by name

Locating a Recorder that is Recording Video from a Known Camera

You can locate a recorder in the device tree that is recording video from a camera that you specify. To do so, choose **Tools > Find Camera**, enter the camera ID in the Camera Number field, then click **Find**.

Displaying Detailed Status for a Device

You can view detailed status for any device. To do so, double-click the device name in the device tree. The status information appears in the Device Details area.

For more information, see the “Understanding Device Details” section on page 5-9.

Clearing the Device List Display

You can remove all devices from the list in the device tree, and you can remove individual devices from the device tree. This action provides a way to refresh the display in the device tree. It does not affect the operation of any device.

Devices that Administration and Monitoring module discovers reappear in the list then next time that the module refreshes.

To clear the device list display, choose **Devices > Clear Device List**.

To remove a single device from the device list display, right-click the device and click **Delete**.
Rebooting a Device

You can choose to reboot any device in the device list. When you do so, the device shuts down and restarts.

To reboot a device in the device list display, right-click the device and click **Reboot**.

Understanding Device Details

The Device Details area appears at the top right of the Stream Manager Monitor window. (See Figure 5-1 on page 5-2.) The Status tab in this area displays detailed information for any device that you double-click in the device tree. The Retention tab, which is available for recorders, displays information about video that is retained on a recorder.

The information in the Device Details area depends on the device that you select. This information refreshes automatically at the rate that is configured as described in the “Configuring Network Options” section on page 5-4.

Figure 5-2 shows an example of the Device Details area for a recorder. Figure 5-3 shows an example of the Device Details area for a decoder.

**Figure 5-2  Device Details Area for a Recorder**
Interpreting Device Details

The Device Details area shows this information on the Status tab for any device that you select:

- IP address of the device
- MAC address of the device
- Firmware version that is loaded on the device

In addition, the Device Details area shows this information for recorders:

- Running time—Length of time that the recorder has been running since it last started or rebooted
- Storage space bar—Blue bar that represents how much disk space is used on the recorder
- Total storage—Total disk capacity of the device
- Available storage—Remaining disk space that can be used for video storage
- Total recording rate—Aggregate recording rate of all ports on the recorder
- Average retention time—Average period of time that video has been stored on the recorder

Drives Status

The Drives Status area shows the following information for each drive:

- Status icons for RAID drives:
  - Green icon—Drive is operating normally
  - Yellow icon—Drive is rebuilding
  - Red icon—Drive is not operating
- Name and status of each drive

For attached storage devices, click a Unit n button to see information for a specific storage unit.

Recording Status

The Recording Status area shows the following information:

- Color coded icons
  - Green icon—Channel is being recorded
  - Red icon—Channel cannot be recorded
  - Gray icon—Unused port on a recorder that is configured as a backup recorder
- Port—Video port on the recorder
- Channel—Camera ID of the camera that is attached to the associated port
• Type—"Local" indicates an encoder that is attached to the recorder and “Network” indicates a virtual port in the recorder
• Rate—Bit rate of video that is coming into the recorder
• Retention—Period of time that video from the associated channel has been stored on the recorder

Viewing Retention Information

When viewing device details for a recorder, you can choose the Retention tab in the Device Details area to see information about video data that is stored for each channel on the recorder.

Figure 5-4 shows an example of the Retention tab for a recorder.

Figure 5-4  Retention Tab

1 Marker Bar
2 Retention status
3 Time and date scale
4 Display controls
You can take the following actions in the Retention tab:

- To see the date and time for the activity at any point in the display, move the marker bar to that point and look at the value in the middle of the time and date scale.
- To change the time period for the information in the retention display, choose the desired value from the Show drop-down list.
- To refresh the retention display, click **Refresh Now**.

## Understanding Device Alerts

The Device Alerts area appears at the bottom right of the Stream Manager Monitor window. (See Figure 5-1 on page 5-2.) This area displays a list of all alerts from the device that is highlighted in the device tree.

By default, all alerts appear in the Active tab. However, if you have enabled the Silence “Raid Verification” alerts option in the **Tools > Options > General** tab, the system displays RAID alerts in the Silenced tab instead of the Active tab.

**Figure 5-5** shows an example of the Device Alerts area.

![Device Alerts Area](image)

By default, alerts appear in chronological order. To change the display order of alerts, choose **Alerts > Sort By**, then choose one of these options:

- **Type**—Displays alerts in alphabetical order by alert type
- **Date (Newest First)**—Displays devices in chronological order
- **Date (Oldest First)**—Displays devices in reverse chronological order

To move an alert from the Active tab to the Silence tab, right-click the alert and choose **Silence**. To move an alert from the Silence tab to the Active tab, right-click the alert and choose **Activate**.
Managing the Log File

The Stream Manager Administration and Monitoring module maintains a history of activities and events in a log file. This information includes the date and time that the following activities occur:

- A device comes on line
- A device goes off the network
- An alarm is detected
- A RAID alert is detected
- A user action is detected

Figure 5-6 shows an example of the Log File as it appears in the History Log window.

You can perform the following log file activities:

- View the log file by choosing **History > View Log**.

  The log file appears in the History Log window.

- Add a comment to a log file:
  a. Choose **History > Add a Comment**.
  b. Enter your name in the Operator Name field.
  c. Enter the comment in the Comment field.
  d. Click **Save**.

  Comments that you add are identified as “User Comment” in the log file.
• Clear the log file by choosing **History > Clear Log**, then clicking **Yes**.

You should clear the log periodically to prevent it from becoming very large.

**Managing Device Problems**

If the Monitoring and Administration module detects and alerts you to a problem with a device, follow this general procedure to identify and resolve the issue:

• Read the log file to identify the device and the problem

• Sort alerts in the Device Alerts area by device type to identify possible trends that are associated with the device
CHAPTER 6

Using the Stream Manager Client Viewing Module

The Cisco Video Surveillance Stream Manager Client Viewing module gives you access to many system operations, including viewing live and recorded video, controlling cameras, and reviewing events. It is the primary PC application for viewing live or stored video from the network.

Before you use the Client Viewing module, make sure that video surveillance devices are connected to the network and configured for normal operation.

This chapter includes these topics:

- Quick Start, page 6-1
- Starting and Exiting the Client Viewing Module, page 6-2
- Displaying Information about the Client Viewing Module, page 6-4
- Configuring the Client Viewing Module, page 6-4
- Managing Cameras, page 6-7
- Managing Monitors, page 6-13
- Managing Video, page 6-15
- Managing Events, page 6-22
- Exporting Video, page 6-25
- Managing Preset Camera Actions, page 6-27

Quick Start

Table 6-1 describes several common tasks that you might perform with the Client Viewing module and provides tips for performing each task. This table also includes references to sections that provide detailed related information.

You can use this overview information to quickly get started with the Client Viewing module.
Table 6-1  Client Viewing Module Quick Start Tips

<table>
<thead>
<tr>
<th>Task</th>
<th>Quick Start Tips</th>
<th>Reference</th>
</tr>
</thead>
</table>
| Starting and exiting the Stream Manager client module. | • To start, double-click the Stream Manager Client Viewing module icon on your desktop, or choose Start > Programs > Cisco Video Surveillance Stream Manager > Stream Manager Client.  
• To exit, choose File > Exit. | See the “Starting and Exiting the Client Viewing Module” section on page 6-2. |
| Viewing video. | • To choose a layout for video panes, click a stock layout button at the top of the Video Display area.  
• To view live video from a camera, double-click the camera in the camera bank or drag the camera to a video pane.  
• To view recorded video, right click the video and choose View > Recorded, or shift-drag a camera to a video pane.  
• To review events from the video buffer, toggle the control mode to playback, then left-click the image and drag left or right. Or, use the analog video control buttons.  
• To view video panes in full screen format, double-click a video pane, right-click a video pane and choose View > Full Screen, or choose View > Full Screen.  
To return to normal format, double-click the full screen video or press Esc. | See the “Managing Video” section on page 6-15. |
| Capturing an image from live or recorded video. | • Right-click the video and choose Still Image Capture. | See the “Capturing a Video Image” section on page 6-21. |
| Exporting video. | • Right-click a camera or video pane and choose Export, choose Cameras > Export, or click the Export Video button. | See the “Exporting Video” section on page 6-25. |
| Programming and executing preset camera actions. | • To program a preset camera action, position the camera as desired, right-click its video, and choose Program Preset.  
• To execute a preset action, right-click in the media wall and choose Call Up Preset. | See the “Managing Preset Camera Actions” section on page 6-27 |

Starting and Exiting the Client Viewing Module

To start the Stream Manager Client Viewing module, take either of these actions:

• Double-click the Stream Manager Client Viewing module icon on your desktop

• Choose Start > Programs > Cisco Video Surveillance Stream Manager > Stream Manager Client
The Stream Manager Client window appears. Figure 6-1 shows how this window might appear if the user rights and privileges and the event searching features are enabled. If these features are not enabled, the Search and Log tabs do not appear in the Events area, and not all icons appear in the camera bank and monitor bank.

**Figure 6-1  Stream Manager Client Window**

1. Video Display area
2. Stock layout buttons
3. Save Current Layout button
4. Load Custom Layout button
5. Digital video control buttons
6. Analog video control buttons
7. Export Video button
8. Video panes
9. Monitor bank
10. Events area
11. Media wall
12. Camera bank

To exit the Client Viewing module, choose **File > Exit.**
Displaying Information about the Client Viewing Module

To determine the version of the Client Viewing module and its components, choose Help > About. In the About window, you can take these actions:

- Click OK to exit the window
- Click System Info to display the Windows System Information window.

Configuring the Client Viewing Module

Table 6-2 describes the options that you can configure in the Client Viewing module.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration location</td>
<td>Location on a local or network drive where the system stores and accesses configuration files</td>
<td>See the “Specifying Configuration File Location” section on page 6-4</td>
</tr>
<tr>
<td>Export location</td>
<td>Default folder in which the system saves exported video files, default length of exported video files, and whether the system includes the Media Player with exported video files</td>
<td>See the “Configuring Export Options” section on page 6-5</td>
</tr>
<tr>
<td>General options</td>
<td>Settings for time master, text overlay position, and digital zoom sensitivity</td>
<td>See the “Configuring General Options” section on page 6-5</td>
</tr>
<tr>
<td>Network refresh rate</td>
<td>How often the information in the camera bank and monitor bank is updated</td>
<td>See the “Configuring Network Refresh Rate” section on page 6-6</td>
</tr>
<tr>
<td>Map data location</td>
<td>Location on a local or network computer where the system accesses map data</td>
<td>See the “Configuring Map Data Location” section on page 6-7</td>
</tr>
<tr>
<td>Database</td>
<td>Database location for user rights and privileges, and whether various features are enabled</td>
<td>See the “Configuring Database Location” section on page 6-7</td>
</tr>
</tbody>
</table>

Specifying Configuration File Location

The configuration file location designates the folder in which the Client Viewing module stores and accesses configuration files. These files store the configuration settings for the Client Viewing module. This folder can be on the local PC or on a network computer. The default location is the following folder on the local PC, where Windows_user_name is the Windows user name that you are logged in as:
C:\Documents and Settings\Windows_user_name\Local Settings\Application Data\Cisco Systems, Inc\StreamManagerClient,

To specify a location for configuration files, follow these steps:
Configuring the Client Viewing Module

Procedure

Step 1 From the Stream Manager Client window, choose **Tools > Options**.
Step 2 Choose the **Configuration** tab.
Step 3 In the Configuration Location field, enter the folder in which the system stores and accesses configuration files.
To browse to a folder, click the Browse button (which is labeled ...).
Step 4 Click **OK**.

Configuring Export Options

The export location designates the path and folder in which the system stores video files that you export. This folder can be on the local PC or on a network computer.

To configure export location options, follow these steps:

Procedure

Step 1 From the Stream Manager Client window, choose **Tools > Options**.
Step 2 Choose the **Export** tab.
Step 3 Configure the options that are described in Table 6-3.
Step 4 Click **OK**.

### Table 6-3 Export Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Export Location</td>
<td>Path to the folder where exported video files are stored.</td>
</tr>
<tr>
<td></td>
<td>To browse to a folder, click the Browse button (which is labeled ...).</td>
</tr>
<tr>
<td>Default Export Length</td>
<td>Default length, in seconds, of an exported video clip.</td>
</tr>
<tr>
<td></td>
<td>The default value is 60 seconds.</td>
</tr>
<tr>
<td>Include Media Player when</td>
<td>Places a copy of the Stream Manager Media Player in the same location as the</td>
</tr>
<tr>
<td>exporting</td>
<td>exported video.</td>
</tr>
<tr>
<td></td>
<td>This media player is required for viewing exported video.</td>
</tr>
<tr>
<td></td>
<td>This option is checked by default.</td>
</tr>
</tbody>
</table>

Step 4 Click **OK**.

Configuring General Options

General options include whether the PC on which you are running the Client Viewing module obtains its time from a time master, the location of overlay information on video panes, and sensitivity for digital zooming.
To configure general options, follow these steps:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>From the Stream Manager Client window, choose <strong>Tools &gt; Options</strong>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Choose the <strong>General</strong> tab.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Configure the options that are described in <strong>Table 6-4</strong>.</td>
</tr>
</tbody>
</table>

**Table 6-4**  **General Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronize clock with system</td>
<td>Check this check box to cause the PC on which you are running the Client Viewing module to use the time from a recorder that is designated as a time master.</td>
</tr>
<tr>
<td>Text overlay position</td>
<td>Specifies the location (top or bottom) of the status bar that the Stream Manager Client module includes in each video pane.</td>
</tr>
<tr>
<td>Digital Zoom Sensitivity</td>
<td>Specifies how the digital zoom feature performs. Move the slider toward Less to cause digital zooming to occur slowly when you rotate the mouse wheel. Move the slider toward More to cause digital zooming to occur quickly.</td>
</tr>
</tbody>
</table>

| Step 4 | Click **OK**. |

**Configuring Network Refresh Rate**

The network refresh rate specifies how often the Client Viewing module polls the network and updates information in the camera bank and the monitor bank.

A lower refresh rate causes the display to update more often, but uses more network bandwidth. To conserve bandwidth, do not choose a refresh rate that is lower than you need.

To specify the network refresh rate, follow these steps:

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the Stream Manager Client window, choose <strong>Tools &gt; Options</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Choose the <strong>Network</strong> tab.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Refresh Information every $n$ seconds field, enter how often, in seconds, the Client Viewing module refreshes information. You can enter a value from 1 to 3600. The default value is 60.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
Configuring Map Data Location

Maps let you view camera and alarm locations. For information about this feature, contact your Cisco sales representative or your Cisco partner.

Configuring Database Location

Database options let you specify the IP address of the database server, which is a recorder that you configured using the Stream Manager Configuration module. These options also let you designate whether the user rights and privileges and the event searching features are enabled.

To configure database options, follow these steps:

Procedure

Step 1 From the Stream Manager Client window, choose Tools > Options.
Step 2 Choose the Database tab.
Step 3 Configure the options that are described in Table 6-5.
Step 4 Click OK.

| Table 6-5 Database Options |
| Option | Description |
| Server | Enter the IP address of the recorder that is configured as the database server. |
| Enable User Rights and Privileges | Check this check box if you want the Client Viewing module to access devices that are configured with user rights and privileges. You must designate a database server before you can access this check box. |
| Enable Event Searching | Check this check box if you want to be able to search for events in the Event tab in the Events area. If you do not check this check box, the Search tab does not appear. You must designate a database server before you can access this check box. |

Managing Cameras

When you start the Client Viewing module, the system polls each device that is attached to the network and displays a list of cameras in the camera bank at the left of the Stream Manager Client window. (See Figure 6-1 on page 6-3.)

This display includes the name of each camera as it was configured in the Stream Manager Configuration module. The display can also include the icons that are described in Table 6-6.
Chapter 6  Using the Stream Manager Client Viewing Module

Managing Cameras

You can change the height or width of the camera bank display by dragging the bottom or right edge of the camera bank area.

Hold the mouse over a camera name to see the a tool tip that displays the camera ID, IP address, resolution, and frame rate.

You can perform the following camera bank activities:

- Designating the Display Order of Cameras in the Camera Bank, page 6-9
- Designating the Camera Type in the Camera Bank, page 6-9
- Refreshing the Display in the Camera Bank, page 6-9
- Exporting Video, page 6-25
- Browsing Camera Activity, page 6-10
- Searching for Specific Activity, page 6-12

For information about exporting video from a camera in the camera bank, see the “Exporting Video” section on page 6-25.

Table 6-6  Camera Bank Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Fixed camera icon]</td>
<td>Fixed camera</td>
</tr>
<tr>
<td>![PTZ camera icon]</td>
<td>PTZ camera</td>
</tr>
<tr>
<td>![Audio capture icon]</td>
<td>Camera is configured to capture audio</td>
</tr>
<tr>
<td>![Stream Manager access icon]</td>
<td>Stream Manager Client module has previously discovered the camera but can no longer access it</td>
</tr>
</tbody>
</table>

The following icons apply only if the user rights and privileges feature is enabled

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Locked PTZ camera icon]</td>
<td>PTZ camera is locked by a user</td>
</tr>
<tr>
<td>![User rights enabled icon]</td>
<td>Camera has user rights and privileges enabled</td>
</tr>
<tr>
<td>![User rights disabled icon]</td>
<td>Camera has user rights and privileges disabled</td>
</tr>
<tr>
<td>![Privileges not supported icon]</td>
<td>User rights and privileges is not supported on this camera</td>
</tr>
</tbody>
</table>
Designating the Display Order of Cameras in the Camera Bank

By default, the cameras in the camera bank appear in alphabetical order. To change the display order of cameras, follow these steps:

**Procedure**

**Step 1**
Take either of these actions:
- From the Stream Manager Client window, choose **Cameras > Sort By**.
- Right-click anywhere in the camera bank and choose **Sort By**.

**Step 2**
Choose one of these options:
- Name Ascending—Displays cameras in alphabetical order by name.
- Name Descending—Displays cameras in reverse alphabetical order by name.
- Type—Displays PTZ cameras at the top of the list, then displays fixed cameras. Cameras of each type appear in alphabetical order.
- Numerical Ascending—Displays cameras in ascending order by camera ID.
- Numerical Descending—Displays cameras in descending order by camera ID.

Designating the Camera Type in the Camera Bank

By default, the camera bank shows all cameras that are configured. You can limit this display to fixed cameras or pan-tilt-zoom (PTZ) cameras.
To designate the type of camera that appears in the camera bank, follow these steps:

**Procedure**

**Step 1**
Take either of these actions:
- From the Stream Manager Client window, choose **Cameras > Filter**.
- Right-click anywhere in the camera bank and choose **Filter**.

**Step 2**
Choose one of these options:
- All Cameras—Displays all configured cameras
- Fixed Cameras—Displays fixed cameras only
- PTZ Cameras—Displays PTZ cameras only

Refreshing the Display in the Camera Bank

By default, the system automatically refreshes the display of cameras in the camera bank every 60 seconds. When the displays refreshes, cameras that have been removed from the system no longer appear and cameras that have been added do appear.
You can manually refresh the camera bank display at any time. To do so, take either of these actions:

- From the Stream Manager Client window, choose **Cameras > Refresh**.
- Right-click anywhere in the camera bank and choose **Refresh**.

**Browsing Camera Activity**

Browsing camera activity allows you to view thumbnail snapshots of the video from a camera at designated intervals during a designated time period. This feature is useful for quickly scanning the activity that a camera has recorded.

For example, assume that you want to determine the exact time at which the lights came on in an office. You could start by browsing camera activity for the time period in which you know the lights came on. Figure 6-2 shows the results of browsing camera activity for a 6-hour period at 15-minute intervals. Based on this information, you can determine that the lights came on between 7:07 a.m. and 7:22 a.m.

![Figure 6-2 Browsing Camera Activity](Image)

To determine more precisely when the lights came on, browse activity from this camera again. This time, set the time period to just before and just after the change was noted, in this case, 7:07:27 a.m and 7:22:27 a.m., and set the interval to a smaller value, in this case, 1 minute. Figure 6-3 shows the results of this refined search, which indicates that the lights came on at 7:20 a.m.
To browse activity from a camera, follow these steps:

**Procedure**

**Step 1** Take either of these actions:

- In the camera bank, highlight the camera from which you want to browse activity, then choose Cameras > Browse.
- Right-click the camera from which you want to browse activity, then choose Browse.

**Step 2** In the Video Browser window, enter the information that is described in Table 6-7.

**Table 6-7 Video Browser Window Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera</td>
<td>Make sure that the number of the camera from which you want to export video appears in this field.</td>
</tr>
<tr>
<td>Thumbnail Interval</td>
<td>Choose how often you want to capture a snapshot from the video.</td>
</tr>
<tr>
<td>Browse From</td>
<td>In the date field, choose the date on which the period that you are browsing begins.</td>
</tr>
<tr>
<td></td>
<td>In the time field, enter the time at which the period that you are browsing begins. You can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.</td>
</tr>
<tr>
<td>Browse To</td>
<td>In the date field, choose the date on which the period that you are browsing begins.</td>
</tr>
<tr>
<td></td>
<td>In the time field, enter the time at which the period that you are browsing begins. You can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.</td>
</tr>
</tbody>
</table>
**Managing Cameras**

**Chapter 6  Using the Stream Manager Client Viewing Module**

**Step 3**  Click **Search**.

A series of thumbnail images appear, based on the interval and time period that you specified.

You can now exit the Video Browser window, or take these actions:

- Right-click a thumbnail image and choose **Narrow Search**—The system browses the video again for the same camera and time period, but at the next smaller interval.

- Right-click a thumbnail image and choose **Show Recorded Video**, or double-click a thumbnail image—The system plays back the video in the highlighted video pane in the media wall.

- Drag a thumbnail to a video pane in the media wall—The system plays back the video in that pane.

---

**Searching for Specific Activity**

The Client Viewing module can detect and report activity from cameras. To do so, the system compares video images at designated intervals within a designated time period. If the system detects a change in the image, it displays a thumbnail view of the image that has changed.

You can search for activity from specific areas in a camera view. For example, if a camera view is the front of a building, you can search for activity that involves only the front door or a window. Similarly, if the camera view is a parking lot, you can search for activity that involves only specific parking spaces. By isolating areas in a view, you can detect activities that are of interest, such as a door opening or a car parking, and ignore other activities, such as a tree moving in the wind or a car passing on the street.

To search for activity for a specific camera, follow these steps:

**Procedure**

**Step 1**  Take either of these actions:

- In the camera bank, highlight the camera from which you want to search for activity, then choose **Cameras > Activity Search**.

- Right-click the camera from which you want to search for activity, then choose **Activity Search**.

**Step 2**  In the Activity Search window, enter the information that is described in **Table 6-8**.

**Table 6-8  **Activity Search Window Options**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Camera</td>
<td>Make sure that the number of the camera from which you want to export video appears in this field.</td>
</tr>
<tr>
<td>Search Interval</td>
<td>Choose how often the system should check the video for activity.</td>
</tr>
<tr>
<td>Search From</td>
<td>In the date field, choose the date on which the period that you are searching begins.</td>
</tr>
<tr>
<td></td>
<td>In the time field, enter the time at which the period that you are searching begins. You can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.</td>
</tr>
</tbody>
</table>
Step 3  (Optional) If you want to check certain areas of a video for activity, click **Get Image**, then use your mouse to highlight areas in the video pane that you want to check for activity.

To highlight areas, draw boundaries around each area. Start by clicking at one corner of the desired boundary. Then move the mouse pointer to another corner and click again. Continue moving and clicking the mouse to define an area of any shape. Double-click the last corner to complete the area definition.

You can define as many areas as you need. If you want to clear the highlighted regions, click **Reset**.

Step 4  Click **Start**.

The system searches for activity and displays the results in a series of thumbnail images.

To stop a search in progress, click **Stop**.

You can now exit the Video Browser window, or take these actions:

- Right-click a thumbnail image and choose **Narrow Search**—The system browses the video again for the same camera and time period, but at the next smaller interval.
- Right-click a thumbnail image and choose **Show Recorded Video**, or double-click a thumbnail image—The system plays back the video in the highlighted video pane in the media wall.
- Drag a thumbnail to a video pane in the media wall—The system plays back the video in that pane.

### Managing Monitors

When you start the Client Viewing module, the system polls each device that is attached to the network and displays a list of monitors that are attached to decoders in the **monitor bank** at the right of the Stream Manager Client window. (See Figure 6-1 on page 6-3.)

To designate whether the monitor bank appears, choose **View > Monitor Bank** from the Stream Manager Client window.

The monitor bank displays the name of each monitor as it was configured in the Stream Manager Configuration module. The display can also include the icons that are described in Table 6-9.

#### Table 6-8  Activity Search Window Options (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search To</td>
<td>In the date field, choose the date on which the period that you are searching ends. In the time field, enter the time at which the period that you are searching ends. You can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.</td>
</tr>
<tr>
<td>Show Activity in Thumbnails</td>
<td>Check this check box if you want each thumbnail image to identify where in the video activity was detected. If you choose to check only certain areas of a video for activity, the thumbnail images identify changes in those areas only.</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>Use the slider to specify how sensitive the system is to changes in video.</td>
</tr>
</tbody>
</table>
Managing Monitors

You can change the height or width of the monitor bank display by dragging the bottom or right edge of the monitor bank area.

You can perform the following monitor bank activities:
- Designating the Display Order of Monitors in the Monitor Bank, page 6-14
- Refreshing the Display in the Monitor Bank, page 6-15
- Displaying Live Video from a Camera on a Monitor, page 6-15

### Designating the Display Order of Monitors in the Monitor Bank

By default, the monitors in the monitor bank appear in alphabetical order.

To change the display order of monitors, follow these steps:

**Procedure**

**Step 1**
Take either of these actions:
- From the Stream Manager Client window, choose **Monitors > Sort By**.
- Right-click anywhere in the monitor bank and choose **Sort By**.

**Step 2**
Choose one of these options:
- Name Ascending—Displays monitors in alphabetical order by name
- Name Descending—Displays monitors in reverse alphabetical order by name
Refreshing the Display in the Monitor Bank

By default, the system automatically refreshes the display of cameras in the monitor bank every 60 seconds. When the displays refreshes, monitors that have been removed from the system no longer appear and monitors that have been added do appear.

You can manually refresh the monitor bank display at any time. To do so, take either of these actions:

- From the Stream Manager Client window, choose Monitors > Refresh.
- Right-click anywhere in the monitor bank and choose Refresh.

Displaying Live Video from a Camera on a Monitor

The Client Viewing module lets you direct live video from a camera to a monitor. To do so, drag a camera from the camera bank to a monitor in the monitor bank. When you take this action, the live video from the camera appears on the monitor.

If user rights and privileges are configured, there may be restrictions on which cameras you can display on which monitors.

Managing Video

The video Display area in the Stream Manager Client window (see Figure 6-1 on page 6-3) lets you view any combination of live and recorded video in the layout configuration that you choose. In this area, you can also control the video, capture an image from a video stream, and perform a variety of other actions.

When you left-click a video pane in the Video Display area, a green border highlights the pane. When you double-click a camera in the camera bank, its video appears in the highlighted pane. In addition, the transport control buttons affect video in the highlighted pane.

This section describes how to perform the following activities:

- Designating a Layout for Panes in the Media Wall, page 6-15
- Viewing Video in Full Screen Mode, page 6-16
- Managing Custom Screen Layouts, page 6-16
- Viewing Live Video, page 6-17
- Viewing Recorded Video, page 6-19
- Capturing a Video Image, page 6-21
- Understanding the Video Status Bar, page 6-20

Designating a Layout for Panes in the Media Wall

The stock layout buttons at the top of the Video Display area let you choose the display layout for video panes in the media wall. The design on each button represents the layout that it sets. The layout can range from a single camera display to a display that shows video from up to 10 cameras.

Figure 6-4 shows the video display layout buttons.
Figure 6-4 Video Display Stock Layout Buttons

To choose a stock screen layout, click the desired stock layout button.

Note: You can save any layout with the cameras that you have placed in each video pane of the media wall and then load that layout whenever you want it. For more information, see the “Managing Custom Screen Layouts” section on page 6-16.

Viewing Video in Full Screen Mode

You can display the media wall with any layout in a full screen view. To do so, take any of these actions:

- Double-click any video pane
- Right-click a video pane and choose Full Screen
- Choose View > Full Screen.

To exit the full screen view and return to the Stream Manager Client window, double-click anywhere in the full screen display or press the Esc key.

When viewing video in full screen mode, the following functions are available:

- View live or recorded video—You can choose live or recorded video from a camera and use the pop-up rewind and forward options for recorded video
- Toggle control mode—You can toggle between PTZ and Playback mode and use the functions that are available in each mode
- Call Up Preset—You can execute a preset action for a camera
- Program Preset—You can program a preset action for a camera

Managing Custom Screen Layouts

As explained in the “Designating a Layout for Panes in the Media Wall” section on page 6-15, you can choose a layout to display any combination of up to 10 live and recorded video streams. If there are one or more combinations of layout and live or recorded video streams that you use often, you may find it convenient to save that configuration as a custom layout. You can recall custom layouts at any time, which allows you to easily display any saved configuration.

Creating a Custom Layout

To create a custom layout follow, these steps:

Procedure

Step 1 Choose the screen layout that you want.

See the “Designating a Layout for Panes in the Media Wall” section on page 6-15.
Step 2 Display the live video or recorded video streams in the video panes that you want.

See the “Viewing Live Video” section on page 6-17 and the “Viewing Recorded Video” section on page 6-19.

Step 3 Click the Save Current Layout button at the top of the Video Display area.

Step 4 In the Save a Custom Layout pop-up window, enter a description for the layout then click Save.

Loading a Custom Layout

You can load any custom layout that you have saved as described in the “Creating a Custom Layout” section on page 6-16. To do so, follow these steps:

Procedure

Step 1 Click the Load Custom Layout button at the top of the Video Display area.

Step 2 Locate and click the name of the layout, then click OK.

Viewing Live Video

You can view the live video stream from any camera. To do so, take either of these actions:

- Double-click the camera name in the camera bank. By default, the video from the camera appears in the next open video pane in the media wall. If a pane is highlighted in green, the video appears in that pane instead.

- Drag the camera name from the camera bank to the desired video pane in the media wall.

Note Depending on the screen layout that you choose, you can view video from up to 10 cameras at a time, and you can view any combination of live and recorded video streams. For related information, see the “Designating a Layout for Panes in the Media Wall” section on page 6-15 and the “Viewing Recorded Video” section on page 6-19.

You can control pan, tilt, optical zoom, focus, and iris settings of live (analog) video from cameras that support these functions. You can also control play back of buffered video from any camera. To perform these actions, click the portion of the current display that shows the video that you want to control. A green border appears around that portion. Then, use the analog video control buttons in the Video Display area or your mouse controls to perform the activities that are described in Table 6-10.
**Table 6-10  Controlling Live Video**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Zoom in</strong></td>
<td>Click the Zoom In button: [+] . This action performs an optical zoom by adjusting the camera lens. Or, place the mouse cursor in a video pane and rotate the scroll wheel away from you. This action zooms in digitally by increasing the pixel size of the display. When a video is digitally zoomed, you can see different areas of the image by holding down the left mouse button and dragging the image.</td>
</tr>
<tr>
<td><strong>Zoom out</strong></td>
<td>Click the Zoom Out button: [-] . This action performs an optical zoom by adjusting the camera lens. Or, place the mouse cursor in a video pane and rotate the scroll wheel toward you. This action zooms out digitally by decreasing the pixel size of the display.</td>
</tr>
<tr>
<td><strong>Focus near</strong></td>
<td>Click the Focus Near button: [+] .</td>
</tr>
<tr>
<td><strong>Focus far</strong></td>
<td>Click the Focus Far button: [-] .</td>
</tr>
<tr>
<td><strong>Open iris</strong></td>
<td>Click the Open Iris button: [+] .</td>
</tr>
<tr>
<td><strong>Close iris</strong></td>
<td>Click the Close Iris button: [-] .</td>
</tr>
<tr>
<td><strong>Pan</strong></td>
<td>Make sure that Control:PTZ appears at the top right of the video that you want to pan. If it does not, right-click the video and choose Toggle Control Mode. (If you cannot see this control indicator text, use the mouse scroll wheel to zoom the display all the way out.) To pan the display, move the mouse cursor to within the green border, hold down the left mouse button, and drag left or right.</td>
</tr>
<tr>
<td><strong>Tilt</strong></td>
<td>Make sure that Control:PTZ appears in the status bar of the video that you want to tilt. If it does not, right-click the video and choose Toggle Control Mode. To tilt the display, move the mouse cursor to within the green border, hold down the left mouse button, and drag up or down.</td>
</tr>
</tbody>
</table>
Table 6-10  Controlling Live Video (continued)

<table>
<thead>
<tr>
<th>Activity</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play back video from a buffer</td>
<td>Take either of these actions:</td>
</tr>
<tr>
<td></td>
<td>• To move back or forward one frame at a time, click the Rewind a single frame button or the Advance a single frame button. To return to live viewing, click the Play button: .</td>
</tr>
<tr>
<td></td>
<td>• Make sure that Control:Playback appears in the status bar of the video that you want to play back. If it does not, right-click the video and choose Toggle Control Mode. Then, move the mouse cursor to the video pane that displays the video to play back, hold down the left mouse button, and drag left to go back in the buffer or right to go ahead. Drag farther to increase the speed of playback.</td>
</tr>
<tr>
<td>Freeze (pause) video</td>
<td>Take either of these actions:</td>
</tr>
<tr>
<td></td>
<td>• Click the Pause button: . To return to live viewing, click the Play button: .</td>
</tr>
<tr>
<td></td>
<td>• Make sure that Control:Playback appears in the status bar of the video that you want to play back. If it does not, right-click the video and choose Toggle Control Mode. Then, move the mouse cursor to the video pane that displays the video to pause and hold down the left mouse button.</td>
</tr>
</tbody>
</table>

Viewing Recorded Video

You can view recorded video from any camera from which video is recorded. To do so, follow these steps:

**Procedure**

**Step 1** Take either of these actions:

- If you are already viewing live video from the camera, right click the video, choose View Recorded from the pop-up list, then take one of these actions:
  - Choose how far to back from the current time you want the recorded video to start playing (1 minute, 5 minutes, 30 minutes, 1 hour, 2 hours). Repeat as needed to go back more.
  - If you want to move the video playback ahead after you go back, choose how far ahead from the current position to advance (1 minute, 5 minutes, 30 minutes, 1 hour, 2 hours).
  - If you want to start viewing from a specific date and time, choose Go to Time/Date and continue to Step 2.
- To view recorded video from a camera in the camera bank, hold down the Shift key and drag the camera to a portion in the video layout. Continue to Step 2.
Step 2  In the Select Start Date and Time window:

a. In the Date field, choose the date from which to start playing the recorded video.

b. In the Time field, enter the time from which to start playing the recorded video.

    You can type the hours, minutes, seconds, and time designator, or you can highlight any time
    segment and use the up or down arrow to adjust it.

c. Click OK.

When you are viewing recorded video from a camera, you can change the display to live video from that
camera by right clicking the video display and choosing View Live.

Note  Depending on the screen layout that you choose, you can view video from up to 10 cameras at a time,
and you can view combinations of live and recorded video streams. For related information, see the
“Designating a Layout for Panes in the Media Wall” section on page 6-15 and the “Viewing Live Video”
section on page 6-17.

When viewing recorded (digital) video, you can pause, and resume the video, and move back or ahead
one frame at a time. To do so, click the portion of the current display that shows the video that you want
to control. A green border appears around that portion. Then, use the digital video control buttons in the
Video Display area to perform the activities that are described in Table 6-11.

Table 6-11  Controlling Video Playback

<table>
<thead>
<tr>
<th>Activity</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause video playback</td>
<td>Click the Pause button: [ ]</td>
</tr>
<tr>
<td>Resume video playback</td>
<td>Click the Play button: [ ]</td>
</tr>
<tr>
<td>Go back one frame</td>
<td>Click the Rewind a single frame button: &lt;</td>
</tr>
<tr>
<td>Go forward one frame</td>
<td>Click the Advance a single frame button: &gt;</td>
</tr>
</tbody>
</table>

Understanding the Video Status Bar

Each pane of live or recorded video includes a status bar, which displays the following information,
depending on the activity that you are performing:

- Display mode—“Live” designates live video, “Rec” designates recorded video
- Camera name—Name of the camera that is providing the video stream
- Time—Date and time of recorded video
- Status messages—Applicable messages, such as “VIDEO NOT PRESENT” or “RECONNECTING”
Playback function—Indicates the function that you perform in playback mode:
- < — Slow rewind
- <<< — Fast rewind
- > — Slow forward
- >> — Fast forward
- Paused — Video freeze

Control mode—Indicates the current control mode:
- PTZ — You can use the mouse to control PTZ functions
- Playback — You can use the mouse to play back video from a buffer

Figure 6-5 shows an example of a status bar.

**Figure 6-5 Status Bar**

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Live: West Lot]</td>
<td>![Pause]</td>
<td>![Playback]</td>
<td>![Control: Playback]</td>
</tr>
</tbody>
</table>

By default, the status bar appears at the top of a video pane. To change the location of the status bar, choose **Tools > Options > General**, then choose Top or Bottom from the Text Overlay Position drop-down list.

When you digitally zoom in using the mouse scroll wheel, the status bar disappears. In this case, zoom out to redisplay the status bar.

### Capturing a Video Image

You can capture a video image from any live or recorded video stream that you are viewing. You can save the image in a JPEG or BMP format in a location that you choose.

To capture a video image, follow these steps:

**Procedure**

**Step 1**
Display the live or recorded video stream from which you want to capture an image.

For related information, see the “Viewing Live Video” section on page 6-17 or the “Viewing Recorded Video” section on page 6-19.
Managing Events

An event is video activity, a contact closure, or video loss. The system displays information for events that occur on devices for which alarms are configured in the Stream Manager Configuration module.

Events appear in the Events area at the bottom of the Stream Manager Client window. (See Figure 6-1 on page 6-3.)

To designate whether the Events area appears, choose View > Event Window from the Stream Manager Client window.

The events area can include these tabs:

- Live—Displays events as they occur.
  For detailed information, see the “Using the Live Tab” section on page 6-23.
- Search—Lets you find events within a designated time period. This tab appears only if you have configured user rights and privileges and you have enabled event searching.
  For detailed information, see the “Using the Search Tab” section on page 6-24.
- Logs—Displays the events log. This tab appears only if you have configured user rights and privileges.
  For detailed information, see the “Using the Log Tab” section on page 6-25.
Using the Live Tab

The Live tab in the Events area displays events as they occur. The display includes the type of event, the date and time that the event occurred, and a brief description of the event. Table 6-12 describes event types.

Table 6-12 Live Event Types

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Any activity that is detected on a camera</td>
</tr>
<tr>
<td>Dry Contact</td>
<td>A contact that changes from its normal state</td>
</tr>
<tr>
<td>Video Loss</td>
<td>An interruption of the video signal from an encoder or recorder</td>
</tr>
</tbody>
</table>

You can perform the following activities for live events:

- Filtering Events in the Live Tab, page 6-23
- Reviewing Events in the Live Tab, page 6-23

Filtering Events in the Live Tab

Filtering events in the Events area Live tab lets you designate the type of event that you want to display in this tab.

To filter events, follow these steps:

Procedure

Step 1
Take either of these actions:
- From the Stream Manager Client window, choose Events > Filter.
- Right-click anywhere in the Events area and choose Filter.

A list of filters appears. A check next to a filter indicates that events of that type appear in the Events area.

Step 2
Choose one of these event types to toggle it on or off:
- Activity Detection—Displays an event whenever activity is detected on a camera
- Dry Contact—Displays an event whenever a contact detects an open circuit, which happens when a contact is broken
- Video Loss—Displays an event whenever a video signal from a camera is detected

Step 3
Repeat Step 1 and Step 2 as needed to choose other filters for events.

Reviewing Events in the Live Tab

You can review video for activity and contact closure events that appear in the Events area Live tab. To do so, double-click the event or drag the event from the Live tab to a video pane in the media wall. The video starts playing from a few seconds before the event occurred.
Using the Search Tab

The Search tab in the Events area lets you displays events that occurred within a designated time period. The display includes the type of event, the date and time that the event occurred, and a brief description of the event.

This tab appears only if you have configured user rights and privileges and you have enabled event searching. For more information, see the “Configuring Database Location” section on page 6-7. Table 6-13 describes event types that can appear in the Search tab.

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity</td>
<td>Any activity that is detected on a camera</td>
</tr>
<tr>
<td>Dry Contact</td>
<td>A contact that changes from its normal state</td>
</tr>
<tr>
<td>Video Loss</td>
<td>An interruption of the video signal from an encoder or recorder</td>
</tr>
</tbody>
</table>

You can perform the following event activities for searched events:

- Table 6-13
- Filtering Events in the Live Tab, page 6-23
- Reviewing Events in the Live Tab, page 6-23

Designating a Time Period for a Search

To designate the time period for which events display in the Events area search tab, designate the start and end of the period in the Search from and the Search to fields, then click Search.

In the time fields, you can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.

Filtering Events in the Search Tab

Filtering events in the Events area Search tab lets you designate the type of event that you want to display in this tab.

To filter events, follow these steps:

Procedure

Step 1  Take either of these actions:
- From the Stream Manager Client window, choose Events > Filter.
- Right-click anywhere in the Events area and choose Filter.

A list of filters appears. A check next to a filter indicates that events of that type appear in the Events area.
Chapter 6  Using the Stream Manager Client Viewing Module

Exporting Video

Step 2 Choose one of these event types to toggle it on or off:
  - Activity Detection—Displays an event whenever activity is detected on a camera
  - Dry Contact—Displays an event whenever a contact detects an open circuit, which happens when a contact is broken
  - Video Loss—Displays an event whenever a video signal from a camera is detected

Step 3 Repeat this procedure as needed to choose other filters for events.

Reviewing Events in the Search Tab
You can review video for activity and contact closure events that appear in the Events area Search tab. To do so, double-click the event or drag the event from the Live tab to a video pane in the media wall. The video starts playing from a few seconds before the event occurred.

Using the Log Tab
The Log tab in the Events area displays errors that relate to user rights and privileges. The displays includes the date and time that the error occurred, and a brief description of the error.
This tab appears only if you have configured user rights and privileges. For more information, see the “Configuring Database Location” section on page 6-7.

Exporting Video
Exporting video lets you save a video segment from a camera in a file that you can view using the Stream Manager Media Player.
By default, the system stores exported video as a 60-second segment in the root directory. You can change these default values as described in the “Configuring Export Options” section on page 6-5. You can also change the length of the video segment when you perform the export procedure.
You can export any number of video clips from any number of cameras at one time, and you can export for playback in one pane or for playback in four panes simultaneously. (Playback in four panes can be useful for comparing an event that was recorded from several cameras.) Video clips playback sequentially in the order and in the panes that you specify when you export them.
To export video, follow these steps:

Procedure

Step 1 Take one of these actions:
  - In the camera bank, highlight the camera from which you want to export video, then choose Cameras > Export. Continue to Step 2.
  - In the camera bank, right-click the camera from which you want to export video, then choose Export. Continue to Step 2
  - In the media wall, right-click the video that you want to export, then click Export. Continue to Step 2
Click the Export Video button. Go to Step 3.

**Step 2**

In the Define Video Clip window, enter the information that is described in Table 6-14, then click OK.

<table>
<thead>
<tr>
<th>Table 6-14</th>
<th>Video Export Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Camera</td>
<td>Make sure that the number of the camera from which you want to export video appears in this field.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Enter the time at which the clip that you are exporting starts. You can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Choose the date on which the clip that you are exporting starts.</td>
</tr>
<tr>
<td>Stop Time</td>
<td>Enter the time at which the clip that you are exporting stops. You can type the hours, minutes, seconds, and time designator, or you can highlight any time segment and use the up or down arrow to adjust it.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Choose the date on which the clip that you are exporting ends.</td>
</tr>
</tbody>
</table>

**Step 3**

In the Video Export Storyboard window, you can take any of these actions:

- To designate whether exported video plays back in one pane or in four panes, click a stock layout button:
  - —Video plays back in one pane
  - —Video plays back in four panes

- To add a video to export, take either of these actions:
  - Click the pane in the Video Export Storyboard window that corresponds to the video pane in which the video will play back, click Add, enter information in the Define Video Clip window (see Step 2), then click OK.
  - Drag a camera from the camera bank to the pane in the Video Export Storyboard window that corresponds to the video pane in which the video will play back, enter information in the Define Video Clip window (see Step 2), then click OK.

- To remove a video clip, highlight the clip and click Delete.
- To remove all video clips, click Delete All.
- To change the order of video clips in a pane, drag the clip to the location that you want.
- To move a video clip to another pane, drag the clip to the pane that you want.
- To change information about a clip to export (camera ID, start time, start date, stop time, stop date), double-click the clip, enter information in the Define Video Clip window (see Step 2), then click OK.
- To change the folder to which the system exports the clip, click Browse, define the folder, then click Save.
Managing Preset Camera Actions

A preset action causes a PTZ camera to pan, tilt, and zoom to a preset position when instructed. For example, you might program a preset action that causes a camera to pan and tilt toward a door and to zoom in on the door. You can program up to four preset actions for a camera.

From the Client Viewing module, you can instruct a camera to execute a preset action at any time. In addition, you can use the Stream Manager Configuration module to configure a camera to execute a preset action upon the occurrence of an event such as an alarm. For detailed information, see Chapter 4, “Using the Stream Manager Configuration Module.”

Programming a Preset Camera Action

To program a preset action for a PTZ camera, follow these steps:

Procedure

Step 1 Display the video stream from the camera for which you want to program a preset action.

For related information, see the “Viewing Live Video” section on page 6-17.

Step 2 Pan, tilt, and zoom the camera to the settings that you want to be programmed for the preset action. When the preset action executes, the camera will go to these pan, tilt, and zoom settings.

Step 3 Right-click the video, choose Program Preset, then choose Preset 1, Preset 2, Preset 3, or Preset 4. The system saves the current camera settings under the preset name that you choose.

Step 4 Repeat Step 2 and Step 3 as needed to program additional preset actions for the camera.

Manually Executing a Preset Camera Action

To manually execute a preset camera action that you have programmed as described in the “Programming a Preset Camera Action” section on page 6-27, follow these steps:

Procedure

Step 1 Display live video from the camera for which you want to execute a preset action.

Step 2 Right-click the video, choose Call Up Preset, then choose Preset 1, Preset 2, Preset 3, or Preset 4. The camera executes the preset program that you choose.
Using the Stream Manager On-Screen Menus

The Cisco Video Surveillance Stream Manager provides on-screens menu for display on analog monitors. These menus are accessed by using third-party video keyboards and provides basic functionality to lock a camera or monitor, or run a tour or sequence. Menu access can be restricted using Cisco Stream Manager user rights and privileges.

This chapter includes these topics:
- Accessing the Stream Manager On Screen Menu, page 7-29
- Managing a Tour or Sequence, page 7-31
- Understanding the Status Display for a Tour or Sequence, page 7-33

Accessing the Stream Manager On-Screen Menu

The Stream Manager on-screen menu provides options for logging in or out, locking a camera or monitor, and running a tour or sequence. To display the Stream Manager on-screen menu, perform the following steps:

Procedure

**Step 1**
From your third-party keyboard, select a monitor.
The Cisco Login screen appears,

**Step 2**
Enter the user password that is configured for you in the Stream Manager configuration module.

**Step 3**
Display the on-screen menu by using the appropriate keystrokes for your keyboard, as shown in Table 7-1.

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Keystrokes</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD CC1100</td>
<td>Macro key in menu</td>
</tr>
<tr>
<td>AD Enhanced Touch Tracker VM96</td>
<td>Menu key</td>
</tr>
<tr>
<td>Bosch Intuikey</td>
<td>On screen menu key</td>
</tr>
<tr>
<td>Pelco KBD300</td>
<td>Macro key</td>
</tr>
</tbody>
</table>
Step 4  
Select an option from the Main menu.

Table 7-2 describes each menu selection.

<table>
<thead>
<tr>
<th>Menu No.</th>
<th>Menu Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Logout Current User &lt;number&gt;</td>
<td>Logs out the current user. &lt;number&gt; specifies the 4-digit user ID of the user. Only one user can be logged in at a time. Any keyboard user can access the menu functionality.</td>
</tr>
<tr>
<td>2</td>
<td>Login as Different User &lt;number&gt;</td>
<td>Logs out the current user and displays the Cisco Login screen. &lt;number&gt; specifies the 4-digit user ID of the user.</td>
</tr>
<tr>
<td>3</td>
<td>Lock Current Camera &lt;number&gt;</td>
<td>Prevents users with the same or lower priority levels from controlling the pan, tilt, and zoom (PTZ) functions of the current camera. Only the current user, and users with higher priority access levels, can operate the PTZ functions while the camera is locked. When a camera is locked, a padlock icon appears next to the onscreen status display. &lt;number&gt; specifies the camera number. If the camera is already locked by another user, an error message appears. <strong>Note</strong> The camera lock is cancelled when you log out or when you select Unlock Current Camera &lt;number&gt;. The Unlock Current Camera menu item appears only when a camera is locked.</td>
</tr>
<tr>
<td>4</td>
<td>Lock Monitor &lt;number&gt;</td>
<td>Prevents users with lower priority levels from accessing the specified monitor by using another keyboard. When a monitor is locked, a padlock icon appears next to the onscreen status display. &lt;number&gt; specifies the monitor number. If the monitor is already locked by another user, an error message appears. <strong>Note</strong> The monitor lock is cancelled when you log out or when you select Unlock Current Monitor &lt;number&gt;. The Unlock Current Monitor menu item appears only when a camera is locked.</td>
</tr>
</tbody>
</table>
Managing a Tour or Sequence

When a tour or sequence is running, you can temporarily halt the script to view the current camera video, and step forward or back one step in the tour or sequence. To do so, perform the following steps:

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Press the appropriate key on your third-party keyboard to display the on-screen menu.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select 5. Load a Tour or 6. Load a Sequence.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 7-2</th>
<th>Menu Selections for the Cisco Stream Manager On-Screen Menu (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu No.</td>
<td>Menu Title</td>
</tr>
<tr>
<td>5</td>
<td>Load a Tour &lt;number&gt;</td>
</tr>
<tr>
<td>6</td>
<td>Load a Sequence &lt;number&gt;</td>
</tr>
<tr>
<td>7</td>
<td>Clear Tour</td>
</tr>
</tbody>
</table>
Managing a Tour or Sequence

Step 3 Enter the number of the tour or sequence.

Step 4 Choose an option from the on-screen menu, as described in Table 7-3.

---

Note

When the menu displays, the tour or sequence is halted on the monitor. However, the script continues to run in the background. When a menu item is selected, or the on-screen menu is cleared, the monitor displays the current status of the script. For this reason, the monitor may not show all steps in the tour or sequence while the on-screen menu is displayed.

---

**Table 7-3  Selections for the Tour or Sequence Control Menu**

<table>
<thead>
<tr>
<th>Menu No.</th>
<th>Menu Title</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1        | Hold | Resume     | • Hold—Stops a tour or sequence from continuing. This menu is displayed if the tour or sequence is running.  
|          |   |            | • Resume—Resumes a tour or sequence that was previously stopped. This menu is displayed only if the tour or sequence is on hold (stopped). |
| 2        | Prev          | Displays the next step in the tour or sequence.                             |
| 3        | Next          | Displays the previous step in the tour or sequence.                        |
| 9        | Exit          | Exits the menu screen.                                                     |

Step 5 To apply an additional command, such as another Prev or Next step in the tour or sequence, repeat these instructions beginning with Step 1.

---

Note

Some keyboards provide Hold, Previous, and Next keys, which allow additional steps to be performed without bringing up the on-screen menu and repeating this sequence.
Understanding the Status Display for a Tour or Sequence

When a tour or sequence is running, the status of that tour or sequence is displayed at the bottom of the screen. The format for the status display is:

Mon number Tour | Sequence number [Hold] Step number

Table 7-4 describes each status item.

<table>
<thead>
<tr>
<th>Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon number</td>
<td>The current monitor number.</td>
</tr>
<tr>
<td>Tour</td>
<td>Sequence number</td>
</tr>
<tr>
<td></td>
<td>If a tour is displayed on the screen, the Tour number is shown.</td>
</tr>
<tr>
<td></td>
<td>If a sequence is displayed on the screen, the Sequence number is shown.</td>
</tr>
<tr>
<td>Hold</td>
<td>Displayed when a tour or sequence is paused (held). This item is not</td>
</tr>
<tr>
<td></td>
<td>displayed when the tour or sequence is resumed.</td>
</tr>
<tr>
<td>Step number</td>
<td>The step number for the tour or sequence that is displayed on the screen.</td>
</tr>
</tbody>
</table>
Numerics

1:1 resolution mode  6-22

A

action, for alarm  4-8
activity, from camera
  browsing  6-10
  searching  6-12
activity detection alarm  4-6
Administration and Monitoring module
  overview  5-1
  configuring
    configuration file location  5-3
    overview  5-3
  Device Alerts area  5-12
    See also Device Alerts area
  Device Details area  5-9
    See also Device Details area
devices to monitor  5-5
device tree  5-7
device tree, See also device tree
exiting  5-2
log file  5-13
  See also log file
main window  5-2
options
  audio  5-5
  failover  5-6
  general  5-4
  network  5-4
  still image location  5-7
  refresh interval  5-5
  starting  5-1
  version  5-2
Advance Frame button  6-19
Advance frame button alarm
  action  4-8
  activity detection  4-6
  configuring  4-6
  contact closure  4-6
description  4-6
  overview  4-6
  RAID failure  4-6
  recording failure  4-6
types  4-6
  video loss  4-6
alert
  audio  5-5
  in Administration and Monitoring module  5-4
  RAID verification  5-4
types  5-5
Analog video control buttons  6-3
analog video port settings, for recorder  4-52
audio
  alert  5-5
  options for Administration and Monitoring module  5-5

B

browsing, camera activity  6-10
Index

C

camera
  browsing activity  6-10
  locking PTZ functions  7-30
  overview  1-3
  preset action  6-2, 6-27
  PTZ  1-3
  searching for activity  6-12
  user access rights  4-23

camera bank
  camera type in  6-9
  description  6-7
  display order  6-9
  filtering  6-9
  icons  6-8
  illustration  6-3
  refreshing display  6-9
  capturing still image  6-21
Cisco Video Surveillance Stream Manager
  See Stream Manager
Cisco Video Surveillance System
  components  1-2
  deployment options  3-1
Client Viewing module
  camera bank  6-7
  configuring
    configuration file location  6-4
    export location for video files  6-5
  events area  6-22
  exiting  6-2, 6-3
  exporting video  6-2
  main window  6-3
  monitor bank  6-13
  options
    database  6-7
    general  6-5
    maps  6-7
    network  6-6
  overview  6-1
  quick start  6-1
  refresh interval  6-6
  starting  6-2
  still image capture  6-2
  version  6-4
  viewing video in  6-2
closed circuit television (CCTC) monitor
  See video monitor
Close Iris button  6-18
comment, adding to log file  5-13
configuration file
  location for Administration and Monitoring module  5-3
  location for Client Viewing module  6-4
Configuration module
  alarm configuration  4-6
  decoder configuration  4-26
  display  4-6
  encoder configuration  4-35
  exiting  4-3
  hybrid decoder configuration  4-63
  pinning Loaded Modules area  4-6
  recorder configuration  4-44
  sequence configuration  4-10
  Services Platform configuration  4-44
  starting  4-2
  start up  4-4
  tour configuration  4-15
  user rights and privileges configuration  4-18
  version  4-4
contact closure alarm  4-6
Convergence Chassis
  connecting to external power supply  3-22
  description  3-20
  Fast Ethernet  3-21
  Gigabit Ethernet  3-22
  installing  3-20
  overview  1-4
types  3-21
USB  3-21

database, for Configuration module  4-3
database options, for Client Viewing module  6-7
decoder
collection options  4-26
configuring  4-26
description  3-19
device settings  4-26
hybrid, See hybrid decoder
installing  3-19
media settings  4-31
network settings  4-28
overlay settings  4-32
overview  1-4
peripheral settings  4-33
QoS settings  4-30
resetting
  firmware  3-28
  password  3-28
SNMP settings  4-29
deployment
Convergence Chassis with Fast Ethernet Outputs—External Power Supply deployment  3-8
Convergence Chassis with Fast Ethernet Outputs—Internal Power Supply deployment  3-6
Convergence Chassis with Gigabit Ethernet Outputs—External Power Supply deployment  3-13
Convergence Chassis with Gigabit Ethernet Outputs—Internal Power Supply deployment  3-11
Convergence Chassis with USB Outputs deployment  3-4
Integrated Services Platform deployment  3-3
overview  3-1
Standalone Gateways deployment  3-2
Device Details area
drives status  5-10
information  5-10
overview  5-9
recording status  5-10
Retention tab  5-9, 5-11
Status tab  5-9
device security
description  4-25
icons  4-25
device settings
decoder  4-26
coder  4-35
hybrid decoder  4-63
recorder  4-45
device tree
clearing list  5-8
display order  5-8
Find Camera  5-8
information  5-7
locating recorder in  5-8
rebooting device  5-9
status for a device  5-8
status icons  5-7
understanding  5-7
Digital video control buttons  6-3
digital zoom
sensitivity  6-6
zoom in  6-18
zoom out  6-18
display mode  6-20
drives status  5-10
dual-streaming encoder  3-16

e
encoder
configuration options  4-35
configuring 4-35
description 3-16
device settings 4-35
dual-streaming 3-16
high-density 3-18
installing 3-16
media settings 4-40
network settings 4-36, 4-37
overview 1-4
peripheral settings 4-42
QoS setting 4-39
resetting
  firmware 3-28
  password 3-28
SNMP setting 4-38

filtering
  events in Events area 6-23
  events in Search area 6-24
firmware
  upgrade files 2-8
  upgrading 2-6
Focus Far button 6-18
Focus Near button 6-18
focussing, video 6-18
freezing video 6-19
full screen mode 6-16

g
  general options
    for Administration and Monitoring module 5-4
    for Client Viewing module 6-5

h
  hardware
    installation guidelines 3-15
    operating conditions 3-16
  high-density encoder 3-18
hybrid decoder
  configuration options 4-63
  configuring 4-63
  device settings 4-63
  media settings 4-68
  network settings 4-65
  overview 1-4
  QoS settings 4-67
  SNMP settings 4-67

i
  icons
    camera bank 6-8

f
  failover 5-6
Index

IN-5

Cisco Video Surveillance System User Guide

OL-13827-01

device security 4-25
monitor bank 6-14
installing
Cisco Video Surveillance System 3-1
Convergence Chassis 3-20
decoder 3-19
coder 3-16
external power supply for Convergence Chassis 3-22
hardware guidelines for 3-15
Integrated Services Platform 3-25
Services Platform 3-23
Stream Manager modules 2-1
Integrated Services Platform
description 3-25
installing 3-25
overview 1-5
RAID 5 array 3-25
IP Gateway encoder
See encoder
iris, controlling 6-18

L

layout
custom
creating 6-16
description 6-16
loading 6-17
of panes in media wall 6-15
stock 6-15
Live tab, in events Viewing area 6-23
live video 6-17
Load Custom Layout button 6-3, 6-17
locking
PTZ functions 7-30
video monitor 7-30
log file
comment 5-13
deleting 5-14
description 5-13
viewing 5-13
log in
changing password for Stream Manager configuration module 4-3
default password for Stream Manager configuration module 4-3
from video keyboard 7-30
to Stream Manager Configuration module 4-2
log out
from video keyboard 7-30
Log tab, in Events area 6-25

M

maps 6-7
matrix switch
overview 1-4
time information from 4-46
media settings
decoder 4-31
coder 4-40
hybrid decoder 4-68
media wall
full screen mode 6-16
illustration 6-3
layout 6-15
monitor
See video monitor
monitor bank
description 6-13
display order 6-14
icons 6-14
illustration 6-3
refreshing display 6-15
network options
   for Administration and Monitoring module 5-4
   for Client Viewing module 6-6
network settings
   decoder 4-28
   encoder 4-36, 4-37
   hybrid decoder 4-65
   recorder 4-47

on-screen menus, accessing from video keyboard 7-29
Open Iris button 6-18
operating conditions, for hardware 3-16
optical zoom 6-18
order
   display in camera bank 6-9
   display in device tree 5-8
   display in monitor bank 6-14
overlay settings, decoder 4-32

pan, tilt, zoom (PTZ) 1-3
panning video 6-18
Pause button 6-19, 6-20
peripheral settings
   decoder 4-33
   encoder 4-42
playback
   from video buffer 6-19
   recorded video 6-19
Play button 6-19, 6-20
port audio settings, recorder 4-53
port grooming, recorder 4-54
port PTZ camera control settings, recorder 4-58
port video adjustment, recorder 4-57
port video settings, recorder 4-55
power module 1-5, 3-27
power supply 3-27
   See also external power supply
preset action
   executing 6-27
   programming 6-2, 6-27
PTZ
   camera control settings, for recorder 4-61
   locking from video keyboard 7-30
QoS settings
   decoder 4-30
   encoder 4-39
   hybrid decoder 4-67
QoS settings, recorder 4-49
RAID 5 array 3-23, 3-25
RAID failure alarm 4-6
rebooting, device in device tree 5-9
recorded video
   controlling 6-20
   viewing 6-19
recorder
   analog video port settings 4-52
   configuration options 4-44
   configuring 4-44
   device settings 4-45
   network settings 4-47
   port audio settings 4-53
   port grooming settings 4-54
   port PTZ camera control 4-58
   port video adjustment 4-57
   port video settings 4-55
PTZ camera control settings 4-61
QoS settings 4-49
SNMP settings 4-48
storage monitor settings 4-50
video matrix settings 4-51
virtual video port 4-60
recording failure alarm 4-6
recording status 5-10
refresh
camera bank display 6-9
monitor bank display 6-15
refresh interval
for Administration and Monitoring module 5-5
for Client Viewing module 6-6
removing, user 4-21
resetting
decoder
firmware 3-28
password 3-28
encoder
firmware 3-28
password 3-28
retention, viewing details 5-11
Retention tab 5-11
reviewing, events in Events area 6-23, 6-25
Rewind Frame button 6-19
Rewind frame button 6-20
removing 4-15
stopping from a video keyboard 7-31
updating 4-12
viewing from a video keyboard 7-31
Services Platform
configuration options, See recorder
description 3-23
installing 3-23
overview 1-5
RAID 5 array 3-23
Services Platform database firmware 2-7, 2-8
SNMP settings
decoder 4-29
encoder 4-38
hybrid decoder 4-67
SNMP settings, recorder 4-48
sorting
device alerts area 5-12
device tree 5-8
SQL connection 4-3
status bar
illustration 6-21
in client viewing module 6-20
text overlay position 6-6
still image 6-2
capturing 6-21
location 5-7
Stock layout buttons 6-3
stock layout buttons 6-15
storage, of video data 4-54
storage monitor settings, for recorder 4-50
Stream Manager
Administration and Monitoring module, See
Administration and Monitoring module
Client Viewing module, See Client Viewing module
Configuration module, See Configuration module
installing modules 2-1
modules 2-1
on screen menus 7-29
overview 1-3
uninstalling modules 2-6
Upgrade module 2-1
Stream Manager Client window 6-3
system security 4-25

configuring database for 4-3
enabling 6-7
firmware for 2-7, 2-8

video
buffer 6-19
controlling display 6-17
displaying from camera 6-15
exporting 6-2, 6-25
focussing 6-18
freezing 6-19
live 6-17
panning 6-18
playback 6-19
recorded 6-19
tilting 6-18
viewing 6-2, 6-15, 6-17, 6-19
video camera
See camera
video data, storage 4-54
Video Display area 6-3
Video Export Storyboard window 6-26
video keyboard
accessing Stream Manager on screen menus from 7-29
overview 1-3
video loss alarm 4-6
Video Mass Storage device 1-5
video matrix settings, recorder 4-51
video monitor
access security 4-24
camera access 4-24
locking 7-30
overview 1-3
security 4-24
user access rights 4-21
video pane
  illustration 6-3
  layout 6-15
virtual video port
  adding 4-60
  description 4-60
  removing 4-61

Z

zoom
  digital 6-6, 6-18
  optical 6-18
Zoom In button 6-18
Zoom Out button 6-18